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Verwendung dieser Dokumentation

■ Überblick – Im Desktopbenutzerhandbuch zu Oracle Solaris 11.2 wird die Konfiguration,
Anpassung und Verwendung der Oracle Solaris-Desktopfunktionen beschrieben. Die
meisten Informationen in diesem Handbuch treffen auf alle Desktopversionen zu. Bei
versionsspezifischen Informationen wird die entsprechende Plattform angegeben.

■ Zielgruppe – Dieses Handbuch richtet sich an Benutzer, Systemadministratoren sowie an
alle potenziellen Benutzer des Oracle Solaris-Desktops.

■ Benötigte Vorkenntnisse – Grundkenntnisse der SPARC- und x86-Systeme werden
vorausgesetzt. In diesem Handbuch wird davon ausgegangen, dass Ihnen folgende
Dokumentationen zur Referenz vorliegen:
■ „Oracle Solaris 11 Handbuch zur Barrierefreiheit für Desktop “
■ „Oracle Solaris 11.2 Desktop Administrator’s Guide “
■ „Optimizing the Oracle Solaris Desktop for a Multi-User Environment “
■ Oracle Solaris 11.2 Information Library

Der Aufbau dieses Buches

Dieses Handbuch ist folgendermaßen strukturiert:

■ In Kapitel 1, Erste Schritte mit dem Desktop werden einige Basiskomponenten des
Desktops vorgestellt. Zu diesen Komponenten gehören Fenster, Arbeitsflächen und
Anwendungen. Dieses Kapitel enthält außerdem Informationen zum Anmelden beim
Desktop, zum Herunterfahren des Desktops sowie zum Starten, Verwalten und Beenden
einer Desktopsitzung.

■ Kapitel 2, Desktopfenster verwenden enhält Erläuterungen zu den Desktopfenstern, den
verschiedenen verfügbaren Fenstertypen und zur Verwendung von Fenstern.

■ In Kapitel 3, Desktop-Arbeitsflächen verwenden werden Arbeitsflächen und die Verwaltung
der vorhandenen Arbeitsflächen auf dem Oracle Solaris-Desktop beschrieben.

■ In Kapitel 4, Desktop-Panels verwenden wird beschrieben, wie Panel im Oracle Solaris-
Desktop oben und unten hinzugefügt, angepasst und verwendet werden.

■ In Kapitel 5, Verwendung von Desktopanwendungen werden die standardmäßigen
Desktopanwendungen sowie das Erstellen, Öffnen und Speichern von Dateien und Ordnern
erläutert.

http://www.oracle.com/pls/topic/lookup?ctx=dsc&id=/app/docs/doc/E54036
http://www.oracle.com/pls/topic/lookup?ctx=E36784&id=SDSAG
http://www.oracle.com/pls/topic/lookup?ctx=E36784&id=OSDME
http://docs.oracle.com/cd/E36784_01/index.html
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■ In Kapitel 6, Hauptmenüleiste verwenden finden Sie Erläuterungen zur Verwendung der
Panel-Menüleiste des Desktops.

■ In Kapitel 7, Verwenden des Zeitschiebereglers finden Sie eine Beschreibung der
Wiederherstellung einzelner Dateien oder Verzeichnisse aus automatisch aufgenommenen,
inkrementellen Schnappschüssen von Verzeichnissen mit persönlichen Ordnern.

■ Kapitel 8, Dateimanager verwenden beinhaltet Anweisungen zum Organisieren und
Durchsuchen von Dateien, zum Verbinden mit Remote-Servern und Brennen von CDs.

■ In Kapitel 9, Desktoptools und -dienstprogramme verwenden werden die
Verwendungsmöglichkeiten einiger Tools und Dienstprogramme auf dem Desktop erläutert,
z.B. Screenshoterstellung oder Durchsuchen der Hilfe.

■ In Kapitel 10, Anpassen des Desktops wird die Verwendung von Einstellungstools zur
Anpassung des Desktops beschrieben.

■ In Anhang A, Verwenden der Maus finden Sie Erläuterungen zu Mausfunktionen und den
verschiedenen Mauszeigern.

■ Anhang B, Bedienung der Tastatur enthält eine Beschreibung zur Verwendung der Tastatur
und der Tastenkombinationen für Desktop und Anwendungen.

Produktdokumentationsbibliothek

Aktuelle Informationen und bekannte Probleme mit diesem Produkt finden Sie in der
Dokumentationsbibliothek unter http://www.oracle.com/pls/topic/lookup?ctx=E36784.

Kontakt zum Oracle Support

Oracle-Kunden können über My Oracle Support den Onlinesupport nutzen. Besuchen Sie
dazu die Website http://www.oracle.com/pls/topic/lookup?ctx=acc{ENT:#x0026}id=info
bzw. die Website http://www.oracle.com/pls/topic/lookup?ctx=acc{ENT:#x0026}id=trs für
Hörgeschädigte.

Feedback

Unter http://www.oracle.com/goto/docfeedback können Sie uns Feedback zu dieser
Dokumentation geben.

http://www.oracle.com/pls/topic/lookup?ctx=E36784
http://www.oracle.com/pls/topic/lookup?ctx=acc{ENT:#x0026}id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc{ENT:#x0026}id=trs
http://www.oracle.com/goto/docfeedback
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Erste Schritte mit dem Desktop

Dieses Kapitel stellt einige der grundlegenden Komponenten des Oracle Solaris-Desktops vor,
dem wiederum GNOME Desktop 2.30.2 zugrunde liegt.

In diesem Kapitel sind die folgenden Informationen enthalten:

■ „Übersicht über den Desktop“ [11]
■ „Komponenten des Desktops“ [12]
■ „Desktopsitzungen“ [13]

Übersicht über den Desktop

Der Desktop befindet sich auf dem Bildschirm hinter allen anderen Komponenten. Wenn keine
Fenster sichtbar sind, ist der Desktop derjenige Teil des Bildschirms, der sich zwischen dem
obersten und dem untersten Panel befindet. Sie können Dateien und Ordner, auf die Sie schnell
zugreifen möchten, auf dem Desktop platzieren.

Standardmäßig sind die folgenden Symbole auf dem Desktop sichtbar:

■ "Start Here (Hier beginnen)" – Ermöglicht Ihnen den Zugriff zum Anpassen des Desktops
und zum Aufrufen der Hilfe.

■ "Add More Software (Weitere Software hinzufügen)" – Öffnet den Package Manager, der es
Ihnen ermöglicht, Software hinzuzufügen oder zu aktualisieren.

Wenn Sie eine CD, ein Flashlaufwerk oder ein anderes Wechselmedium einführen, erscheint
dafür ein Symbol auf dem Desktop.

Um den Desktop aufzurufen und sämtliche Fenster zu minimieren, führen Sie eine der
folgenden Aktionen aus:

■ Klicken Sie auf den Knopf "Show Desktop (Arbeitsfläche anzeigen)".
■ Drücken Sie Strg+Alt+D.

Sie können stattdessen auf eine andere Arbeitsfläche umschalten, um den Desktop zu sehen.
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Sie können die Farbe des Desktophintergrundes oder des angezeigten Bildes ändern. Weitere
Informationen über die Änderung des Desktophintergrundes erhalten Sie unter „Einstellungen
für den Desktophintergrund“ [136].

Anmerkung - Die Dateien und Ordner auf dem Desktop werden in einem speziellen Ordner
mit Namen "Desktop", der sich im persönlichen Ordner befindet, gespeichert. Der Inhalt des
"Desktop"-Ordners wird auf dem Desktop angezeigt.

Komponenten des Desktops

Wenn Sie eine Desktopsitzung zum ersten Mal starten, wird ein standardmäßiger
Startbildschirm angezeigt, der über Panels, Fenster und verschiedene Symbole verfügt.

Die nachfolgende Tabelle erläutert die Hauptkomponenten des Oracle Solaris-Desktops.

TABELLE 1-1 Komponenten des Oracle Solaris-Desktops

Komponente Beschreibung

Panels Die beiden Balken, die auf dem Bildschirm oben und unten angezeigt werden, werden
als Panels bezeichnet. Standardmäßig werden im oberen Panel die Hauptmenüleiste des
Desktops, Anwendungsstartersymbole, das Benachrichtigungsfeld, der Lautstärkeregler
und eine Uhr angezeigt. Das untere Panel beinhaltet den Knopf "Show Desktop
(Desktop anzeigen)", das Applet "Window List (Fensterliste)", den "Workspace
Switcher (Arbeitsflächenumschalter)" und das "Trash applet (Mülleimer-Applet)".

Panels können so angepasst werden, dass mehrere Tools wie weitere Menüs und Starter
sowie kleine Dienstprogramme, die als Panel-Applets bezeichnet werden, integriert
werden können. Beispiel: Sie können Ihr Panel so konfigurieren, dass die für Ihren Ort
aktuelle Wetterlage angezeigt wird. Weitere Informationen zu Panels erhalten Sie unter
Kapitel 4, Desktop-Panels verwenden.

Fenster Die meisten Anwendungen werden in einem oder mehreren Fenstern ausgeführt. Sie
können auf dem Desktop mehrere Fenster gleichzeitig anzeigen. Fenster können in
ihrer Größe verändert und verschoben werden, um sie an den Arbeitsablauf anzupassen.
Jedes Fenster weist oben eine Titelleiste mit Knöpfen auf, mit denen Sie das Fenster
minimieren, maximieren und schließen können. Weitere Informationen über die Arbeit
mit Fenstern erhalten Sie unter „Mit Fenstern arbeiten“ [20].

Arbeitsflächen Sie können den Desktop in getrennte Arbeitsflächen aufteilen. Jede Arbeitsfläche
kann mehrere Fenster beinhalten, so dass Sie verwandte Aufgaben gruppieren können.
Weitere Informationen zur Arbeit mit Arbeitsflächen erhalten Sie unter „Überblick über
die Arbeitsflächen“ [25].

Dateimanager Über den Dateimanager können Sie auf Dateien, Ordner und Anwendungen zugreifen.
Zu den Aufgaben des Dateimanagers gehören das Verwalten von Ordnerinhalten sowie
das Öffnen von Anwendungen in geeigneten Anwendungen. Weitere Informationen zur
Verwendung des Dateimanagers erhalten Sie unter „Mit Dateien arbeiten“ [54] .

Einstellungen Sie können den Computer anpassen, indem Sie im Menü "System (System)" die Option
"Preferences (Einstellungen)" verwenden. Mit jedem Einstellungstool können Sie einen
bestimmten Aspekt des Verhaltens des Computers ändern. Weitere Informationen zu
Einstellungen erhalten Sie unter Kapitel 10, Anpassen des Desktops.
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Desktopsitzungen
Eine Sitzung bezeichnet einen Zeitraum zwischen der Anmeldung und der Abmeldung, in dem
Sie den Desktop verwenden. Während einer Sitzung verwenden Sie Anwendungen, drucken,
surfen im Internet usw.

Starten von Sitzungen
Wenn Sie sich anmelden, startet Ihre Sitzung. Über den Anmeldebildschirm erhalten Sie
Zugang zum Oracle Solaris-Desktop.

Anmerkung - Die Sitzung endet mit Ihrer Abmeldung. Sie können jedoch den Status Ihrer
Sitzung speichern und bei der nächsten Verwendung des Desktops wiederherstellen. Weitere
Informationen über die Wiederherstellung einer Sitzung erhalten Sie unter „Automatischen
Programmstart beim Anmelden festlegen“ [15].

So melden Sie sich beim Desktop an

1. Klicken Sie im Anmeldebildschirm auf "Session (Sitzung)". Wählen Sie aus der
Liste verfügbarer Desktopumgebungen GNOME aus.

2. Geben Sie den Benutzernamen im Feld "Username" (Benutzername) ein, und
drücken Sie dann die EINGABETASTE.

3. Geben Sie das Passwort im Feld "Password" (Passwort) ein, und drücken Sie
dann die EINGABETASTE.
Wenn Sie sich zum ersten Mal anmelden, wird eine neue Sitzung durch die Sitzungsverwaltung
gestartet. Wenn Sie sich zuvor bereits einmal angemeldet und die Einstellungen für die
vorige Sitzung gespeichert haben, wird die vorige Sitzung durch die Sitzungsverwaltung
wiederhergestellt.
Wenn Sie vor dem Anmelden das System herunterfahren oder neu starten möchten, klicken Sie
im Anmeldebildschirm auf "System (System)". Wählen Sie im Dialog die entsprechende Option
aus, und klicken Sie auf "OK".

So verwenden Sie eine andere Sprache

1. Klicken Sie im Anmeldebildschirm auf "Language (Sprache)". Wählen Sie die
gewünschte Sprache aus der Liste der verfügbaren Sprachen.

2. Geben Sie den Benutzernamen im Feld "Username" (Benutzername) ein, und
drücken Sie dann die EINGABETASTE.
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3. Geben Sie das Passwort im Feld "Password" (Passwort) ein, und drücken Sie
dann die EINGABETASTE.

So verwenden Sie ein anderes Tastaturlayout

Wenn Sie sich bei einer Sitzung in einer anderen Sprache anmelden, wird die Sprache der
Benutzeroberfläche und nicht das Tastaturlayout geändert.

1. Geben Sie den Benutzernamen im Feld "Username (Benutzername)" ein, und
drücken Sie dann die Eingabetaste.

2. Klicken Sie unten im Anmeldebildschirm auf das Tastatursymbol, und wählen
Sie das gewünschte Tastaturlayout aus der Liste der verfügbaren Layouts aus.

3. Geben Sie das Passwort im Feld "Password" (Passwort) ein, und drücken Sie
dann die EINGABETASTE.

Siehe auch Wenn Sie angemeldet sind, können Sie auch ein anderes Tastaturlayout mithilfe des
Einstellungstools "Keyboard (Tastatur)" wählen. Weitere Informationen über das
Tatstatureinstellungstool erhalten Sie unter „Tastatur“ [148].

Sperren des Bildschirms
Durch das Sperren eines Bildschirms wird der Zugriff auf Anwendungen und Daten
unterbunden, sodass Sie den Computer unbeaufsichtigt lassen können. Wenn Ihr Bildschirm
gesperrt ist, wird der Bildschirmschoner ausgeführt.

Führen Sie eine der folgenden Aktionen aus, um den Bildschirm zu sperren:

■ Wählen Sie "System -> Lock Screen" (System -> Bildschirm sperren)
■ Klicken Sie auf die Schaltfläche "Lock Screen (Bildschirm sperren)", wenn sie in einem

Panel angezeigt wird.

Anmerkung - Standardmäßig erscheint die Schaltfläche "Lock Screen (Bildschirm sperren)"
in Panels nicht. Weitere Informationen über das Hinzufügen der Schaltfläche zur "Lock Screen
(Bildschirm sperren)" zu einem Panel erhalten Sie unter „Objekt zu Panel hinzufügen“ [35].

Um den Bildschirm zu entsperren, müssen Sie Ihre Maus bewegen oder eine beliebige Taste
drücken, Ihr Passwort im Dialog des gesperrten Bildschirms eingeben und die Eingabetaste
drücken.

Andere Benutzer können sich bei dem gesperrten Computer anmelden, indem sie die
Maus bewegen oder eine beliebige Taste drücken und dann auf "Switch User (Benutzer
wechseln)" klicken. Der Anmeldebildschirm wird angezeigt, in dem sie sich mit ihren
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Berechtigungsnachweisen anmelden können. Sie we Wenn sie sich abmelden, wird der
Bildschirm wieder gesperrt. Sie können auf Ihre Sitzung zugreifen, indem sie den Bildschirm
entsperren.

Automatischen Programmstart beim Anmelden
festlegen

Sie können festlegen, dass bestimmte Programme automatisch gestartet werden, wenn Sie
sich bei einer Sitzung anmelden. Beispiel: Beim Anmelden soll ein Webbrowser gestartet
werden. Programme, die automatisch gestartet werden, wenn Sie sich anmelden, werden als
Startprogramme bezeichnet. Wenn Sie sich abmelden, werden Startprogramme automatisch
gespeichert und von der Sitzungsverwaltung geschlossen; wenn Sie sich anmelden, werden sie
neu gestartet.

Mithilfe des Einstellungstools für Startprogramme können Sie Startprogramme definieren.
Es verfügt über die Registerkarten "Startup Programs (Startprogramme)" und "Options
(Optionen)".

Informationen zur Registerkarte "Startup Programs
(Startprogramme)"

Sie können Startprogramme mithilfe der Registerkarte "Startup Programs (Startprogramme)"
hinzufügen, ändern und entfernen.

Auf dieser Registerkarte werden die Startprogramme aufgelistet. Die Auflistung enthält eine
Kurzbeschreibung jedes Programms sowie eine Option, die anzeigt, ob das Startprogramm
aktiviert ist. Deaktivierte Programme werden nicht automatisch gestartet, wenn Sie sich
anmelden.

Startprogramme aktivieren/deaktivieren

Um ein Programm automatisch zu starten, wählen Sie die dem Programm entsprechende
Option.

Um das automatische Starten eines Programms zu deaktivieren, müssen Sie die Option
abwählen.

So fügen Sie ein neues Startprogramm hinzu

1. Klicken Sie auf der Registerkarte "Startup Programs (Startprogramme)" auf "Add
(Hinzufügen)".
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Das "Add Startup Program (Startprogramm hinzufügen)"-Dialogfeld wird angezeigt.

2. Geben Sie im Textfeld "Name (Name)" einen Namen für das neue Startprogramm
ein.

3. Geben Sie im Textfeld "Command (Befehl)" den Befehl zum Aufrufen der
Anwendung ein.
Beispiel: Der Befehl gedit startet den Texteditor Gedit. Wenn Sie nicht den genauen Namen
des Befehls kennen, klicken Sie auf "Browse (Durchsuchen)", und wählen Sie den Pfad zum
Befehl.

4. Geben Sie im Textfeld "Comments (Kommentare)" eine Beschreibung für die
Anwendung ein.
Die Beschreibung des Programms wird in der Liste der Startprogramme angezeigt.

5. Klicken Sie auf "Add" (Hinzufügen).
Die Anwendung wird der Liste der Startprogramme hinzugefügt.

Startprogramm entfernen

Um ein Startprogramm zu entfernen, wählen Sie es aus der Liste der Startprogramme aus, und
klicken Sie auf "Remove (Entfernen)".

Startprogramm bearbeiten

Um ein vorhandenes Startprogramm zu bearbeiten, wählen Sie es aus der Liste der
Startprogramme aus, und klicken Sie auf "Edit (Bearbeiten)". Es wird ein Dialog angezeigt, der
es Ihnen ermöglicht, die Eigenschaften des Programms zu bearbeiten. Weitere Informationen
über die in diesem Dialog zur Verfügung stehenden Optionen erhalten Sie unter „Informationen
zur Registerkarte "Startup Programs (Startprogramme)"“ [15].

Informationen zur Registerkarte "Options (Optionen)"

Über die Sitzungsverwaltung kann gespeichert werden, welche Anwendungen bei Ihrer
Anmeldung ausgeführt werden. Diese werden dann neu gestartet, wenn Sie sich erneut
anmelden. Wenn ausgeführte Anwendungen immer neu gestartet werden sollen, wenn Sie
sich anmelden, wählen Sie "Automatically remember running applications when logging out
(Automatisch die laufenden Programme beim Abmelden merken)". Wenn dieser Vorgang nur
einmal durchgeführt werden soll, klicken Sie auf "Remember Currently Running Application
(Momentan laufendes Programm merken)".
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Beenden von Sitzungen

Sie können eine der folgenden Aktionen ausführen, um eine Sitzung zu beenden:

■ Melden Sie sich ab. Ein anderer Benutzer kann dann am Computer arbeiten. Melden Sie
sich ab, indem Sie "System (System) -> Log Out username" (Benutzername abmelden)
wählen.

■ Fahren Sie den Computer herunter, und schalten Sie ihn aus. Um auszuschalten, wählen
Sie "System -> Shut Down" (System -> Ausschalten) und klicken dann auf "Shut
Down" (Ausschalten).

■ Bei entsprechender Konfiguration können Sie den Computer in den Ruhezustand versetzen.
Im Ruhezustand wird weniger Strom verbraucht, trotzdem werden alle geöffneten
Anwendungen und Dokumente beibehalten. Sie werden geöffnet sein, wenn Sie den
Ruhezustand beenden. Sie können den Ruhezustand beenden, indem Sie Ihre Maus
bewegen oder eine Taste drücken.

Bevor Sie eine Sitzung beenden, speichern Sie Ihre aktuellen Einstellungen speichern, wenn
Sie Ihre Sitzung später wiederherstellen möchten. Im Einstellungstool zum Starten von
Anwendungen können Sie eine Option auswählen, um Ihre aktuelle Sitzung automatisch zu
speichern.



18 Desktopbenutzerhandbuch zu Oracle Solaris 11.2 • Juli 2014



Kapitel 2. Desktopfenster verwenden 19

 2 ♦  ♦  ♦        K  A  P  I  T  E  L     2 

Desktopfenster verwenden

In diesem Kapitel werden die Desktopfenster, die verschiedenen verfügbaren Fenstertypen und
die Verwendung von Fenstern beschrieben.

In diesem Kapitel sind die folgenden Informationen enthalten:

■ „Überblick über die Fenster“ [19]
■ „Fenstertypen“ [19]
■ „Mit Fenstern arbeiten“ [20]

Überblick über die Fenster

Ein Fenster ist ein rechteckiger Bereich des Bildschirms, üblicherweise mit einem umlaufenden
Rahmen und einer Titelleiste an der Oberseite. Sie können sich das wie einen Bildschirm
innerhalb des Bildschirms vorstellen. In jedem Fenster wird eine Anwendung angezeigt, sodass
Sie mehrere Anwendungen gleichzeitig betrachten und dadurch an mehreren Aufgaben zugleich
arbeiten können.

Sie können die Position eines Fensters auf dem Bildschirm und auch dessen Größe
beeinflussen. Sie legen fest, welche Fenster andere Fenster überlappen, so dass das Fenster,
mit dem Sie arbeiten, vollständig sichtbar ist. Weitere Informationen zum Verschieben und
Anpassen der Größe von Fenstern finden Sie unter „Mit Fenstern arbeiten“ [20].

Fenstertypen

Verschiedene Fenster können durchaus zur selben Anwendung gehören. Üblicherweise hat
eine Anwendung ein Hauptfenster, zusätzliche Fenster werden auf Anforderung des Benutzers
geöffnet.

In der folgenden Tabelle sind die beiden Hauptfenstertypen aufgeführt.
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TABELLE 2-1 Fenstertypen

Fenster Beschreibung

Anwendungsfenster Sie können Anwendungsfenster über die Knöpfe in der Titelleiste minimieren,
maximieren oder schließen.

Dialogfenster Dialogfenster werden auf Anforderung durch das Anwendungsfenster angezeigt. In
einem Dialogfenster werden Warnungen zu einem Problem, Bestätigung einer Aktion
oder Aufforderungen zur Eingabe angezeigt. Es gibt zwei Haupttypen von Fenstern:

■ Modale Dialoge – Dieser Dialog erlaubt Ihnen erst dann den Zugriff auf das
Hauptanwendungsfenster, wenn Sie das Dialogfenster geschlossen haben.

■ Übergangsdialoge – Diese Dialoge erlauben das Arbeiten im
Hauptanwendungsfenster, ohne dass das Dialogfenster geschlossen werden muss.

Mit Fenstern arbeiten

Sie können die Größe und Position des Fensters auf dem Bildschirm ändern. Dadurch sehen
Sie mehr als eine Anwendung und können mehrere Aufgaben zur gleichen Zeit erledigen.
Beispiel: Sie können eine Webseite lesen und gleichzeitig mit einer Textverarbeitung arbeiten
oder einfach zu einer anderen Anwendung wechseln, um eine Aufgabe zu erledigen oder deren
Fortschritt zu sehen.

Die meisten dieser Aktionen werden mit der Maus auf Teilen des Fensterrahmens ausgeführt.
Der genannte obere Teil des Fensterrahmens ("Titelleiste") enthält einige Knöpfe, über die die
Anzeige des Fensters verändert werden kann.

In der folgenden Abbildung wird die Titelleiste eines typischen Anwendungsfensters
dargestellt. Diese enthält folgende Knöpfe (von links nach rechts): Fenstermenü, Fenstertitel,
Minimieren, Maximieren und Schließen.

ABBILDUNG 
  2-1

Titelleiste eines Anwendungsfensters

Sie können alle Aktionen auch über das Fenstermenü ausführen. Allgemeine Aktionen
können Sie auch über Tastenkombinationen ausführen. Eine Liste mit Beispielen für
Tastenkombinationen finden Sie unter „Tastenkombinationen für Fenster“ [168]. Folgende
Aktionen können Sie an einem Fenster entweder mit der Maus oder der Tastatur ausführen:
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Verschieben eines Fensters
Klicken Sie auf eine beliebige Stelle auf der Titelleiste (nicht auf die Knöpfe), und ziehen
Sie mit gedrückter Maustaste. Das Fenster bewegt sich über den Bildschirm, sobald Sie
mit gedrückter Maustaste ziehen. Auf manchen Computern wird die Fensterbewegung
möglicherweise durch einen sich bewegenden, leeren Rahmen dargestellt.

Darüber hinaus stehen Ihnen zum Verschieben eines Fensters folgende Möglichkeiten zur
Verfügung:

■ Wählen Sie aus dem Fenstermenü "Move (Verschieben)".
■ Drücken Sie Alt+F7, und bewegen Sie dann die Maus, oder verschieben Sie das Fenster

mithilfe der Pfeiltasten auf der Tastatur.
■ Halten Sie Alt gedrückt, und ziehen Sie das Fenster mit der Maus an eine beliebige Stelle.
■ Halten Sie die Umschalttaste gedrückt, und ziehen Sie das Fenster auf den freien Platz

zwischen den Rändern des Desktops und anderen Fenstern.

Anmerkung - Wenn die Taste NUM deaktiviert ist, können Sie die Pfeiltasten auf dem
Ziffernblock sowie die Tasten 7, 9, 1 und 3 zum diagonalen Verschieben verwenden.

Ändern der Größe eines Fensters
Ziehen Sie bei gedrückter Maustaste an einer Seite des Fensterrahmens, um das Fenster
auseinanderzuziehen oder zusammenzuschieben. Wenn Sie mit gedrückter Maustaste an den
Fensterecken ziehen, können Sie die Fenstergröße in zwei Richtungen gleichzeitig ändern. Der
Größenänderungszeiger wird angezeigt, sobald die Maus in der richtigen Position für diese
Aktion ist.

So ändern Sie die Größe eines Fensters

1. Wählen Sie aus dem Fenstermenü "Resize" (Größe ändern), oder drücken Sie
ALT+F8.
Der Größenänderungszeiger wird angezeigt.

2. Verschieben Sie den Mauszeiger in die Richtung der Seite des Fensters, dessen
Größe Sie ändern möchten, oder drücken Sie eine der Pfeiltasten auf der
Tastatur.
Der Mauszeiger ändert sich, um die gewählte Fensterseite kenntlich zu machen. Jetzt können
Sie die Fensterseite mit der Maus oder den Pfeiltasten verschieben.

3. Klicken Sie mit der Maus, oder drücken Sie die Eingabetaste, um die Änderung
zu übernehmen.
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Anmerkung - Sie können Esc drücken, um die Größenänderungsaktion abzubrechen und das
Fenster in seiner ursprünglichen Größe und Form zu belassen.

Minimieren von Fenstern

Klicken Sie in der Titelleiste auf den dritten Knopf "Minimieren", damit das Fenster nicht
mehr angezeigt wird. Das Fenster kann aus der "Window List (Fensterliste)" oder über den
"Window Selector (Fensterwähler)" im oberen Panel an seiner ursprünglichen Position und in
Originalgröße wiederhergestellt werden.

Sie können stattdessen auch aus dem Fenstermenü "Minimize" (Minimieren) wählen, oder
drücken Sie ALT+F9.

Anmerkung - Der Titel eines minimierten Fensters wird in der Fensterliste und dem
Fensterwähler in eckigen Klammern dargestellt.

Maximieren von Fenstern

Klicken Sie in der Titelleiste auf den Knopf "Maximieren", um das Fenster zu vergrößern (die
Panels bleiben sichtbar).

Darüber hinaus stehen Ihnen zum Maximieren eines Fensters folgende Möglichkeiten zur
Verfügung:

■ Wählen Sie aus dem Fenstermenü "Maximize (Maximieren)".
■ Drücken Sie ALT+F10.
■ Doppelklicken Sie auf eine beliebige Stelle auf der Titelleiste außer auf die Knöpfe an

beiden Enden der Leiste.

Anmerkung - Wenn Sie möchten, können Sie die Doppelklickaktion auch zum Einrollen des
Fensters verwenden, sodass nur noch die Titelleiste angezeigt wird. Weitere Informationen zu
Fenstereinstellungen finden Sie unter „Mit Fenstern arbeiten“ [20].

Wiederherstellen der Größe eines maximierten
Fensters

Stellen Sie ein maximiertes Fenster in ursprünglicher Größe und Position wieder her, indem Sie
auf den Knopf "Maximieren" klicken.
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Darüber hinaus stehen Ihnen zum Wiederherstellen der Größe eines maximierten Fensters
folgende Möglichkeiten zur Verfügung:

■ Wählen Sie aus dem Fenstermenü "Unmaximize (Wiederherstellen)".
■ Drücken Sie Alt+F5.
■ Doppelklicken Sie auf eine beliebige Stelle auf der Titelleiste außer auf die Knöpfe an

beiden Enden der Leiste.

Fenster schließen

Klicken Sie auf den Knopf "Close (Schließen)", um das Fenster zu schließen. Sie werden von
der Anwendung aufgefordert, nicht gespeicherte Arbeit zu speichern.

Fenster aktivieren

Um mit einer Anwendung zu arbeiten, müssen Sie deren Fenster aktivieren. Wenn ein Fenster
aktiviert ist, können Aktionen wie Mausklicks, Texteingaben oder Tastenkombinationen an die
in diesem Fenster laufende Anwendung gerichtet werden. Nur ein einziges Fenster kann jeweils
aktiviert sein. Das aktivierte Fenster erscheint oberhalb anderer Fenster. Je nach ausgewähltem
Thema kann es sich auch durch sein Aussehen von anderen Fenstern unterscheiden.

Ihnen stehen zum Aktivieren eines Fensters folgende Möglichkeiten zur Verfügung:

■ Wenn das Fenster angezeigt wird, klicken Sie auf eine beliebige Stelle im Fenster.
■ Klicken Sie im unteren Panel auf den Knopf "Window List (Fensterliste)" des gewünschten

Fensters.
■ Klicken Sie im oberen Panel auf das Fensterlistensymbol, und wählen Sie dann das Fenster

aus der Liste aus, zu dem Sie wechseln möchten.

Anmerkung - Wenn sich das gewählte Fenster auf einer anderen Arbeitsfläche befindet,
dann wird auf diese Arbeitsfläche umgeschaltet. Weitere Informationen zur Verwendung von
Arbeitsflächen finden Sie unter „Überblick über die Arbeitsflächen“ [25].

■ Drücken Sie ALT+TAB-TASTE. Ein Popup-Fenster wird angezeigt, in dem in einer
Symbolliste jeweils ein Symbol ein Fenster bezeichnet. Halten Sie Alt gedrückt, und
drücken Sie die Tabulatortaste, um durch die Auswahlliste zu navigieren. Wählen Sie ein
Fenster aus, indem Sie die Alt-Taste loslassen.

Anmerkung - Sie können diese Tastenkombination mithilfe des Einstellungstools "Keyboard
Shortcuts (Tastaturkurzbefehle)" anpassen.
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Desktop-Arbeitsflächen verwenden

In diesem Kapitel werden Arbeitsflächen und die Verwaltung der vorhandenen Arbeitsflächen
auf dem Oracle Solaris-Desktop beschrieben.

In diesem Kapitel sind die folgenden Informationen enthalten:

■ „Überblick über die Arbeitsflächen“ [25]
■ „Mit Arbeitsflächen arbeiten“ [26]

Überblick über die Arbeitsflächen
Mithilfe von Arbeitsflächen können Sie bestimmen, welche Fenster angezeigt werden
sollen. Arbeitsflächen sind virtuelle Bildschirme, zwischen denen Sie jederzeit wechseln
können. Desktop, Panels und Menüs sind bei allen Arbeitsflächen gleich. Sie können jedoch
verschiedene Anwendungen ausführen und in jeder Arbeitsfläche unterschiedliche Fenster
öffnen. Die Anwendungen in jeder Arbeitsfläche ändern ihre Position nicht, wenn Sie in andere
Arbeitsflächen wechseln.

Vier Arbeitsflächen sind standardmäßig verfügbar. Mit dem Arbeitsflächenumschalterapplet
können Sie zwischen den Arbeitsflächen wechseln. In der folgenden Abbildung enthält der
Arbeitsflächenumschalter vier Arbeitsflächen. In den ersten drei Arbeitsflächen wurden
Fenster geöffnet. In der letzten Arbeitsfläche wurde kein Fenster geöffnet. Die derzeit aktive
Arbeitsfläche ist hervorgehoben.

ABBILDUNG 
  3-1

Workspace Switcher (Arbeitsflächenumschalter)

In jeder Arbeitsfläche kann eine Anzahl von Anwendungen ausgeführt werden. Die Anzahl
der Arbeitsflächen kann angepasst werden. Weitere Informationen zum Hinzufügen von
Arbeitsflächen finden Sie unter „Arbeitsflächen hinzufügen und löschen“ [26].
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Anmerkung - Arbeitsflächen ermöglichen Ihnen die Organisation des Oracle Solaris-
Desktops, während Sie gleichzeitig verschiedene Anwendungen ausführen. Eine Möglichkeit,
Arbeitsflächen zu nutzen, besteht in der Zuweisung einer bestimmten Funktion zu jeder
Arbeitsfläche.

Mit Arbeitsflächen arbeiten

Sie können in Arbeitsflächen folgende Aktionen durchführen:

■ Arbeitsflächen wechseln,
■ Arbeitsflächen hinzufügen,
■ Arbeitsflächen löschen,

Arbeitsflächen wechseln.

Ihnen stehen zum Wechsel der Arbeitsflächen folgende Möglichkeiten zur Verfügung:

■ Klicken Sie im Arbeitsflächenumschalterapplet auf die Arbeitsfläche, in der Sie arbeiten
möchten.

■ Bewegen Sie den Mauszeiger über das Arbeitsflächenumschalterapplet, und drehen Sie das
Mausrad.

■ Drücken Sie Strg+Alt+Pfeil nach rechts, um zur Arbeitsfläche rechts neben der derzeitigen
Arbeitsfläche zu wechseln.

■ Drücken Sie Strg+Alt+Pfeil nach links, um zur Arbeitsfläche links neben der derzeitigen
Arbeitsfläche zu wechseln.

Anmerkung - Die Funktion der Pfeiltasten richtet sich nach Ihren im
Arbeitsflächenumschalterapplet eingerichteten Arbeitsflächen. Wenn Sie die Anordnung
Ihrer Arbeitsflächen so geändert haben, dass mehr als eine Zeile mit Arbeitsflächen angezeigt
wird, drücken Sie STRG+ALT+NACH-OBEN-TASTE, um zur Arbeitsfläche oberhalb der
derzeitigen Arbeitsfläche zu wechseln, und STRG+ALT+NACH-UNTEN-TASTE, um zur
Arbeitsfläche unterhalb der derzeitigen Arbeitsfläche zu wechseln.

Arbeitsflächen hinzufügen und löschen

Verwenden Sie für das Hinzufügen und Löschen von Arbeitsflächen das
Arbeitsflächenumschalterapplet.
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So fügen Sie Arbeitsflächen hinzu

1. Klicken Sie mit der rechten Maustaste auf das Arbeitsflächenumschalterapplet,
und wählen Sie dann "Einstellungen".
Das Dialogfeld zu den Einstellungen des Arbeitsflächenumschalters wird angezeigt.

2. Erhöhen Sie im Feld "Number of Workspaces (Anzahl der Arbeitsflächen)" den
Wert, sodass er der Anzahl der auf dem Desktop angezeigten Arbeitsflächen
entspricht.

3. Klicken Sie auf "Schließen".

So löschen Sie Arbeitsflächen

1. Klicken Sie mit der rechten Maustaste auf das Arbeitsflächenumschalterapplet,
und wählen Sie dann "Preferences (Einstellungen)".
Das Dialogfeld zu den Einstellungen des Arbeitsflächenumschalters wird angezeigt.

2. Verringern Sie im Feld "Number of Workspaces (Anzahl der Arbeitsflächen)" den
Wert, sodass er der Anzahl der auf dem Desktop angezeigten Arbeitsflächen
entspricht.

3. Klicken Sie auf "Schließen".
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Desktop-Panels verwenden

Dieses Kapitel beschreibt die Verwendung der Panels an den oberen und unteren Rändern des
Oracle Solaris-Desktops, die Anpassung der angezeigten Objekte sowie das Hinzufügen neuer
Panels zum Desktop.

In diesem Kapitel sind die folgenden Informationen enthalten:

■ „Panelüberblick“ [29]
■ „Verwalten von Panels“ [31]
■ „Panel-Eigenschaften festlegen“ [32]
■ „Panel-Objekte verwalten“ [34]
■ „Applets“ [37]
■ „Starter“ [37]
■ „Schaltflächen“ [41]
■ „Menüs“ [44]
■ „Schubladen“ [45]
■ „Panelobjekte“ [47]

Panelüberblick

Ein Panel ist ein Bereich des Oracle Solaris-Desktops, in dem Sie Zugriff auf bestimmte
Aktionen und Informationen haben. In den standardmäßigen Panels können Sie beispielsweise
Anwendungen starten, Datum und Uhrzeit einsehen und unter anderem die Systemlautstärke
steuern.

Sie können das Verhalten und das Erscheinungsbild der Panels anpassen. Außerdem können Sie
den Panels Objekte hinzufügen oder sie daraus entfernen. Sie können mehrere Panels erstellen
und für jedes Panel andere Eigenschaften, Objekte und Hintergründe auswählen. Sie können
auch Panels verbergen. Standardmäßig beinhaltet der Oracle Solaris-Desktop ein Panel am
oberen und am unteren Bildschirmrand. In den folgenden Abschnitten werden diese Panels
beschrieben.
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Panel am oberen Bildschirmrand
Standardmäßig enthält das Panel am oberen Bildschirmrand die in der folgenden Tabelle
beschriebenen Applets.

TABELLE 4-1 Applets im Panel am oberen Bildschirmrand

Applet Beschreibung

Menüleiste Beinhaltet die Menüs "Applications (Anwendungen), "Places (Orte)"
und "System (System)". Weitere Informationen über die Menüleiste
erhalten Sie unter Kapitel 6, Hauptmenüleiste verwenden.

Eine Reihe von
Anwendungsstartersymbolen

Verwenden Sie Symbole, um den Dateimanager, den Firefox-
Webbrowser, die Thunderbird-E-Mail-Anwendung, Package Manager
und das Terminal zu starten.

Notification Area (Benachrichtigungsfeld) Hier werden Symbole anderer Anwendungen angezeigt, die Ihre
Aufmerksamkeit erfordern könnten und auf die Sie eventuell zugreifen
möchten, ohne das aktuelle Anwendungsfenster verlassen zu müssen.
Weitere Informationen über die Applets des Benachrichtigungsbereichs
finden Sie unter „Benachrichtigungsfeldapplet“ [48].

Bis eine Anwendung ein Symbol zum Benachrichtigungsfeld hinzufügt,
ist nur ein schmaler Balken sichtbar.

Uhr Die aktuelle Zeit wird angezeigt. Wenn Sie auf die Uhrzeit klicken, wird
ein kleiner Kalender geöffnet. Sie können außerdem eine Weltkarte
anzeigen, indem Sie auf den aufklappbaren Abschnitt "Locations (Orte)"
klicken. Weitere Informationen über das Applet "Clock (Uhr)" erhalten
Sie im Uhren-Handbuch.

"Volume Control (Lautstärkeregler)" Ermöglicht Ihnen die Steuerung der Lautsprecherlautstärke im
System. Weitere Informationen zur Lautstärkeregelung finden Sie im
Lautstärkeregler-Handbuch.

Panel am unteren Bildschirmrand
Standardmäßig enthält das Panel am unteren Bildschirmrand die in der folgenden Tabelle
beschriebenen Applets.

TABELLE 4-2 Applets im Panel am unteren Bildschirmrand

Applet Beschreibung

Show Desktop (Arbeitsfläche
anzeigen)

Alle geöffneten Fenster werden minimiert und der Desktop wird angezeigt.
Klicken Sie erneut, um den vorherigen Fensterstatus wiederherzustellen.

Window List (Fensterliste) Für jedes geöffnete Fenster wird eine Schaltfläche angezeigt. Die Fensterliste
ermöglicht es Ihnen, Fenster zu minimieren und wiederherzustellen.
Weitere Informationen zur Fensterliste erhalten Sie unter „Window List
(Fensterliste)“ [49].

Workspace Switcher
(Arbeitsflächenumschalter)

Ermöglicht es Ihnen, zwischen Arbeitsflächen umzuschalten. Weitere
Informationen über Arbeitsflächen erhalten Sie unter „Mit Arbeitsflächen
arbeiten“ [26].
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Applet Beschreibung

Trash-(Müll-)Applet Zeigt, ob Dateien aus dem "Trash (Müll)" gelöscht wurden. Klicken Sie auf das
Applet, um den Inhalt im Dateimanager anzuzeigen. Um den Müll zu leeren,
klicken Sie mit der rechten Maustaste auf das Applet und wählen Sie "Empty
Trash (Müll leeren)" aus.

Verwalten von Panels
Um mit einem Panel zu interagieren, klicken Sie auf einen freien Bereich, anstatt auf eines
der im Panel enthaltenen Objekte. Wenn die "Hide (Verbergen)"-Schaltflächen auf dem Panel
sichtbar sind, können Sie auch auf eine davon mit der mittleren oder rechten Maustaste klicken,
um das Panel auszuwählen.

Weitere Informationen über die Einstellung von Panel-Eigenschaften erhalten Sie unter „Panel-
Eigenschaften festlegen“ [32].

Verschieben von Panels
Um ein Panel auf eine andere Bildschirmseite zu verschieben, halten Sie die Taste ALT
gedrückt und ziehen Sie das Panel an seinen neuen Ort. Klicken Sie auf eine beliebige, freie
Stelle im Panel und beginnen Sie mit dem Ziehen.

Ein Panel, das von seiner Größe her nicht den ganzen Bildschirm umfasst, kann von den
Bildschirmrändern weggezogen und an jeder beliebigen Stelle des Bildschirms platziert werden.

Panel verbergen
Sie können ein Panel verbergen oder anzeigen, wenn es über "Hide (Verbergen)"-Schaltflächen
verfügt. Wenn die "Hide (Verbergen)"-Schaltflächen auf einem Panel nicht sichtbar sind,
müssen Sie die Eigenschaften des Panels so ändern, dass die "Hide (Verbergen)"-Schaltflächen
sichtbar werden.

"Hide (Verbergen)"-Schaltflächen befinden sich an jedem Ende eines Panels. Die "Hide
(Verbergen)"-Schaltflächen beinhalten ein optionales Pfeilsymbol. Die untenstehende
Abbildung zeigt die "Hide (Verbergen)"-Schaltflächen.

ABBILDUNG 
  4-1

"Hide (Verbergen)"-Schaltflächen in einem Panel
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Um ein Panel zu verbergen, müssen Sie auf eine der "Hide (Verbergen)"-Schaltflächen
klicken. Das Panel schrumpft in die Richtung zusammen, die durch den Pfeil auf der "Hide
(Verbergen)"-Schaltfläche angegeben ist. Die "Hide (Verbergen)"-Schaltfläche am anderen
Ende des Panels bleibt sichtbar.

Um ein verborgenes Panel erneut anzuzeigen, klicken Sie auf die sichtbare "Hide (Verbergen)"-
Schaltfläche. Das Panel zieht sich in die Richtung auseinander, die durch den Pfeil auf der
"Hide (Verbergen)"-Schaltfläche angegeben ist.

Sie können ein Panel auf "autohide (Auto-Verbergen)" setzen, so dass das Panel automatisch
verborgen wird, wenn die Maus nicht darauf zeigt. Das Panel erscheint erneut, wenn Sie auf den
Teil des Bildschirms zeigen, wo sich das Panel befindet.

Neues Panel hinzufügen

Um ein neues Panel hinzuzufügen, klicken Sie mit der rechten Maustaste in einem beliebigen
Panel in einen freien Bereich, und wählen Sie dann "New Panel (Panel anlegen)" aus. Das neue
Panel wird zum Oracle Solaris-Desktop hinzugefügt und verfügt über keinerlei Objekte. Es ist
ebenfalls möglich, das neue Panel anzupassen.

Panel löschen

Um ein Panel vom Oracle Solaris-Desktop zu löschen, klicken Sie mit der rechten Maustaste
auf das Panel, das Sie löschen möchten, und wählen Sie dann "Delete This Panel (Dieses Panel
löschen)".

Anmerkung - Sie müssen stets mindestens ein Panel auf dem Oracle Solaris-Desktop haben.
Wenn Sie nur über ein Panel auf dem Oracle Solaris-Desktop verfügen, können Sie das Panel
nicht löschen.

Panel-Eigenschaften festlegen

Sie können auch Eigenschaften für jedes einzelne Panel ändern. Dazu zählen u.a. der Typ des
Panels, das Ausblendeverhalten und das Aussehen.

Um die Eigenschaften eines Panels zu ändern, müssen Sie mit der rechten Maustaste im
Panel auf einen freien Ort klicken und "Eigenschaften" auswählen. Der Dialog "Panel
Properties (Panel-Eigenschaften)" beinhaltet zwei Registerkarten: "General (Allgemein)" und
"Background (Hintergrund)".



Panel-Eigenschaften festlegen

Kapitel 4. Desktop-Panels verwenden 33

Informationen zur Registerkarte "General
Properties (Allgemeine Eigenschaften)"

In der Registerkarte "General (Allgemein)" können Sie die Eigenschaften zur Panel-Größe, -
Position und zum Verbergen ändern. Die nachfolgende Tabelle erläutert die Dialogfeldelemente
der Registerkarte "General (Allgemein)".

TABELLE 4-3 Dialogfeldelemente der Registerkarte "General (Allgemein)"

Dialogfeldelement Beschreibung

"Orientation (Ausrichtung)" Bestimmt die Ausrichtung des Panels auf dem Bildschirm. Klicken Sie auf die
erforderliche Panel-Position.

Größe Bestimmt die Panel-Größe.

"Expand (Ausdehnen)" Standardmäßig dehnt sich ein Panel auf die volle Kantenlänge des Bildschirms
aus, auf dem es sich befindet. Ein Panel, das sich nicht ausdehnt, kann von den
Bildschirmkanten an jeden anderen Ort auf dem Bildschirm verschoben werden.

"Autohide (Auto-Verbergen)" Das Panel wird vollständig sichtbar, wenn sich der Mauszeiger darüber befindet.
Das Panel wird, ausgehend von seiner längsten Kante, verborgen, so dass nur
ein schmaler Teil davon entlang der Desktopkante sichtbar bleibt. Wird der
Mauszeiger über den sichtbaren Teil des Panels gezogen, wird das Panel wieder in
den sichtbaren Bereich bewegt.

"Hide (Verbergen)"-
Schaltflächen anzeigen

Zeigt die "Hide (Verbergen)"-Schaltflächen an jedem Ende des Panels an.
Klicken Sie auf eine "Hide (Verbergen)"-Schaltfläche, um das Panel vertikal
zu verschieben und es, abgesehen von der "Hide (Verbergen)"-Schaltfläche am
gegenüberliegenden Ende, zu verbergen. Wenn Sie auf diese "Hide (Verbergen)"-
Schaltfläche klicken, wird das Panel wieder komplett sichtbar.

Pfeile auf "Hide (Verbergen)"-
Schaltflächen

Zeigt Pfeile auf den "Hide (Verbergen)"-Schaltflächen an, wenn "Hide
(Verbergen)"-Schaltflächen aktiviert sind.

Informationen zur Registerkarte "Background
Properties (Hintergrundeigenschaften)"

Auf der Registerkarte "Background (Hintergrund)" können Sie den Hintergrundtyp für das
Panel auswählen. Die nachfolgende Tabelle erläutert die Dialogfeldelemente der Registerkarte
"Background (Hintergrund)".

TABELLE 4-4 Dialogfeldelemente der Registerkarte "Background (Hintergrund)"

Dialogfeldelement Beschreibung

"None (use system theme)
(Keiner (System-Thema
verwenden))"

Wählen Sie diese Option, um für das Panel die Einstellungen des
Erscheinungsbildeinstellungstools zu verwenden. Diese Einstellung sorgt dafür, dass
der Panel-Hintergrund dem Desktop und den Anwendungen ähnelt.

"Solid Color (Durchgängige
Farbe)"

Legt eine durchgängige Farbe für den Panel-Hintergrund fest. Klicken Sie auf die
Schaltfläche "Color (Farbe)" und wählen Sie eine Farbe aus dem "Color Selector
(Farbwähler)"-Dialog aus.
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Dialogfeldelement Beschreibung
Verwenden Sie den "Style (Stil)"-Schieberegler um den Grad der Farbtransparenz
bzw. -undurchlässigkeit festzulegen. Wenn Sie ein Panel beispielsweise transparent
erscheinen lassen möchten, müssen Sie den Schieberegler bis zum Ende bewegen.

"Background image
(Hintergrund)"

Es wird ein Bild für den Panel-Hintergrund festgelegt. Klicken Sie auf "Browse
(Durchsuchen)", um nach einer Bilddatei zu suchen. Klicken Sie auf "OK", wenn
die Datei ausgewählt wurde.

Farben oder Bilder können ebenfalls in ein Panel gezogen werden, um sie als Hintergrund
festzulegen. Bilder oder Farben können aus vielen Anwendungen gezogen werden. Zum
Beispiel:

■ Sie können aus jedem Farbauswahldialog eine Farbe ziehen.
■ Sie können eine Bilddatei aus dem Dateimanager ziehen, um Sie als Panel-Hintergrund

festzulegen.
■ Sie können eine Farbe aus dem "Backgrounds and Emblems (Hintergründe und Embleme)"-

Dialog im Dateimanager in ein Panel ziehen, um sie als Hintergrund festzulegen.

Panel-Objekte verwalten

Dieser Abschnitt beschreibt die Objekte, die Sie Ihren Panels hinzufügen und dort verwenden
können.

Mit Panel-Objekten interagieren

Verwenden Sie die Maustasten, um in folgender Weise mit einem Panel-Objekt zu interagieren:

■ Linksklick - Startet das Panel-Objekt
■ Mittlerer Mausklick - Ermöglicht es Ihnen, ein Objekt auszuwählen und es an einen neuen

Ort zu ziehen.
■ Rechtsklick – Öfnet das Popup-Menü des Panel-Objekts.

Applet auswählen

Sie können nicht überall auf ein Applet klicken, um das Kontextmenü des Panel-Objekts
anzuzeigen, oder um das Applet zu verschieben. Einige Applets verfügen über Bereiche, die Sie
nicht zur Auswahl des Applets verwenden können. Beispielsweise existiert im Befehlszeilen-
Applet ein Feld, in das Sie Befehle eingeben können. Sie können nicht mit der rechten oder
mittleren Maustaste in dieses Feld klicken, um das Applet auszuwählen. Anstattdessen können
Sie mit der mittleren oder rechten Maustaste einen anderen Teil des Applets anklicken.
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Klicken Sie mit der rechten Maustaste bestimmte Teile des Applets an, um Popup-Menüs
Applet-spezifischer Befehle aufzurufen. Beispiel: Das Fensterlistenapplet weist links einen
vertikalen Ziehpunkt sowie Knöpfe auf, die rechts das Fenster darstellen. Um das Kontextmenü
des Panel-Objekts in der Fensterliste zu öffnen, klicken Sie mit der rechten Maustaste auf
den Ziehpunkt. Wenn Sie mit der rechten Maustaste eine Schaltfläche auf der rechten Seite
anklicken , wird ein Popup-Menü für die jeweilige Schaltfläche angezeigt.

Objekt zu Panel hinzufügen
Es lassen sich verschiedene Objekte zu einem Panel hinzufügen.

So fügen Sie ein Objekt zu einem Panel hinzu

1. Klicken Sie mit der rechten Maustaste auf eine freie Stelle im Panel, um das
Popup-Menü des Panels zu öffnen.

2. Wählen Sie "Add to Panel (Zum Panel hinzufügen)".
Der Dialog "Add to Panel (Zum Panel hinzufügen)" wird angezeigt. Die verfügbaren Panel-
Objekte werden in alphabetischer Reihenfolge aufgeführt, wobei die Starter oben stehen.

Anmerkung - Sie können in das Feld "Find (Suchen)" einen Teil des Namens oder der
Beschreibung des Objekts eingeben. Dadurch verkürzt sich die Liste der auf Ihre Eingaben
passenden Objekte. Um die vollständige Liste wiederherzustellen, löschen Sie den Text im Feld
"Find (Suchen)".

3. Verschieben Sie ein Objekt entweder durch Ziehen und Ablegen aus der Liste
in das Panel, oder wählen Sie ein Objekt aus der Liste aus, und klicken Sie auf
"Add (Hinzufügen)", um es an der Stelle im Panel hinzuzufügen, auf die Sie mit
der rechten Maustaste zuerst geklickt haben.
Sie können jedes Element aus dem "Applications menu (Anwendungsmenü)" dem Panel
hinzufügen. Jeder Starter entspricht einer .desktop-Datei. Sie können eine .desktop-Datei auf
die Panels ziehen, um den Starter zum Panel hinzuzufügen.

Objekteigenschaften ändern
Einigen Panel-Objekten wie Starter und Schubladen sind Eigenschaften zugeordnet. Die
Eigenschaften variieren je nach Objekttyp. Die Eigenschaften weisen folgende Details auf:

■ Befehl, mit dem eine Starteranwendung gestartet werden kann
■ Ort der Quelldateien für ein Menü
■ Symbol, das das Objekt darstellt
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So ändern Sie die Eigenschaften eines Objekts

1. Klicken Sie mit der rechten Maustaste auf das Objekt, um das Kontextmenü des
Panel-Objekts zu öffnen.

2. Wählen Sie "Properties (Eigenschaften)".
Verwenden Sie den "Properties (Eigenschaften)"-Dialog, um die Eigenschaften den
Anforderungen entsprechend zu verändern. Die Eigenschaften im Dialog hängen vom
ausgewählten Objekt ab.

3. Schließen Sie das Dialogfeld "Properties (Eigenschaften)".

Panel-Objekt verschieben
Panel-Objekte lassen sich innerhalb eines Panels und von einem Panel zu einem anderen
verschieben. Sie können auch Objekte zwischen Panels und Schubladen verschieben.

Das Verschieben eines Panel-Objekts hat Auswirkungen auf die Positionierung anderer Panel-
Objekte. Sie können über einen Bewegungsmodus bestimmen, wie sich Objekte in einem Panel
bewegen. Um den Bewegungsmodus anzugeben, drücken Sie beim Bewegen des Panel-Objekts
eine der folgenden Tasten.

Taste Bewegungsmodus Beschreibung

No key (Keine
Taste)

Wechselbewegung Das Objekt wird durch andere Panel-Objekte ausgetauscht. Die
Wechselbewegung ist der Standardbewegungsmodus.

Alt Freie Bewegung Das Objekt wird an die nächste freie Stelle im Panel platziert,
wobei andere Panel-Objekte übersprungen werden.

Umschalttaste Schiebebewegung Durch das Objekt werden andere Objekte im Panel weiter weg
geschoben.

So bewegen Sie ein Panel-Objekt

1. Klicken Sie mit der rechten Maustaste auf das Objekt, und wählen Sie dann
"Move (Verschieben)".

2. Zeigen Sie auf den neuen Ort für das Objekt, und klicken Sie dann mit einer
beliebigen Maustaste darauf, um das Objekt am neuen Ort zu verankern.
Dieser Ort kann sich auf jedem Panel des Oracle Solaris-Desktops befinden.

Anmerkung - Sie können stattdessen auch mit der mittleren Maustaste auf das Objekt klicken
und es an den neuen Ort ziehen. Wenn Sie die mittlere Maustaste loslassen, wird das Objekt am
neuen Ort verankert.
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Panel-Objekt sperren
Sie können das Panel-Objekt sperren, sodass die Objekte immer auf derselben Position bleiben.

Anmerkung - Sperren Sie die Panels, wenn sie an derselben Stelle bleiben sollen, während Sie
andere Panel-Objekte verschieben.

Um ein Objekt an seiner aktuellen Position im Panel zu sperren, klicken Sie mit der rechten
Maustaste auf das Objekt, und wählen Sie dann "Lock To Panel (Auf dem Panel sperren)".
Wählen Sie diese Option ab, um das Objekt zu entsperren.

Panel-Objekt entfernen
Klicken Sie zum Entfernen eines Objekts von einem Panel mit der rechten Maustaste auf das
Objekt, und wählen Sie "Remove From Panel (Aus dem Panel entfernen)".

Applets
Bei einem Applet handelt es sich um eine Anwendung, deren Benutzeroberfläche sich in einem
Panel befindet. Die folgende Abbildung stellt folgende Applets dar:

■ Window List (Fensterliste) – Die aktuell geöffneten Fenster werden angezeigt.
■ Clock (Uhr) – Das aktuelle Datum und die aktuelle Uhrzeit werden angezeigt.
■ Volume Control (Lautstärkeregler) – Die Lautstärke der Lautsprecher wird hier geregelt.

ABBILDUNG 
  4-2

Appletfenster

Starter
Ein Starter ist ein Objekt, das eine bestimmte Aktion ausführt, wenn Sie es öffnen.

Starter sind in Panels, in der Panel-Menüleiste sowie im Desktop integriert. Ein Starter wird
an diesen Orten immer durch ein Symbol dargestellt. Mithilfe eines Starters können Sie die
folgenden Aktionen ausführen:
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■ Anwendung starten,
■ Befehl ausführen,
■ Ordner öffnen,
■ Webbrowser auf einer bestimmten Webseite öffnen,
■ spezielle URIs (Uniform Resource Identifiers) öffnen. Der Oracle Solaris-Desktop bietet

spezielle URIs, mit denen Sie auf bestimmte Funktionen im Dateimanager zugreifen
können.

Sie können die Startereigenschaften ändern. Beispiel: Zu den Eigenschaften eines Starters
zählen der Startername, das Symbol, das den Starter darstellt, sowie Angaben dazu, wie der
Starter ausgeführt wird. Weitere Informationen zur Anpassung eines Anwendungsstarters
erhalten Sie unter „Starter ändern“ [39].

Starter zum Panel hinzufügen

Sie können einen Starter zu einem Panel mithilfe einer der folgenden Optionen hinzufügen:

■ Popup-Menü
■ Menü
■ Dateimanager

So fügen Sie einen Starter vom Popup-Menü aus zu einem
Panel hinzu

1. Klicken Sie mit der rechten Maustaste auf eine beliebige freie Stelle im Panel,
und wählen Sie dann "Add to Panel (Zum Panel hinzufügen)".
Der Dialog "Add to Panel (Zum Panel hinzufügen)" wird angezeigt.

2. Fügen Sie einen neuen oder vorhandenen Starter hinzu.

■ So fügen Sie einen neuen Starter hinzu

a.    Wählen Sie "Custom Application Launcher (Benutzerdefinierter
Anwendungsstarter)" aus der Liste aus.
Der Dialog "create launcher (Einen Starter anlegen)" wird angezeigt.

b.    Geben Sie die Informationen zum Starter an, und klicken Sie auf "OK
(OK)".

■ So fügen Sie einen vorhandenen Starter hinzu
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a.    Wählen Sie einen Anwendungsstarter aus der Liste aus.

b.    Wählen Sie einen Starter aus der Liste mit Menüeinträgen aus.

So fügen Sie einen Starter von einem Menü aus zu einem
Panel hinzu

1. Öffnen Sie das Menü, das den Starter enthält, und ziehen Sie den Starter in das
Panel.

2. Klicken Sie mit der rechten Maustaste auf den Namen des Starters, und wählen
Sie "Add this launcher to panel (Als Starter zum Panel hinzufügen)".

Anmerkung - Diese Methode funktioniert nur dann, wenn der Starter sich einem Untermenü
des Menüs befindet, das geöffnet wurde.

So fügen Sie einen Starter vom Dateimanager aus zu einem
Panel hinzu

1. Durchsuchen Sie den Dateimanager, und wählen Sie für den Starter in Ihrem
Dateisystem die Datei .desktop aus.

2. Ziehen Sie die Datei .desktop in das Panel.

Starter ändern

Die Startereigenschaften können Sie auf dem Desktop ändern.

So ändern Sie die Startereigenschaften

1. Klicken Sie mit der rechten Maustaste auf den Starter, und öffnen Sie das
Kontextmenü des Panel-Objekts.

2. Wählen Sie "Properties (Eigenschaften)".
Verwenden Sie den "Launcher Properties (Starter-Eigenschaften)"-Dialog, um die
Eigenschaften den Anforderungen entsprechend zu verändern. Weitere Informationen erhalten
Sie unter „Startereigenschaften“ [40].
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3. Klicken Sie auf "Close (Schließen)", um den Dialog zu schließen.

Startereigenschaften
Wenn Sie einen Starter erstellen oder bearbeiten, können die folgenden Eigenschaften definiert
werden:

Eigenschaft Beschreibung

Type (Typ) Im Kontextmenü können Sie angeben, ob der Starter eine Anwendung starten oder einen
Ort öffnen soll:

■ Application (Anwendung) – Eine Anwendung wird über den Starter gestartet.
■ Application in Terminal (Anwendung im Terminal) – Eine Anwendung wird über den

Starter in einem Terminalfenster gestartet.
■ Location (Ort) – Ein Ort, z.B. eine Datei oder eine Webseite wird über den Starter

geöffnet.

Wenn Sie einen Starter für einen Ort bearbeiten, wird diese Dropdown-Liste nicht
angezeigt. Wenn Sie einen Anwendungsstarter bearbeiten, ist die Option "Location (Ort)"
nicht verfügbar.

Name (Name) Der Name wird angezeigt, wenn Sie den Starter einem Menü oder dem Desktop
hinzugefügt haben.

Befehl Geben Sie für einen Anwendungsstarter einen Befehl an, der ausgeführt wird, wenn Sie auf
den Starter klicken. Beispielbefehle finden Sie unter „Starterbefehle und -orte“ [40].

Location (Ort) Geben Sie für einen Starter für einen Ort den Ort an, den Sie öffnen möchten. Klicken Sie
auf "Browse (Durchsuchen)", um einen Speicherort auf Ihrem Computer auszuwählen, oder
geben Sie eine Internetadresse ein, um eine Website zu starten. Beispiele für Orte finden
Sie unter „Starterbefehle und -orte“ [40].

Comment
(Kommentar)

Wenn Sie auf das Startersymbol auf dem Panel klicken, wird er als Tooltip angezeigt.

Starterbefehle und -orte

Wenn Sie im "Launcher properties (Starter-Eigenschaften)"-Dialog aus der Dropdown-Liste
"Type (Typ)" "Application (Anwendung)" oder "Application in Terminal (Anwendung im
Terminal)" auswählen, wird im Textfeld "Command (Befehl)" der entsprechende Befehl für den
Starter angezeigt. Die folgende Tabelle zeigt einige Beispielbefehle und die Aktionen, die diese
Befehle ausführen.

Beispiel für einen Anwendungsbefehl Aktion

gedit Die Texteditor-Anwendung Gedit wird gestartet.

gedit /home/user/loremipsum.txt Die Datei /home/user/loremipsum.txt wird in der
Texteditor-Anwendung Gedit geöffnet.

nautilus /home/user/Projects Der Ordner "/home/user/Projects" wird in einem
Dateibrowserfenster geöffnet.
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Wenn Sie aus der Dropdown-Liste "Type (Typ) im "Launcher Properties (Starter-
Eigenschaften)"-Dialog "Location (Ort)" auswählen, wird im Textfeld "Location (Ort)" der
entsprechnde Befehl für den Starter angezeigt. Die folgende Tabelle zeigt einige Beispiele für
Orte und die beim Anklicken des Starters ausgeführten Aktionen.

Beispielort Aktion

file:///home/user/loremipsum.txt Die Datei /home/user/loremipsum.txt wird in der
Texteditor-Anwendung Gedit geöffnet.

file:///home/user/Projects Der Ordner wird in einem /home/user/Projects
Dateibrowserfenster geöffnet.

http://www.oracle.com Die Oracle-Website wird im Standardbrowser geöffnet.

ftp://ftp.oracle.com Die Oracle-FTP-Site wird im Standardbrowser geöffnet.

Schaltflächen

Sie können Panels Knöpfe hinzufügen, um schnell auf häufig verwendete Aktionen und
Funktionen zugreifen zu können. In diesem Abschnitt werden die Knöpfe beschrieben, die Sie
Ihren Panels hinzufügen können. Weitere Informationen über das Hinzufügen eines Objekts zu
einem Panel finden Sie unter „Objekt zu Panel hinzufügen“ [35].

Force Quit (Beenden erzwingen)

Mithilfe des Knopfs "Force Quit (Beenden erzwingen)" können Sie das Beenden einer
Anwendung erzwingen, indem Sie auf ein Fenster klicken. Dieser Knopf ist hilfreich für das
Beenden einer Anwendung, die nicht auf Ihre Befehle reagiert, oder wenn eine Anwendung
abgestürzt ist oder nicht reagiert.

ABBILDUNG 
  4-3

Schaltfläche "Force Quit" (Beenden erzwingen)

Um eine Anwendung zu beenden, klicken Sie auf "Force Quit (Beenden erzwingen)", und
klicken Sie dann auf ein Fenster der Anwendung, die Sie beenden möchten. Drücken Sie Esc,
wenn Sie die Anwendung nicht beenden möchten.
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Lock Screen (Bildschirm sperren)

Mit der Schaltfläche "Lockl Screen (Bildschirm sperren)" sperren Sie den Bildschirm und
aktivieren den Bildschirmschoner. Um erneut auf die Sitzung zuzugreifen, müssen Sie Ihr
Passwort angeben.

ABBILDUNG 
  4-4

Schaltfläche "Lock Screen" (Bildschirm sperren)

Klicken Sie mit der rechten Maustaste auf die Schaltfläche "Lock Screen (Bildschirm sperren)",
um ein Menü mit Befehlen für den Bildschirmschoner aufzurufen. Die nachfolgende Tabelle
erläutert die Menüoptionen.

TABELLE 4-5 Funktionen des Menüs "Lock Screen (Bildschirm sperren)"

Menüeintrag Funktion

Activate Screensaver
(Bildschirmschoner
aktivieren)

Der Bildschirmschoner wird aktiviert. Der Bildschirm wird auch dann gesperrt, wenn Sie
die Option "Lock Screen When the Screensaver Is Active (Bildschirm sperren, wenn der
Bildschirmschoner aktiv ist)" im Bildschirmschonereinstellungstool aktiviert haben.

Lock Screen
(Bildschirm sperren)

Der Bildschirm wird gesperrt.

Eigenschaften Das Einstellungstool "Screensaver (Bildschirmschoner)" wird geöffnet, mit dem Sie den
Bildschirmschonertyp konfigurieren können, der beim Sperren des Bildschirms angezeigt
wird.

Anmerkung - Ein Klick auf die Schaltfläche "Lock Screen (Bildschirm sperren)" sperrt den
Bildschirm nur dann, wenn der Bildschirmschoner im Bildschirmschonereinstellungstool
aktiviert wurde. Der Bildschirmschoner ist standardmäßig aktiviert.

Log Out (Abmelden)

Mithilfe des Knopfs "Log Out (Abmelden)" können Sie sich von einer Desktopsitzung
abmelden oder zu einem anderen Benutzerkonto wechseln.
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ABBILDUNG 
  4-5

Schaltfläche "Log Out" (Abmelden)

Run (Ausführen)
Durch Klicken auf die Schaltfläche "Run (Ausführen)" wird der "Run Application (Anwendung
ausführen)"-Dialog angezeigt, der es Ihnen ermöglicht, eine Anwendung zu starten, indem Sie
sie in einer Liste auswählen.

ABBILDUNG 
  4-6

Schaltfläche "Run" (Ausführen)

Weitere Informationen zum Dialog "Run Application (Anwendung ausführen)" erhalten Sie
unter „Ausführen von Anwendungen“ [119].

Search for Files (Nach Dateien suchen)
Durch Klicken der Schaltfläche "Search for Files (Nach Dateien suchen)" wird das Suchtool
angezeigt, das es Ihnen erlaubt, auf Ihrem Computer nach Dateien zu suchen. Weitere
Informationen zum Suchtool erhalten Sie im Search Tool Manual.

ABBILDUNG 
  4-7

Knopf "Search for Files (Nach Dateien suchen)"

http://library.gnome.org/users/gnome-search-tool/2.32/
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Show Desktop (Arbeitsfläche anzeigen)
Sie können mithilfe des Knopfs "Show Desktop (Arbeitsfläche anzeigen)" alle geöffneten
Fenster minimieren und den Desktop anzeigen.

ABBILDUNG 
  4-8

Schaltfläche "Show Desktop" (Arbeitsfläche anzeigen)

Menüs
Sie können Panels die folgenden Menütypen hinzufügen:

■ Menubar (Menüleiste) – Sie können auf fast alle Standardanwendungen, Befehle
und Konfigurationsoptionen von der Menüleiste aus zugreifen. Die Leiste enthält
Anwendungen, Orte und Systemmenüs.

■ Main menu (Hauptmenü) – Im Hauptmenü sind ähnliche Elemente wie die Menüleiste
enthalten, die aber in einem und nicht in drei Menüs angeordnet sind.

■ Submenus (Untermenüs) – Sie können dem Panel ein Untermenü der Menüleiste oder des
Hauptmenüs hinzufügen. Beispielsweise können Sie dem Panel das Untermenü "Games
(Spiele)" aus dem "Applications menu (Anwendungsmenü)" hinzufügen.

So fügen Sie einem Panel eine Menüleiste oder ein
Hauptmenü hinzu

1. Klicken Sie mit der rechten Maustaste auf eine beliebige freie Stelle im Panel,
und wählen Sie "Add to Panel (Zum Panel hinzufügen)".

2. Wählen Sie im "Add to Panel (Zum Panel hinzufügen)"-Dialog die Menüleiste
oder das Hauptmenü aus.

So fügen Sie einem Panel ein Untermenü hinzu
1. Sie können ein Untermenü folgendermaßen öffnen:



Schubladen

Kapitel 4. Desktop-Panels verwenden 45

■ Hauptmenüapplet
■ Anwendungen
■ Orte
■ Systemmenü im Menüleistenapplet

2. Klicken Sie mit der rechten Maustaste auf ein Starterelement im Untermenü.

3. Wählen Sie "Entire Menu -> Add this menu to panel" (Gesamtes Menü -> Menü
zum Panel hinzufügen).

Schubladen

Bei einer Schublade handelt es sich um eine Erweiterung eines Panels. Sie können Schubladen
auf dieselbe Art öffnen und schließen, wie Sie Panels anzeigen und verbergen können. Eine
Schublade kann alle Panel-Objekte enthalten einschließlich Startern, Menüs, Applets und
anderen Schubladen. Wenn Sie eine Schublade öffnen, können Sie die Objekte so wie Objekte
auf einem Panel verwenden.

Sie können eine Schublade öffnen, indem Sie auf das Symbol der Schublade klicken. Um eine
Schublade zu schließen, klicken Sie erneut auf das Symbol oder klicken Sie auf die "Hide
(Verbergen)"-Schaltfläche der Schublade.

Die folgende Abbildung stellt eine geöffnete Schublade mit zwei Panel-Objekten dar.

ABBILDUNG 
  4-9

Schubladenpanel

Der Pfeil auf dem Symbol stellt eine Schublade oder ein Menü dar.
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Ähnlich wie bei Panel-Objekten können Sie Schubladen Objekte hinzufügen, Objekte aus
Schubladen verschieben oder entfernen. Beim Hinzufügen einer Schublade können Sie genauso
vorgehen wie bei anderen Objekten. Weitere Infromationen erhalten Sie unter „Objekt zu Panel
hinzufügen“ [35].

So fügen Sie einem Panel ein Menü als Schublade
hinzu

1. Sie können ein Untermenü folgendermaßen öffnen:

■ Hauptmenüapplet
■ Anwendungen
■ Orte
■ Systemmenü im Menüleistenapplet

2. Klicken Sie mit der rechten Maustaste auf ein Starterelement im Untermenü.

3. Wählen Sie "Entire menu -> Add this as drawer to panel" (Gesamtes Menü -> Als
Schublade zum Panel hinzufügen).

So fügen Sie ein Objekt zu einer Schublade hinzu
1. Klicken Sie mit der rechten Maustaste auf eine freie Stelle in der Schublade, um

das Popup-Menü der Schublade zu öffnen.

2. Wählen Sie "Add to Drawer (Zur Schublade hinzufügen)".
Der "Add to Drawer (Zur Schublade hinzufügen)"-Dialog wird angezeigt. Die verfügbaren
Schubladenobjekte werden in alphabetischer Reihenfolge aufgeführt, wobei die Starter oben
stehen.

Anmerkung - Sie können in das Feld "Find (Suchen)" einen Teil des Namens oder der
Beschreibung des Objekts eingeben, um die passenden Objekte einzugrenzen. Um die
vollständige Liste wiederherzustellen, löschen Sie den Text im Feld "Find (Suchen)".

3. Verschieben Sie ein Objekt entweder durch Ziehen und Ablegen aus der Liste in
die Schublade, oder wählen Sie ein Objekt aus der Liste aus, und klicken Sie auf
"Add (Hinzufügen)", um es an der Stelle in der Schublade hinzuzufügen, auf die
Sie mit der rechten Maustaste zuerst geklickt haben.
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So ändern Sie Schubladeneigenschaften

Sie können die Eigenschaften einzelner Schubladen ändern. Sie können zum Beispiel die
visuelle Darstellung der Schublade ändern und festlegen, ob sie über "Hide (Verbergen)"-
Schaltflächen verfügen soll.

1. Klicken Sie mit der rechten Maustaste auf die Schublade, und wählen Sie dann
"Properties (Eigenschaften)".
Der "Drawer Properties (Schubladen-Eigenschaften)"-Dialog erscheint und die Registerkarte
"General (Allgemein)" wird angezeigt.

2. Wählen Sie die Eigenschaften für die Schublade. Die Registerkarte "General
(Allgemein)" weist folgende Elemente auf:

■ Size (Größe) – Geben Sie hier die Breite der geöffneten Schublade an.
■ Icon (Symbol) – Hier können Sie ein Symbol, das die Schublade darstellt, auswählen.

Klicken Sie auf die Schaltfläche "Icon (Symbol)", um einen "Icon Selector
(Symbolauswahl)"-Dialog anzuzeigen. Wählen Sie im Dialog ein Symbol aus, und klicken
Sie auf "OK", um Ihre Auswahl zu bestätigen.

■ "Show hide buttons (Verbergen-Knöpfe anzeigen)" – Zeigt "Hide (Verbergen)"-
Schaltflächen für ihre Schublade an. Klicken Sie auf einen der Knöpfe, um die Schublade zu
schließen.

■ "Arrows on hide buttons (Pfeile auf Verbergen-Knöpfen)" – Wählen Sie diese Option
aus, um Pfeile auf Ihren "Hide (Verbergen)"-Schaltflächen anzuzeigen, wenn "Hide
(Verbergen)"-Schaltflächen aktiviert sind.

3. Legen Sie einen Hintergrund für die Schublade mithilfe der Registerkarte
"Background (Hintergrund)" fest.
Weitere Informationen zur Vervollständigung der Registerkarte "Background (Hintergrund)"
erhalten Sie unter „Panel-Eigenschaften festlegen“ [32]. Sie können auch eine Farbe oder
ein Bild auf eine Schublade ziehen, um die Farbe oder das Bild als Hintergrund der Schublade
festzulegen. Weitere Informationen erhalten Sie unter „Informationen zur Registerkarte
"Background Properties (Hintergrundeigenschaften)"“ [33].

4. Klicken Sie auf "Close (Schließen)", um den Dialog zu schließen.

Panelobjekte

In diesem Abschnitt werden die Panel-Objekte beschrieben, die auf dem Oracle Solaris-Desktop
angezeigt werden.
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Menüleiste

Die Menüleiste enthält Anwendungen, Orte und Systemmenüs. Menubar (Menüleiste) – Sie
können auf fast alle Standardanwendungen, Befehle und Konfigurationsoptionen von der
Menüleiste aus zugreifen. Weitere Informationen über die Benutzung der Menüleiste erhalten
Sie unter Kapitel 6, Hauptmenüleiste verwenden.

ABBILDUNG 
  4-10

Hauptmenüleiste

Fensterwählerapplet

Sie können eine Liste aller aktuell geöffneten Fenster anzeigen. Sie können eine Fenster
auswählen, um es zu aktivieren. Um die Fensterliste anzuzeigen, klicken Sie auf das "Window
Selector applet (Fensterwähler-Applet)". Die folgende Abbildung zeigt ein Beispiel für ein
"Window Selector applet (Fensterwähler-Applet)".

ABBILDUNG 
  4-11

Fensterwählerapplet

Um ein Fenster zu aktiveren, wählen Sie das Fenster im "Window Selector applet
(Fensterwähler-Applet)" aus. Der Fensterwähler listet die Fenster in allen Arbeitsflächen auf.
Die Fenster aller Arbeitsflächen außer der aktuell aktivierten Arbeitsfläche, werden unterhalb
einer Trennzeile aufgelistet.

Benachrichtigungsfeldapplet

Im "Notification Area applet (Benachrichtigungsfeld-Applet)" werden Symbole verschiedener
Anwendungen angezeigt, um aktive Anwendungen anzuzeigen. Beispiel: Wenn Sie die CD-
Player-Anwendung zum Abspielen einer CD verwenden, wird ein CD-Symbol im "Notification
Area applet (Benachrichtigungsfeld-Applet)" angezeigt.
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Window List (Fensterliste)

Mit dem Fensterlistenapplet können Sie die auf dem Oracle Solaris-Desktop geöffneten
Fenster verwalten. In der Fensterliste wird für jedes Fenster oder jede Gruppe von Fenstern,
die geöffnet sind, ein Knopf angezeigt. Der Status der Knöpfe im Applet richtet sich nach dem
Status des Fensters, das den Knopf darstellt. Die nachfolgende Tabelle erläutert die möglichen
Zustände der Knöpfe der "Window List (Fensterliste)".

TABELLE 4-6 Status der Knöpfe der "Window List (Fensterliste)"

Status Folge

Der Knopf wird als eingedrückt angezeigt. Das Fenster ist aktiv.

Der Knopf wird ausgegraut angezeigt. Der Knopftext
wird in eckige Klammern eingeschlossen.

Das Fenster wird minimiert.

Der Knopf wird nicht als eingedrückt und ausgegraut
angezeigt.

Das Fenster wird nicht minimiert auf dem Desktop
angezeigt.

Eine Zahl steht in Klammern am Ende des Knopfnamens. Der Knopf stellt eine Gruppe von Knöpfen dar.

Verwendung

Sie können mithilfe der "Window List (Fensterliste)" die folgenden Aufgaben durchführen:

■ Aktivieren Sie ein Fenster, das sich auf dem Desktop befindet und vorher inaktiv war.
■ Minimieren Sie das aktive Fenster.
■ ein minimiertes Fenster wiederherstellen,

Sie können die Anordnung der Knöpfe ändern, indem Sie einen Knopf an einen anderen Ort in
der "Window List (Fensterliste)" ziehen.

Einstellungen

Um die "Window List (Fensterliste)" zu konfigurieren, klicken Sie mit der rechten
Maustaste links neben den Fensterknöpfen auf den Ziehpunkt, und wählen Sie "Preferences
(Einstellungen)". Sie können die folgenden Einstellungen ändern:

■ Window List Content (Inhalt der Fensterliste) – Legen Sie fest, welche Fenster in der
Fensterliste angezeigt werden sollen, indem Sie eine der folgenden Optionen wählen:
■ "Show windows from current workspace (Auf momentan aktiver Arbeitsfläche

befindliche Fenster anzeigen)" – Es werden nur die Fenster angezeigt, die in der aktiven
Arbeitfsfläche geöffnet sind.

■ "Show windows from all workspaces (Auf allen Arbeitsflächen befindliche Fenster
anzeigen)" – Es werden die Fenster angezeigt, die in allen Arbeitsflächen geöffnet sind.
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■ Window Grouping (Fenster gruppieren) – Legen Sie fest, wann Fenster, die zur selben
Anwendung gehören, durch die Fensterliste gruppiert werden sollen, indem Sie eine der
folgenden Optionen wählen:
■ Never group windows (Fenster nie gruppieren) – Fenster, die zur selben Anwendung

gehören, werden nie unter einem Knopf gruppiert.
■ Group windows when space is limited (Fenster gruppieren, falls der Platz begrenzt ist) –

Fenster derselben Anwendung werden unter einem Knopf gruppiert, wenn der Platz im
Panel eingeschränkt ist.

■ Always group windows (Fenster immer gruppieren) – Fenster derselben Anwendung
werden immer einem Knopf zugeordnet.

■ Restoring Minimized Windows (Wiederherstellen minimierter Fenster) – Legen Sie das
Verhalten der "Window List (Fensterliste)" beim Wiederherstellen von Fenstern mithilfe der
folgenden Optionen fest.
■ "Restore to current workspace (Auf momentan sichtbarer Arbeitsfläche

wiederherstellen)" – Fenster aus dem Applet werden auf der momentan sichtbaren
Arbeitsfläche wiederhergestellt, selbst wenn sich das Fenster vorher niccht auf der
aktuellen Arbeitsfläche befand.

■ "Restore to native workspace (Auf ursprüngliche Arbeitsfläche wiederherstellen)" – Es
wird die Arbeitsfläche aktiviert, auf der sich das Fenster ursprünglich befunden hat.

Diese Optionen stehen nur dann zur Verfügung, wenn "Show Windows From All
Workspaces (Auf allen Arbeitsfläche befindliche Fenster anzeigen)" im Abschnitt "Window
List Content (Inhalt der Fensterliste)" des Dialogs ausgewählt wurde.

Befehlsassistentapplet

Das Command Assistant-Applet ermöglicht, je nach eingegebener Suchanfrage, einen
schnellen Zugriff auf die Oracle Solaris-Dokumentation wie zum Beispiel Manpages oder
Administrationshandbücher.

Das Befehlsassistentapplet ist standardmäßig nicht installiert. Sie können das Command
Assistant-Applet installieren, indem Sie packagemanager(1) verwenden oder, indem Sie den
folgenden Befehl als root-Benutzer eingeben:

# pkg install cmdassist

Nach der Installation des Befehlsassistentapplets müssen Sie das Applet manuell einem Panel
hinzufügen. Weitere Informationen über das Hinzufügen eines Anwendungstarters zu einem
Panel erhalten Sie unter So fügen Sie einen Starter vom Popup-Menü aus zu einem Panel
hinzu [38].

Im Befehlsassistentapplet wird eine Liste von Verweisen auf die Dokumentation angezeigt,
die in einem Browser geöffnet werden kann, wenn Sie auf den gewünschten Verweis klicken.
Die Suchbegriffe werden mit den in der Dokumentation verfügbaren Befehlszeilenbeispielen
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abgeglichen, wodurch Verweise für Befehle leicht gefunden werden können. Beispiel: Sie
können auf useradd, zpool create und viele weitere Befehle zugreifen.

Im folgenden Beispiel werden die in der Dokumentation verfügbaren Befehle angezeigt, die Sie
mit dem Befehl "zpool create" verwenden können.

ABBILDUNG 
  4-12

Suchbeispiel zur Befehlsassistentensuche
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Verwendung von Desktopanwendungen

Dieses Kapitel erläutert die Verwendung von Oracle Solaris-Desktopanwendungen.
Die Anwendungen haben ein ähnliches Erscheinungsbild, verwenden dieselben
Tastenkombinationen und verfügen ebenfalls über eine Ziehen-und-Ablegen-Option. Die
Anwendungen werden unter Verwendung der GNOME 2.30-Entwicklungsplattform entwickelt.
Eine Anwendung, die unter Heranziehung dieser Plattform entwickelt wird, wird auch als eine
mit GNOME konforme Anwendung bezeichnet. Beispielsweise sind der Dateimanager und der
Texteditor Gedit Anwendungen, die mit GNOME konform sind.

In diesem Kapitel sind die folgenden Informationen enthalten:

■ „Anwendungsüberblick“ [53]
■ „Mit Dateien arbeiten“ [54]
■ „Datei öffnen“ [54]
■ „Speichern von Dateien“ [57]

Anwendungsüberblick

Eine Anwendung ist ein Typ eines Computerprogramms, mit dem Sie eine bestimmte Aufgabe
ausführen können. Verwenden Sie Anwendungen, um eine der nachfolgenden Aufgaben
auszuführen:

■ Erstellen von Textdokumenten wie Briefen oder Berichten
■ Arbeiten mit Tabellen
■ Musikhören
■ Durchsuchen des Internets
■ Erstellen, bearbeiten oder aufrufen von Bildern und Videos

Für jede dieser Aufgaben benutzen Sie verschiedene Anwendungen.

Um eine Anwendung zu starten, öffnen Sie das Menü "Applications (Anwendungen)",
und wählen Sie die gewünschte Anwendung aus den Untermenüs. Weitere Informationen
zum Starten einer Anwendung finden Sie unter „Informationen zum Menü "Applications
(Anwendungen)"“ [59].
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In der nachfolgenden Tabelle werden die Anwendungen erläutert, die sich auf Oracle Solaris-
Desktop befinden.

TABELLE 5-1 Desktopanwendungen

Anwendung Beschreibung

Gedit Texteditor Liest, erzeugt und verändert jeglichen unformatierten Text.

Wörterbuch Hilft Ihnen bei der Suche nach der Definition eines Wortes.

Image Viewer
(Bildbetrachter)

Stellt sowohl einzelne Bilddateien als auch ganze Bildersammlungen dar.

Character Map
(Zeichentabelle)

Bietet Zeichen aus dem Unicode-Zeichensatz zur Auswahl und zum Einfügen in eine beliebige
Anwendung an.

Nautilus
Dateimanager

Zeigt Ordner und ihren Inhalt an. Benutzen Sie diese Anwendung, um Dateien zu kopieren, zu
verschieben oder zu klassifizieren. Die Anwendung ermöglicht zudem den Zugang zu CDs,
USB-Flashlaufwerken und anderen Wechselmedien.

Terminal Erlaubt den Zugriff auf die Befehlszeile.

Weitere Standarddesktopanwendungen sind Spiele, Musik- und Videoabspieler, ein
Webbrowser, Softwarebarrierefreiheitstools und Dienstprogramme zur Systemverwaltung.

Mit Dateien arbeiten

Die Arbeit, die Sie mit einer Anwendung ausführen, wird in Dateien gespeichert. Diese können
sich auf der Festplatte Ihres Computers befinden oder auch auf einem Wechselgerät wie einem
USB-Flashlaufwerk. Sie öffnen eine Datei, um Sie zu betrachten, oder Sie speichern eine
Datei, um die Ergebnisse Ihrer Arbeit zu bewahren. In diesem Abschnitt werden die Aktionen
beschrieben, die im Dialog "File (Datei)" ausgeführt werden können.

Desktopanwendungen verwenden stets ähnliche Dialoge für das Öffnen und Speichern von
Dateien und werden in einer konsistenten Benutzeroberfläche dargestellt.

Datei öffnen

Im Dialog "Open File (Datei öffnen)" können Sie eine Datei auswählen, die in einer
Anwendung geöffnet werden soll. In der Leiste auf der rechten Seite des Dialogs werden
Dateien und Ordner des aktuellen Speicherortes aufgelistet. In diesem Abschnitt werden
Aktionen beschrieben, die Sie im Dialog "File (Datei)" ausführen können.

Zum Auswählen einer Datei können Sie die Maus oder die Pfeiltasten auf der Tastatur
verwenden. Sobald eine Datei in der Liste ausgewählt ist, führen Sie einen der folgenden
Schritte aus, um sie zu öffnen:
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■ Klicken Sie auf "Open (Öffnen)".
■ Drücken Sie die Eingabetaste
■ Drücken Sie die Leertaste
■ Doppelklicken Sie auf die Datei

Wenn Sie einen Ordner oder einen Ort anstelle einer Datei öffnen, wird im Dialog "Open File
(Datei öffnen)" die Ansicht des Inhalts dieses Ordners oder Ortes aktualisiert.

Um den Speicherort zu ändern, der in der rechten Leiste angezeigt wird, führen Sie eine der
folgenden Aktionen aus:

■ Öffnen Sie einen Ordner, der im aktuellen Speicherort aufgeführt wird.
■ Öffnen Sie ein Element aus der Leiste auf der linken Seite. In dieser Leiste werden Orte

aufgeführt wie der Ordner "Documents (Dokumente)", der persönliche Ordner, Datenträger
wie CDs und Flashlaufwerke, Netzwerkorte und Lesezeichen.

■ Klicken Sie auf eine der Schaltflächen in der Pfadleiste oberhalb der Leiste "File List
(Dateiliste)". Die Dateiliste zeigt die Ordnerhierarchie an, in der auch Ihr aktueller
Speicherort enthalten ist. Verwenden Sie die Pfeiltasten auf einer beliebigen Seite der
Schaltflächenleiste, wenn die Ordnerliste lang ist.

Der untere Teil des Dialogs "Open File (Datei öffnen)" kann weitere Optionen speziell zur
aktuellen Anwendung enthalten.

File List (Dateiliste) filtern
Sie können die Anzeige der Dateiliste auf Dateien bestimmter Typen beschränken. Wählen
Sie dafür einen Dateityp aus der Dropdown-Liste unterhalb der Dateiliste aus. Die Liste der
Dateitypen hängt davon ab, welche Anwendung Sie gegenwärtig benutzen. Eine grafische
Anwendung wird zum Beispiel andere Dateiformate für Bilder und ein Texteditor wird andere
Dateitypen für Textdateien auflisten.

Tipp - Geben Sie den Namen der Datei ein, die geöffnet werden soll. Die Dateiliste zeigt
sämtliche Dateien an, deren Namen mit den eingegebenen Zeichen beginnen. Die eingegebenen
Zeichen erscheinen in einem Popup-Fenster am Ende der Dateiliste. Drücken Sie Esc, um das
Suchen beim Eingeben abzubrechen.

Wählen von Ordnern
Manchmal ist es nötig, einen Ordner auszuwählen, ohne dass Sie eine Datei öffnen wollen.
Beispiel: Wenn Sie Archive Manager benutzen, um Dateien aus einem Archiv zu extrahieren,
benötigen Sie einen Ordner, um die Dateien abzulegen. In diesem Fall werden die Dateien des
aktuellen Speicherortes ausgegraut und der Ordner ausgewählt, wenn Sie auf "Open (Öffnen)"
klicken.
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Speicherorte öffnen

Sie können einen vollen oder relativen Pfad zu der zu öffnenden Datei angeben. Drücken
Sie STRG+L, oder klicken Sie auf die Schaltfläche oben links im Fenster, um das Feld
"Location" (Speicherort) ein- oder auszublenden. Wahlweise können Sie die Eingabe eines
vollständigen Pfades mit einem / beginnen, um das Feld "Location (Ort)" anzuzeigen.

Geben Sie einen vom aktuellen Ort ausgehenden Pfad oder einen kompletten Pfad ein, der mit
/ oder ~/ beginnt. Das Feld "Location (Ort)" verfügt über die folgenden Funktionen, um die
Eingabe eines vollständigen Dateinamens zu vereinfachen:

■ Eine Dropdown-Liste mit möglichen Datei- und Ordnernamen wird angezeigt, wenn Sie mit
der Eingabe beginnen. Verwenden Sie die nach unten oder oben weisende Pfeiltaste und die
Eingabetaste, um eine Auswahl in der Liste zu treffen.

■ Wenn der Teil des eingegebenen Namens eindeutig eine Datei oder einen Ordner
identifiziert, wird der Name automatisch vervollständigt. Drücken Sie die Tabulatortaste,
um den vorgeschlagenen Text zu akzeptieren. Beispiel: Wenn Sie Do eingeben und das
einzige Objekt innerhalb des Ordners, das mit “Do “beginnt, ist "Dokumente", dann wird
der vollständige Name im Feld angezeigt.

Öffnen von Remote-Speicherorten

Sie können Dateien an Remote-Orten öffnen, indem Sie einen Ort im linken Panel wählen. Sie
können auch im Feld "Location (Ort)" einen Pfad zu einem Remote-Ort eingeben.

Wenn ein Passwort zum Zugriff auf den entfernten Ort benötigt wird, werden Sie beim Öffnen
danach gefragt.

Lesezeichen hinzufügen und entfernen

Klicken Sie mit der rechten Maustaste auf einen Ordner in der "File List (Dateiliste)", und
wählen Sie "Add to Bookmarks (Zu Lesezeichen hinzufügen)", um den aktuellen Ort zur
Lesezeichenliste hinzuzufügen. Sie können jeden beliebigen Ordner hinzufügen, der im
aktuellen Ort aufgelistet ist, indem Sie ihn in die Lesezeichenliste ziehen.

Um ein Lesezeichen aus der Liste zu entfernen, wählen Sie es aus, und klicken Sie auf
"Remove (Entfernen)".

Anmerkung - Die von Ihnen vorgenommenen Änderungen in der Lesezeichenliste wirken sich
auch auf das Menü "Places (Orte)" aus. Weitere Informationen zu Lesezeichen erhalten Sie
unter „Lesezeichen verwenden“ [99].
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Anzeigen ausgeblendeter Dateien

Um verborgene Dateien in der Liste anzuzeigen, klicken Sie mit der rechten Maustaste
in die Dateiliste, und wählen Sie "Show Hidden Files (Verborgene Dateien zeigen)".
Weitere Informationen zu verborgenen Dateien erhalten Sie unter „Datei oder Ordner
verbergen“ [102] .

Speichern von Dateien

Wenn Sie Ihre Arbeit in einer Anwendung zum ersten Mal speichern, werden Sie im
Dialog "Save as (Speichern als)" aufgefordert, den Ort und einen Dateinamen anzugeben.
Späteres Speichern aktualisiert die Datei, und Sie werden nicht erneut um die Eingabe eines
Speicherortes oder Dateinamens gebeten. Um eine bestehende Datei neu abzuspeichern, wählen
Sie "File -> Save As" (Datei -> Speichern unter).

Sie können einen Dateinamen eingeben und einen Speicherort aus der Dropdown-Liste der
Lesezeichen und der häufig verwendeten Speicherorte auswählen.

Dateien an einem anderen Ort speichern

Um die Datei an einem Ort zu speichern, der nicht in der Dropdown-Liste aufgeführt wird,
klicken Sie auf "Browse (Suchen)". Der Dialog "Save File (Datei speichern)" wird angezeigt.

Anmerkung - Der erweiterte Dialog "Save File (Datei speichern)" verfügt über dieselben
Funktionen wie der Dialog "Open File (Datei öffnen)". Dazu gehört Filtern, Suchen beim
Eingeben sowie das Hinzufügen und Entfernen von Lesezeichen.

Existierenden Datei ersetzen

Falls Sie den Namen einer bereits existierenden Datei eingegeben haben, werden Sie danach
gefragt, ob Sie die existierende Datei durch Ihre aktuelle Arbeit ersetzen wollen. Dies können
Sie auch tun, indem Sie im Browser die Datei auswählen, die Sie überschreiben wollen.

Ordner erstellen

Wenn Sie einen neuen Ordner anlegen möchten, um Ihre Datei zu speichern, klicken Sie auf
"Create Folder (Ordner anlegen)". Geben Sie einen Namen für den neuen Ordner ein, und
drücken Sie die Eingabetaste. Sie können dann die Datei im neuen Ordner speichern.
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Hauptmenüleiste verwenden

In diesem Kapitel wird die Verwendung der Panel-Menüleiste des Desktops beschrieben. In
diesem Kapitel sind die folgenden Informationen enthalten:

■ „Informationen zur Hauptmenüleiste“ [59]
■ „Informationen zum Menü "Applications (Anwendungen)"“ [59]
■ „Menü "Places (Orte)" verwenden“ [60]
■ „Menü "System (System)" verwenden“ [61]
■ „Menü "Administration (Verwaltung)" verwenden“ [61]
■ „Panel-Menüleiste anpassen“ [62]

Informationen zur Hauptmenüleiste

Die Panel-Menüleiste ist der Hauptzugangspunkt zum Desktop. Die Menüleiste besteht aus den
folgenden Menüs:

■ Applications (Anwendungen) – startet die erforderlichen Anwendungen.
■ Places (Orte) – ruft Orte auf dem Computer oder im Netzwerk auf.
■ System (System) – passt das System an, meldet vom Desktop ab oder fährt das System

herunter.

Anmerkung - Standardmäßig befindet sich die Panel-Menüleiste im Panel am oberen
Bildschirmrand. Aber wie bei jedem anderen Panel-Objekt auch können Sie die Panel-
Menüleiste auf ein anderes Panel verschieben oder eine weitere Panel-Menüleiste zu Ihren
Panels hinzufügen. Weitere Informationen zu Menüs finden Sie unter „Menüs“ [44].

Informationen zum Menü "Applications (Anwendungen)"

Das Menü "Applications (Anwendungen)" weist eine hierarchische Struktur aus Untermenüs
auf, über die Sie die auf Ihrem System installierten Anwendungen starten können.
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Jedes Untermenü entspricht einer Kategorie. Beispiel: Im Untermenü "Sound & Video
(Unterhaltungsmedien)" finden Sie Anwendungen zum Abspielen von CDs und für
Audioaufnahmen.

Wenn Sie eine neue Anwendung installiert haben, wird diese automatisch dem Menü
"Anwendungen" in einer passenden Kategorie hinzugefügt. Beispiel: Eine Instant Messenger-
Anwendung, VoIP-Anwendung oder ein FTP-Client wird nach der Installation im Untermenü
"Internet" abgelegt.

So starten Sie eine Anwendung
1. Öffnen Sie das Menü "Applications (Anwendungen)".

2. Wählen Sie die Kategorie, zu welcher die von Ihnen gewünschte Anwendung
gehört.
Sie können ein Untermenü öffnen, indem Sie mit der Maus über die Kategorie fahren.

3. Klicken Sie auf den Menüeintrag der Anwendung, die Sie öffnen möchten.

Menü "Places (Orte)" verwenden
Das Menü "Places (Orte)" bietet eine schnelle Möglichkeit, zu den verschiedenen Orten auf
Ihrem Rechner und im lokalen Netzwerk zu gelangen. Die folgenden Objekte können über das
Menü "Places (Orte)" aufgerufen werden:

■ Standardverzeichnis
■ Desktopordner, der den auf dem Desktop angezeigten Objekten entspricht.
■ Dateimanagerlesezeichenobjekte Weitere Informationen zur Verwendung von Lesezeichen

finden Sie unter „Lesezeichen verwenden“ [99].
■ Lokale Laufwerke auf dem System
■ CD/DVD-Ersteller
■ Lokales Netzwerk Weitere Informationen zum Zugriff auf Orte im Netzwerk finden Sie

unter „Auf Orte im Netzwerk zugreifen“ [110].

Die folgenden Elemente im Menü "Places (Orte)" rufen keine Orte auf, sondern führen
Aktionen aus:

■ Mit Server verbinden – Sie können einen Server im Netzwerk wählen. Weitere
Informationen zum Zugriff auf Remote-Netzwerke finden Sie unter „Auf Remote-Server
zugreifen“ [109].

■ "Search for Files (Nach Dateien suchen)" – Sie können auf dem Computer nach Dateien
suchen. Weitere Informationen zur Suche nach Dateien finden Sie im Search Tool Manual.

http://library.gnome.org/users/gnome-search-tool/2.32/
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■ Recent Documents (Zuletzt geöffnete Dokumente) – führt die Dokumente auf, die Sie
zuletzt geöffnet haben. Der letzte Eintrag in diesem Untermenü löscht die Liste.

Menü "System (System)" verwenden

Das Menü "System (System)" erlaubt Ihnen, die Einstellungen für den Oracle Solaris-Desktop
festzulegen, Hilfe zur Verwendung des Desktops zu erhalten, sich vom System abzumelden
oder es herunterzufahren.

Sie können über das Menü "System (System) " die folgenden Aktionen ausführen:

■ Konfigurieren Sie den Computer mithilfe der Einstellungstools. Weitere Informationen zur
Verwendung dieser Einstellungen finden Sie in Kapitel 10, Anpassen des Desktops.

■ Starten Sie den Hilfebrowser.
■ Sperren Sie den Bildschirm, damit der Bildschirmschoner gestartet wird. Weitere

Informationen finden Sie unter „Sperren des Bildschirms“ [14].
■ Melden Sie sich ab, oder wechseln Sie den Benutzer.
■ Beenden Sie Ihre Desktopsitzung, um den Computer herunterzufahren, oder starten Sie ihn

neu. Weitere Informationen zum Abmelden und Herunterfahren finden Sie unter „Beenden
von Sitzungen“ [17].

Menü "Administration (Verwaltung)" verwenden

Sie können mithilfe des Menüs "Administration (Verwaltung)" den Oracle Solaris-
Desktop verwalten und Aufgaben wie die Konfiguration von Netzwerkgeräten, die
Verwaltung von Druckern und SMF-Services sowie die Systemkonfiguration für
automatische ZFS-Schnappschüsse durchführen. Weitere Informationen zu den einzelnen
Verwaltungsdienstprogrammen, die über das Menü zugänglich sind, erhalten Sie, wenn Sie im
entsprechenden Dialog auf "Help (Hilfe)" klicken.

Das Menü "Administration (Verwaltung)" besteht aus den folgenden Elementen:

■ Core Files (Core-Dateien) – Konfigurieren Sie Namen, Speicherorte und Inhalte von Core-
Dateien, die vom Oracle Solaris-Desktop generiert werden.

■ Netzwerk – Netzwerkschnittstelleneigenschaften, Verbindungsprofile, Orte und
Netzwerkmodifizierer können Sie hier anzeigen und konfigurieren.

■ Package Manager (Package Manager) – Softwarepakete können über das Oracle Solaris
Image Packaging System gesucht, hinzugefügt, aktualisiert und entfernt werden. Ebenso
können Sie Paketherausgeber sowie Boot-Umgebungen anzeigen und bearbeiten.

■ Druckmanager – Hier können Sie mithilfe von CUPS (Common UNIX Printing System)
lokale Drucker und Netzwerkdrucker hinzufügen, entfernen und konfigurieren.
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■ SMF-Services – Überwachen, konfigurieren, aktivieren und deaktivieren Sie SMF-Services
(Service Management Facility) auf dem lokalen System.

■ System Firewall (Systemfirewall) – Konfigurieren Sie systemweite oder servicespezifische
Firewallrichtlinieneinstellungen.

■ Time Slider (Zeit-Schieberegler) – Aktivieren oder deaktivieren Sie regelmäßige
Schnappschüsse bestimmter ZFS-Dateisysteme. Bei Aktivierung können Benutzer über den
Dateimanager den Inhalt älterer Schnappschüsse visualisieren und durchsuchen.

■ Zeit/Datum – Stellen Sie die Systemzeit ein, oder konfigurieren Sie sie automatisch über
einen Zeitserver.

■ Update Manager (Update-Manager) – Überprüfen und installieren Sie verfügbare
Paketupdates.

Panel-Menüleiste anpassen

Sie können den Inhalt folgender Menüs anpassen:

■ Menü "Applications" (Anwendungen)
■ Untermenü "System -> Preferences" (System -> Einstellungen)
■ Untermenü "System -> Administration" (System -> Verwaltung)

Weitere Informationen zur Implementierung dieser Menüs im Desktop und deren Anpassung
durch Administratoren finden Sie im „Oracle Solaris 11.2 Desktop Administrator’s Guide “.

So bearbeiten Sie Menüs
1. Klicken Sie mit der rechten Maustaste auf die Panel-Menüleiste, und wählen Sie

"Edit Menus (Menüs bearbeiten)".
Das Dialogfeld "Menu Layout (Menüanordnung)" wird angezeigt. Die Menüs werden in der
linken Leiste aufgeführt.

2. Klicken Sie auf die Aufklapppfeile, um Untermenüs anzuzeigen oder
auszublenden.

3. Wählen Sie in der linken Leiste ein Menü aus, um dessen Inhalt in der rechten
Leiste anzuzeigen.

4. Wählen Sie ein Element ab, um es aus dem Menü zu entfernen. Wählen Sie ein
Element aus, um es wieder dem Menü hinzuzufügen.

http://www.oracle.com/pls/topic/lookup?ctx=E36784&id=SDSAG
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Verwenden des Zeitschiebereglers

Der Zeitschieberegler bietet für Oracle Solaris-Desktopbenutzer eine anschauliche Möglichkeit
zur Wiederherstellung einzelner Dateien oder Verzeichnisse aus automatisch aufgenommenen,
inkrementellen Schnappschüssen von Verzeichnissen mit persönlichen Ordnern. Nachdem der
Zeitschieberegler aktiviert und eingerichtet wurde, erstellt er standardmäßig alle 15 Minuten
einen Schnappschuss von jedem ZFS-Dateisystem. Diese Schnappschüsse werden dann mit der
Zeit wieder gelöscht, sodass nur ein Schnappschuss für jede der letzten 24 Stunden, einer für
jeden der letzten 7 Tage sowie ein Schnappschuss für jede vergangene Woche seit Beginn der
Verwendung des Zeitschiebereglers übrig bleiben.

Ein Schnappschuss ist eine schreibgeschützte Kopie des Dateisystems oder Datenträgers.
Schnappschüsse können praktisch sofort erstellt werden und verbrauchen keinen zusätzlichen
Festplattenspeicherplatz innerhalb des Pools. Wenn sich die Daten innerhalb des aktiven
Datensatzes ändern, verbraucht der Schnappschuss Festplattenspeicher, da er auf die veralteten
Daten verweist und daher kein Speicherplatz auf der Festplatte freigegeben wird.

Schnappschussservices des Zeitschiebereglers können regelmäßige Schnappschüsse von
allen ZFS-Dateisystemen einschließlich Boot-Umgebungen automatisieren, sogar von Non-
Desktop-Systemen. Das Paket desktop/time-slider erfordert jedoch die Installation des
Pakets desktop-incorporation, sogar wenn der Oracle Solaris-Desktop auf dem Rechner nicht
verwendet wird.

Weitere Informationen zum Zeitschieberegler finden Sie in Chapter 6, „Working With Oracle
Solaris ZFS Snapshots and Clones,“ in „Managing ZFS File Systems in Oracle Solaris 11.2“.

Leiste "Preferences (Einstellungen)" des Zeitschiebereglers

In der Leiste "Preferences (Einstellungen)" des Zeitschiebereglers können Sie den
Zeitschieberegler aktivieren oder deaktivieren sowie auf folgende Funktionen zugreifen:

■ auf externem Speichergerät sichern,
■ Dateisysteme sichern,
■ den für Schnappschüsse vorgesehener Festplattenspeicher ändern,
■ vorhandene Schnappschüsse löschen.

http://www.oracle.com/pls/topic/lookup?ctx=E36784&id=ZFSADMINgavvx
http://www.oracle.com/pls/topic/lookup?ctx=E36784&id=ZFSADMINgavvx


So aktivieren Sie den Zeitschieberegler

64 Desktopbenutzerhandbuch zu Oracle Solaris 11.2 • Juli 2014

Zeitschiebereglerservice aktivieren und
deaktivieren

Standardmäßig ist der Zeitschieberegler deaktiviert. Führen Sie die in den folgenden
Abschnitten aufgeführten Schritte durch, um ihn zu aktivieren. Bei Aktivierung nutzt der
Zeitschieberegler folgende SMF-Services:

■ svc:/system/filesystem/zfs/auto-snapshot:frequent: Schnappschuss alle 15 Minuten
■ svc:/system/filesystem/zfs/auto-snapshot:hourly: Schnappschuss einmal pro Stunde
■ svc:/system/filesystem/zfs/auto-snapshot:daily: Schnappschuss einmal pro Tag
■ svc:/system/filesystem/zfs/auto-snapshot:weekly: Schnappschuss einmal pro Woche
■ svc:/system/filesystem/zfs/auto-snapshot:monthly: Schnappschuss einmal im Monat
■ svc:/application/time-slider:default: automatisches Löschen von Schnappschüssen
■ svc:/application/time-slider/plugin:rsync: automatische Schnappschussreplikation

auf ein bestimmtes externes Speichergerät

So aktivieren Sie den Zeitschieberegler

1. Öffnen Sie die Leiste "Preferences" (Einstellungen) des Zeitschiebereglers,
indem Sie zu "System->Administration->Time Slider" (System-
>Systemverwaltung->Zeitschieberegler) navigieren.

2. Wählen Sie die Option "Enable Time Slider (Zeit-Schieberegler aktivieren)".

3. Klicken Sie auf "OK (OK)".
Der Zeitschieberegler ist für alle verfügbaren ZFS-Dateisysteme aktiviert. Informationen zum
Ausschließen von mindestens einem ZFS-Dateisystem finden Sie unter So wählen Sie ein
bestimmtes ZFS-Dateisystem für den Schnappschuss [66].

So deaktivieren Sie den Zeitschieberegler

1. Öffnen Sie die Leiste "Preferences" (Einstellungen) des Zeitschiebereglers,
indem Sie zu "System->Administration->Time Slider" (System-
>Systemverwaltung->Zeitschieberegler) navigieren.

2. Wählen Sie die Option "Enable Time Slider (Zeit-Schieberegler deaktivieren)".

3. Klicken Sie auf "OK (OK)".
Der Zeitschieberegler ist für alle verfügbaren ZFS-Dateisysteme deaktiviert.
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Mit den Schnappschüssen des Zeitschiebereglers arbeiten
Der Zeitschieberegler erstellt häufig Schnappschüsse der installierten ZFS-Dateisysteme, d.h.
alle 15 Minuten, stündlich, täglich und wöchentlich.

Sie können Schnappschüsse über die Leiste "Preferences (Einstellungen)" des
Zeitschiebereglers oder über den Dateimanager erstellen. In den folgenden Abschnitten werden
verschiedene Verfahren beschrieben, die mithilfe dieser Schritte durchgeführt werden können.

Schnappschüsse mithilfe des Zeitschiebereglers
verwalten
Bei Aktivierung des Zeitschiebereglers werden automatische Schnappschüsse wie folgt
gelöscht:

■ frequent Schnappschüsse werden nach 1 Stunde gelöscht.
■ hourly Schnappschüsse werden nach 1 Tag gelöscht.
■ daily Schnappschüsse werden nach 1 Woche gelöscht.
■ weekly Schnappschüsse werden nach 1 Monat gelöscht.
■ Mindestens einer der ältesten Schnappschüsse in einem Dateisystem wird gelöscht, wenn

die Speicherkapazität des Dateisystems 80% überschreitet.

Sie können Schnappschüsse nach Bedarf auch manuell löschen. Weitere Informationen finden
Sie unter So löschen Sie einen vorhandenen Zeitschiebereglerschnappschuss [65].

Sie können den Schwellenwert für freien Festplattenspeicher ändern, sodass die ältesten
Schnappschüsse automatisch gelöscht werden. Weitere Informationen finden Sie unter So
ändern Sie den für Schnappschüsse vorgesehenen Festplattenspeicher [66].

Wenn keine Schnappschüsse erstellt und auf jedem ZFS-Dateisystem abgespeichert werden
sollen, können Sie bestimmen, welche Dateisysteme ein- und auszuschließen sind. Weitere
Informationen finden Sie unter So wählen Sie ein bestimmtes ZFS-Dateisystem für den
Schnappschuss [66].

Um den Schutz zu erhöhen, kann eine Kopie eines Zeitschiebereglerschnappschusses
automatisch auf einem externen Speichergerät abgelegt werden. Weitere Informationen finden
Sie unter So replizieren Sie Schnappschüsse nach externen Speichergeräten [67].

So löschen Sie einen vorhandenen
Zeitschiebereglerschnappschuss

1. Öffnen Sie die Leiste "Preferences" (Einstellungen) des Zeitschiebereglers,
indem Sie zu "System->Administration->Time Slider" (System-
>Systemverwaltung->Zeitschieberegler) navigieren.
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2. Klicken Sie auf den Knopf "Schnappschüsse löschen", um das Fenster
"Schnappschüsse löschen" zu öffnen.

3. Wählen Sie die zu löschenden Schnappschüsse aus der Schnappschussliste.
Sie können die Liste nach Dateisystem und nach dem SMF-Service filtern, der den
Schnappschuss erstellt hat: frequent, hourly, daily, weekly oder monthly.

4. Klicken Sie auf den Knopf "Löschen".

5. Klicken Sie auf den Knopf "Schließen".

Anmerkung - Schnappschüsse, die nicht vom Zeitschieberegler erstellt wurden, werden im
Fenster "Delete Snapshots (Schnappschüsse löschen)" aufgeführt und können auf dieselbe
Weise gelöscht werden.

So ändern Sie den für Schnappschüsse vorgesehenen
Festplattenspeicher

Standardmäßig erstellt der Zeitschieberegler neue Schnappschüsse auf einem ZFS-Dateisystem,
bis die Speicherplatzbelegung des Dateisystems 80% beträgt. Dann löscht der Zeitschieberegler
automatisch mindestens einen der ältesten automatischen Schnappschüsse, damit die
Dateisystemauslastung bei oder unter 80% liegt.

Sie können diesen Schwellenwert zwischen 70 und 90% festlegen. Dieser Wert gilt für alle
ZFS-Dateisysteme. Führen Sie die folgenden Schritte durch, um den Schwellenwert zu ändern.

1. Öffnen Sie die Leiste "Preferences" (Einstellungen) des Zeitschiebereglers,
indem Sie zu "System->Administration->Time Slider" (System-
>Systemverwaltung->Zeitschieberegler) navigieren.

2. Klicken Sie auf den Aufklappknopf "Erweiterte Optionen".

3. Legen Sie einen Wert zwischen 70 und 90 entweder durch Eingabe im Textfeld
"Sicherungen reduzieren, wenn Speicherplatznutzung Folgendes überschreitet"
oder mithilfe des Drehfelds fest.

4. Klicken Sie auf "OK", um das Fenster zu schließen.

So wählen Sie ein bestimmtes ZFS-Dateisystem für den
Schnappschuss

Standardmäßig erstellt der Zeitschieberegler Schnappschüsse von allen ZFS-Dateisystemen.
Führen Sie die folgenden Schritte durch, um bestimmte Dateisysteme für den
Zeitschiebereglerservice auszuwählen, der den Schnappschuss erstellen soll.
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1. Öffnen Sie die Leiste "Preferences" (Einstellungen) des Zeitschiebereglers,
indem Sie zu "System->Administration->Time Slider" (System-
>Systemverwaltung->Zeitschieberegler) navigieren.

2. Klicken Sie auf den Aufklappknopf "Erweiterte Optionen".

3. Klicken Sie auf das Optionsfeld "Benutzerdefiniert".

4. Wählen Sie aus der Liste der ZFS-Dateisysteme die Option neben dem
Dateisystem aus, von dem Sie einen Schnappschuss erstellen möchten. Wählen
Sie die Dateisystemoptionen ab, von denen Sie keinen Schnappschuss erstellen
möchten.

5. Klicken Sie auf "OK", um das Fenster zu schließen.

So replizieren Sie Schnappschüsse nach externen
Speichergeräten

Um den Schutz der Daten zu erhöhen, kann der Zeitschieberegler ein Duplikat jedes
Schnappschusses auf einem externen Speichergerät ablegen. Führen Sie die folgenden Schritte
durch, um diese Funktion zu aktivieren.

1. Öffnen Sie die Leiste "Preferences" (Einstellungen) des Zeitschiebereglers,
indem Sie zu "System->Administration->Time Slider" (System-
>Systemverwaltung->Zeitschieberegler) navigieren.

2. Klicken Sie auf den Aufklappknopf "Erweiterte Optionen".

3. Wählen Sie die Option "Replicate backups to an External Drive" (Sicherungen
auf einem externen Laufwerk replizieren).

4. Wählen Sie mithilfe des Knopfs zur Dateiauswahl ein Verzeichnis auf einem
externen Speichergerät aus.

5. Klicken Sie auf "OK", um das Fenster zu schließen.

Anmerkung - Externe Geräte müssen für die Verwendung dieser Funktion nicht mit dem ZFS-
Dateisystem formatiert werden.

Dateimanagerschnappschüsse verwalten

Der Zeitschiebereglerservice erstellt Schnappschüsse von Ihren Dateien automatisch alle
15 Minuten. Wenn Ihr Systemadministrator den Zeitschieberegler aktiviert hat, können
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Sie alte Versionen Ihrer Dateien mithilfe der Dateimanageranwendung durchsuchen und
wiederherstellen.

So zeigen Sie die verfügbaren Schnappschüsse im
Dateimanager an

Führen Sie die folgenden Schritte durch, um eine Liste der für einen bestimmten Ordner
verfügbaren Schnappschüsse anzuzeigen.

1. Öffnen Sie das Dateimanagerfenster, und navigieren Sie zu einem Ordner.

2. Führen Sie zum Öffnen der Zeitschiebereglerleiste die folgenden Schritte durch:

■ Wählen Sie im Dateimanagerfenster "View->Restore" (Ansicht-
>Wiederherstellen), und klicken Sie in der Werkzeugleiste auf die
Schaltfläche "Time Slider" (Zeitschieberegler).

■ Drücken Sie Strg+E, um die Zeitschiebereglerleiste zu öffnen.

In der Zeitschiebereglerleiste werden die verfügbaren Schnappschüsse für einen Ordner zeitlich
geordnet als Balken angezeigt. Der älteste Schnappschuss befindet sich, wie nachfolgend
dargestellt, auf der linken, der neueste mit der Bezeichnung "Jetzt" auf der rechten Seite.

Pro Schnappschuss in der Zeitschiebereglerleiste:

■ Die Höhe des Balken zeigt die im Schnappschuss enthaltene Datenmenge an. Je höher der
Balken ist, desto öfter wurde das Dateisystem seit dem vorherigen Schnappschuss geändert.

■ Das Aussehen des Balken verweist auf den Schnappschusstyp.
■ Leer: nur lokaler Schnappschuss, keine externe Sicherung
■ Ausgefüllt: lokaler Schnappschuss mit externer Sicherung
■ Abgerundete Oberseite: automatischer Schnappschuss durch Zeitschieberegler
■ Eckige Oberseite: manuell erstellter Schnappschuss

Wenn mehrere Schnappschüsse angezeigt werden, können Sie die Timeline mithilfe der
Aufklappliste in der Zeitschiebereglerleiste filtern. Folgende Optionen sind verfügbar:
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■ All (Alle): Alle vorhandenen Schnappschüsse werden angezeigt.
■ Today (Heute): Nur die Schnappschüsse, die heute erstellt wurden, werden angezeigt.
■ Yesterday (Gestern): Nur die Schnappschüsse, die gestern erstellt wurden, werden

angezeigt.
■ This week (Diese Woche): Die seit Sonntag der laufenden Woche erstellten Schnappschüsse

werden angezeigt.
■ Last week (Letzte Woche): Die zwischen Sonntag und Samstag der vorherigen Woche

erstellten Schnappschüsse werden angezeigt.
■ This month (Diesen Monat): Die seit dem ersten Tag des laufenden Monats erstellten

Schnappschüsse werden angezeigt.
■ Last month (Letzten Monat): Die zwischen dem ersten und letzten Tag des vorherigen

Monats erstellten Schnappschüsse werden angezeigt.
■ This year (Dieses Jahr): Die seit Januar des laufenden Jahres erstellten Schnappschüsse

werden angezeigt.
■ Last year (Letztes Jahr): Die zwischen dem 1. Januar und dem 31. Dezember des letzten

Jahres erstellten Schnappschüsse werden angezeigt.

Klicken Sie zum Ausblenden der Zeitschiebereglerleiste oben rechts im Fensterbereich auf den
Knopf "Close (Schließen)". Sie können auch "View->Restore" (Ansicht->Wiederherstellen)
wählen, in der Werkzeugleiste auf die Schaltfläche "Time Slider" (Zeitschieberegler) klicken
oder bei angezeigtem Fensterbereich STRG+E drücken.

So zeigen Sie die vorherige Version einer Datei oder eines
Ordners an

1. Öffnen Sie das Dateimanagerfenster, und navigieren Sie zum Ordner, der die
Datei enthält.

2. Öffnen Sie die Zeitschiebereglerleiste mithilfe einer der folgenden Methoden:

■ Wählen Sie im Dateimanagerfenster "View->Restore" (Ansicht-
>Wiederherstellen), und klicken Sie in der Werkzeugleiste auf die
Schaltfläche "Time Slider" (Zeitschieberegler).

■ Drücken Sie Strg+E, um die Zeitschiebereglerleiste zu öffnen.

3. Klicken Sie in der Zeitschiebereglerleiste auf den Balken, der dem
Schnappschuss entspricht, den Sie anzeigen möchten.
Der Inhalt des Dateimanagerfensters wird aktualisiert, sodass die Dateien angezeigt werden, die
zum Zeitpunkt der Erstellung des Schnappschusses im Ordner vorhanden waren.

4. Doppelklicken Sie auf eine beliebige Datei, um den Inhalt der Datei zum
Zeitpunkt der Schnappschusserstellung anzuzeigen.



So vergleichen Sie Versionen einer Datei oder eines Ordners

70 Desktopbenutzerhandbuch zu Oracle Solaris 11.2 • Juli 2014

So vergleichen Sie Versionen einer Datei oder eines Ordners

1. Öffnen Sie das Dateimanagerfenster, und navigieren Sie zum Ordner, der die
Datei enthält.

2. Öffnen Sie die Zeitschiebereglerleiste mithilfe einer der folgenden Methoden:

■ Wählen Sie im Dateimanagerfenster "View->Restore" (Ansicht-
>Wiederherstellen), und klicken Sie in der Werkzeugleiste auf die
Schaltfläche "Time Slider" (Zeitschieberegler).

■ Drücken Sie Strg+E, um die Zeitschiebereglerleiste zu öffnen.

3. Klicken Sie in der Zeitschiebereglerleiste auf den Balken, der dem
Schnappschuss entspricht, den Sie anzeigen möchten.
Der Inhalt des Dateimanagerfensters wird aktualisiert, sodass die Dateien angezeigt werden, die
zum Zeitpunkt der Erstellung des Schnappschusses im Ordner vorhanden waren.

4. Um das Versions-Explorer-Fenster zu öffnen, klicken Sie mit der rechten
Maustaste auf eine beliebige Datei, und wählen Sie dann aus dem Menü die
Option "Explore Versions (Nach Versionen suchen)".
Wenn keine unterschiedlichen Versionen für einen Vergleich vorhanden sind, wird im Menü
"Keine Versionen" anstelle von "Nach Versionen suchen" angezeigt.

Das Fenster mit dem Dateiversions-Explorer des Zeitschiebereglers wird angezeigt.

5. Wählen Sie im Versions-Explorer-Fenster eine ältere Version der Datei aus, und
klicken Sie auf "Compare (Vergleichen)".

Anmerkung - Um Dateiversionen vergleichen zu können, müssen Sie das Paket developer/
meld installieren. Verwenden Sie für die Installation dieses Pakets die Package Manager-
Anwendung, oder geben Sie sudo pkg install developer/meld in ein Terminal ein.

So stellen Sie eine vorherige Version einer Datei wieder her

Wenn Sie eine vorherige Version einer Datei bearbeiten möchten, müssen Sie sie zunächst in
Ihrer Arbeitsumgebung wiederherstellen. Führen Sie die folgenden Schritte durch, um eine
vorherige Version einer Datei wiederherzustellen.

1. Öffnen Sie das Dateimanagerfenster, und navigieren Sie zum Ordner, der die
Datei enthält.

2. Öffnen Sie die Zeitschiebereglerleiste mithilfe einer der folgenden Methoden:
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■ Wählen Sie im Dateimanagerfenster "View->Restore" (Ansicht-
>Wiederherstellen), und klicken Sie in der Werkzeugleiste auf die
Schaltfläche "Time Slider" (Zeitschieberegler).

■ Drücken Sie Strg+E, um die Zeitschiebereglerleiste zu öffnen.

3. Klicken Sie in der Zeitschiebereglerleiste auf den Balken, der dem
Schnappschuss entspricht, den Sie anzeigen möchten.
Der Inhalt des Dateimanagerfensters wird aktualisiert, sodass die Dateien angezeigt werden, die
zum Zeitpunkt der Erstellung des Schnappschusses im Ordner vorhanden waren.

4. Führen Sie zum Kopieren der Dateiversion, die Sie wiederherstellen möchten,
folgende Schritte durch:

■ Klicken Sie mit der rechten Maustaste auf die Datei, die Sie wiederherstellen
möchten, und wählen Sie zum Erstellen einer Kopie dieser Dateiversion
auf Ihrem Desktop die Option "Restore to Desktop (Auf Desktop
wiederherstellen)".

■ Um eine Kopie der Datei an einem anderen Ort zu erstellen, ziehen Sie die
Datei in ein anderes Dateimanagerfenster.

So erstellen Sie einen manuellen Schnappschuss

In manchen Fällen ist es ratsam, einen Schnappschuss manuell zu erstellen und nicht auf den
Schnappschuss des Zeitschiebereglers zu warten.

1. Öffnen Sie das Dateimanagerfenster, und navigieren Sie zum Ordner, der die
Datei enthält.

2. Öffnen Sie die Zeitschiebereglerleiste mithilfe einer der folgenden Methoden:

■ Wählen Sie im Dateimanagerfenster "View->Restore" (Ansicht-
>Wiederherstellen), und klicken Sie in der Werkzeugleiste auf die
Schaltfläche "Time Slider" (Zeitschieberegler).

■ Drücken Sie Strg+E, um die Zeitschiebereglerleiste zu öffnen.

3. (Optional) Wählen Sie den Schnappschuss mit der Bezeichnung "Jetzt", wenn
dieser nicht ausgewählt ist.

4. Klicken Sie in der Zeitschiebereglerleiste unten rechts auf den Knopf "Take
Snapshot (Schnappschuss erstellen)".
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5. Wenn Sie dazu aufgefordert werden, geben Sie einen Namen für den
Schnappschuss ein, und klicken Sie dann zur Bestätigung auf "OK".
Ein manueller Schnappschuss des Dateimanagers wird im Panel "Time Slider (Zeit-
Schieberegler)" angezeigt.

So löschen Sie einen Schnappschuss aus einem
Dateimanager

Wenn Sie sicher sind, dass Sie einen bestimmten manuell oder durch den Zeitschieberegler
erstellten Schnappschuss nicht mehr benötigen, können Sie ihn mithilfe der folgenden Schritte
löschen.

1. Öffnen Sie das Dateimanagerfenster, und navigieren Sie zum Ordner, der die
Datei enthält.

2. Öffnen Sie die Zeitschiebereglerleiste mithilfe einer der folgenden Methoden:

■ Wählen Sie im Dateimanagerfenster "View->Restore" (Ansicht-
>Wiederherstellen), und klicken Sie in der Werkzeugleiste auf die
Schaltfläche "Time Slider" (Zeitschieberegler).

■ Drücken Sie Strg+E, um die Zeitschiebereglerleiste zu öffnen.

3. Wählen Sie den Schnappschuss aus, den Sie löschen möchten.

4. Klicken Sie in der Zeitschiebereglerleiste unten rechts auf den Knopf "Delete
Snapshot (Schnappschuss löschen)".
Da dieser Schritt nicht rückgängig gemacht werden kann, müssen Sie als Root angemeldet sein
und das Root-Passwort angeben, um diesen Schritt durchführen zu können.
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Dateimanager verwenden

In diesem Kapitel wird die Verwendung des Dateimanagers beschrieben. In diesem Kapitel sind
die folgenden Informationen enthalten:

■ „Überblick über den Dateimanager“ [73]
■ „Räumlicher Modus“ [74]
■ „Browsermodus“ [78]
■ „Dateien öffnen“ [83]
■ „Suchen von Dateien“ [85]
■ „Dateien und Ordner verwalten“ [86]
■ „Verwenden von Objekteigenschaften“ [102]
■ „Darstellung von Dateien und Ordnern ändern“ [103]
■ „Verwenden von Wechseldatenträgern“ [107]
■ „Durch Remote-Server navigieren“ [109]
■ „Dateimanagereinstellungen festlegen“ [110]
■ „Dateimanager erweitern“ [117]

Überblick über den Dateimanager
Dateien und Anwendungen können innerhalb des Dateimanagers auf einfache Weise verwaltet
werden. Sie können mithilfe des Dateimanagers folgende Aktionen ausführen:

■ Ordner und Dokumente erstellen
■ Dateien und Ordner anzeigen
■ Dateien suchen und verwalten
■ Skripte ausführen und Anwendungen starten
■ Anzeige von Dateien und Ordnern anpassen
■ spezielle Orte auf dem Computer öffnen
■ Daten auf CD oder DVD schreiben
■ Schriftarten installieren und entfernen

Der Desktop wird über den Dateimanager verwaltet. Der Desktop liegt allen anderen auf dem
Bildschirm sichtbaren Objekten zugrunde.
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Jeder Benutzer verfügt über einen persönlichen Ordner, der sämtliche für den Benutzer
relevanten Dateien enthält. Sie können über spezielle Symbole auf dem Desktop auf den
persönlichen Ordner des Benutzers, den Müll und Wechseldatenträger wie Disketten, CDs oder
USB-Speicher zugreifen.

Im Dateimanager gibt es zwei Modi zur Interaktion mit dem Dateisystem. Sie können sich
für den von Ihnen bevorzugten Modus entscheiden, indem Sie im Einstellungsdialog des
Dateimanagers auf der Registerkarte "Behavior (Verhalten)" die Option "Always Open In
Browser Windows (Immer in Browser-Fenstern öffnen)" aktivieren bzw. deaktivieren. Im
Folgenden wird näher auf die beiden Modi eingegangen.

■ Browsermodus – In diesem Modus können Sie Dateien und Ordner durchsuchen. Das
Dateimanagerfenster stellt einen Browser dar, in dem jeder Ort angezeigt werden kann.
Wenn Sie einen Ordner öffnen, wird das aktuelle Dateimanagerfenster aktualisiert,
sodass der Inhalt des neuen Ordners angezeigt wird. Im Browserfenster wird außer dem
Ordnerinhalt eine Werkzeugleiste mit häufig verwendeten Aktionen und Orten angezeigt,
eine Adressleiste, in der der aktuell geöffnete Orte innerhalb der Ordnerhierarchie
angezeigt wird, sowie eine Seitenleiste, die unterschiedliche Informationen beinhalten
kann. Weitere Informationen zur Verwendung des Browsermodus finden Sie unter
„Browsermodus“ [78].

■ Räumlicher Modus – In diesem Modus können Sie zu Dateien und Ordnern navigieren,
als wären es Objekte. Das Dateimanagerfenster entspricht einem bestimmten Ordner. Wenn
Sie einen Ordner öffnen, wird ein neues Fenster für diesen Ordner geöffnet. Jedes Mal,
wenn Sie einen bestimmten Ordner öffnen, wird er an derselben Stelle auf dem Bildschirm
und in der zuletzt gewählten Größe angezeigt. Im räumlichen Modus werden geöffnete
Ordner im Dateimanager mit einem anderen Symbol angezeigt. Im räumlichen Modus
werden möglicherweise weitere Dateimanagerfenster auf dem Bildschirm geöffnet. Weitere
Informationen zum räumlichen Modus finden Sie unter „Räumlicher Modus“ [74].

Räumlicher Modus

In diesem Abschnitt wird beschrieben, wie das Dateisystem mithilfe des Dateimanagers
im räumlichen Modus durchsucht wird. Im standardmäßig eingestellten räumlichen Modus
entspricht jedes Fenster einem einzelnen Ordner.

Räumliche Fenster

Ein neues räumliches Fenster wird immer dann geöffnet, wenn Sie einen Ordner öffnen. Führen
Sie eine der folgenden Aktionen aus, um einen Ordner zu öffnen:

■ Doppelklicken Sie auf dem Desktop oder in einem vorhandenen Fenster auf das
Ordnersymbol.

■ Wählen Sie den Ordner aus, und drücken Sie Strg+O.
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■ Wählen Sie den Ordner aus, und drücken Sie Alt+Pfeil nach unten.
■ Wählen Sie im oberen Panel aus dem Menü "Places (Orte)" ein Element aus. Der

persönliche Ordner und die als Lesezeichen gespeicherten Ordner werden hier
aufgeführt. Weitere Informationen zu Lesezeichen erhalten Sie unter „Lesezeichen
verwenden“ [99].

Um den aktuellen Ordner beim Öffnen eines neuen Ordners zu schließen, halten Sie
beim Doppelklicken die UMSCHALTTASTE gedrückt, oder drücken Sie UMSCHALT
+ALT+NACH-UNTEN-TASTE.

Der Inhalt des wichtigsten Rechnerordners wird in einem räumlichen Fenster angezeigt, wie die
folgende Abbildung verdeutlicht.

ABBILDUNG 
  8-1

Räumliches Fenster

Im räumlichen Modus wird in jedem geöffneten Fenster nur ein Ort angezeigt. Wenn Sie einen
zweiten Ort auswählen, wird ein zweites Fenster geöffnet. Auch wenn zahlreiche Ordner
gleichzeitig geöffnet sind, können Sie einen Ordner leicht erkennen, da ein Ort an der Stelle
geöffnet wird, an der er zuletzt geschlossen wurde.

Die folgende Abbildung stellt ein Beispiel für die Suche im räumlichen Modus bei zahlreichen
geöffneten Orten dar.

ABBILDUNG 
  8-2

Durchsuchen räumlicher Fenster
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Anmerkung - Da der Bildschirm im räumlichen Modus mit Dateimanagerfenstern belegt ist, ist
es wichtig, sie auf einfache Weise anordnen zu können. Um ein Fenster zu verschieben, müssen
Sie es nicht auswählen und an der zugehörigen Titelleiste ziehen, sondern können stattdessen
bei gedrückter Alt-Taste auf eine beliebige Stelle innerhalb eines Fensters klicken.

In der folgenden Tabelle sind die Komponenten eines räumlichen Fensters aufgeführt.

TABELLE 8-1 Komponenten eines räumlichen Fensters

Komponente Beschreibung

Menüleiste Menüs, mit denen Sie Aufgaben im Dateimanager durchführen, werden hier angezeigt.

Sie können von einem Dateimanagerfenster aus auch ein Kontextmenü aufrufen, indem Sie
mit der rechten Maustaste auf das Fenster klicken. Die angezeigten Menüeinträge variieren
in Abhängigkeit von der Stelle, auf die Sie mit der rechten Maustaste klicken. Beispiel:
Wenn Sie mit der rechten Maustaste auf eine Datei oder einen Ordner klicken, können Sie
entsprechende Datei- oder Ordnerobjekte auswählen. Wenn Sie mit der rechten Maustaste auf
den Hintergrund einer Ansichtsleiste klicken, können Sie die Objekte auswählen, die mit den
in der Ansichtsleiste angezeigten Objekten verknüpft sind.

Ansichtsleiste Folgendes wird hier angezeigt:

■ Ordner
■ FTP-Sites
■ Windows-Freigaben
■ WebDAV-Server
■ Orte, die bestimmten URIs entsprechen

Statusleiste Hier werden Statusinformationen wie die Anzahl der Objekte in einem Ordner und der
verfügbare Festplattenspeicher angezeigt.

Elternordnerauswahl Befindet sich in der Statusleiste. Die Ordnerhierarchie wird hier angezeigt. Wählen Sie einen
Ordner aus der Liste, um ihn zu öffnen.
Anmerkung - Halten Sie dabei die Umschalttaste gedrückt, um beim Öffnen eines neuen
Ordners den aktuellen Ordner zu schließen.

Persönlichen Ordner in räumlichem Fenster
anzeigen

Führen Sie eine der folgenden Aktionen aus, um den persönlichen Ordner anzuzeigen:

■ Klicken Sie im oberen Panel auf das Symbol "Home (Persönlicher Ordner)".
■ Wählen Sie in der Menüleiste eines Ordnerfensters "Places -> Home Folder" (Orte ->

Standardverzeichnis).
■ Wählen Sie in der Menüleiste im oberen Panel "Places -> Home Folder" (Orte ->

Standardverzeichnis).

Im räumlichen Fenster wird der Inhalt des persönlichen Ordners angezeigt.
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Elternordner anzeigen

Bei einem Elternordner handelt es sich um einen Ordner, der den aktuellen Ordner enthält.
Führen Sie eine der folgenden Aktionen aus, um den Inhalt des Elternordners des aktuellen
Ordners anzuzeigen:

■ Wählen Sie "File -> Open Parent" (Datei -> Übergeordneten Ordner öffnen).
■ Drücken Sie Alt+Pfeil nach oben.
■ Wählen Sie im Fenster links unten aus der Elternordnerauswahl einen Ordner aus.

Ordner im Browserfenster anzeigen

Sie können einen einzelnen Ordner im Browsermodus anzeigen und gleichzeitig im räumlichen
Modus weiterarbeiten.

So zeigen Sie einen Ordner in einem Browserfenster an

1. Wählen Sie im räumlichen Modus einen Ordner aus.

2. Wählen Sie "File -> Browse Folder" (Datei -> Ordner durchsuchen).

Schließen von Ordnern

Zahlreiche Fenster können über den Knopf "Close (Schließen)" möglicherweise nicht so
effizient wie Ordner geschlossen werden. Wählen Sie "File -> Close Parent Folders" (Datei -
> Übergeordnete Ordner schließen), wenn Sie nur den aktuellen Ordner anzeigen möchten und
nicht die Ordner, die sich in der Hierarchie über diesem Ordner befinden. Wenn Sie alle Ordner
auf dem Bildschirm schließen möchten, wählen Sie "File -> Close All Folders" (Datei -> Alle
Ordner schließen).

Speicherorte öffnen

Sie können einen Ordner oder einen anderen Ort im räumlichen Modus öffnen, indem Sie
dessen Namen eingeben.

Wählen Sie "File -> Open Location" (Datei -> Speicherort öffnen), und geben Sie den Pfad oder
den URI des Ortes ein, den Sie öffnen möchten.



Browsermodus

78 Desktopbenutzerhandbuch zu Oracle Solaris 11.2 • Juli 2014

Browsermodus

In diesem Abschnitt wird die Suche im System mithilfe des Dateimanagers im Browsermodus
beschrieben. Wenn Sie einen Ordner im Browsermodus öffnen, wird das aktuelle
Dateimanagerfenster aktualisiert, sodass der Inhalt des neuen Ordners angezeigt wird.

Browserfenster

Zum Aufrufen des Dateibrowsers haben Sie folgende Möglichkeiten:

■ Wählen Sie "Applications -> System Tools -> File Browser" (Anwendungen ->
Systemwerkzeuge -> Dateiverwaltung).

■ Im räumlichen Modus können Sie einen Ordner im Browsermodus öffnen, indem Sie mit
der rechten Maustaste auf diesen Ordner klicken und "Browse Folder (Mit Datei-Browser
öffnen)" wählen. Ein neues Dateibrowserfenster wird geöffnet, in dem der Inhalt des
ausgewählten Ordners angezeigt wird.

■ Wenn der Dateimanager so eingestellt ist, dass Browserfenster immer geöffnet werden
sollen, wird durch einen Doppelklick auf einen beliebigen Ordner ein Browserfenster
geöffnet. Siehe „Verhalten“ [112].

ABBILDUNG 
  8-3

Dateibrowserfenster

In der folgenden Tabelle sind die Komponenten eines Dateibrowserfensters aufgeführt.

TABELLE 8-2 Komponenten des Dateibrowserfensters

Komponente Beschreibung

Menüleiste Menüs, mit denen Sie Aufgaben im Dateimanager durchführen, werden hier angezeigt.

Sie können von einem Dateimanagerfenster aus auch ein Kontextmenü aufrufen, indem Sie
mit der rechten Maustaste auf das Fenster klicken. Die angezeigten Menüeinträge variieren
in Abhängigkeit von der Stelle, auf die Sie mit der rechten Maustaste klicken. Beispiel:
Wenn Sie mit der rechten Maustaste auf eine Datei oder einen Ordner klicken, können Sie
entsprechende Datei- oder Ordnerobjekte auswählen. Wenn Sie mit der rechten Maustaste
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Komponente Beschreibung
auf den Hintergrund einer Ansichtsleiste klicken, können Sie die Objekte auswählen, die mit
den in der Ansichtsleiste angezeigten Objekten verknüpft sind.

Werkzeugleiste Knöpfe, mit denen Sie verschiedene Aufgaben im Dateimanager ausführen, sind hier
enthalten.

■ Back (Zurück) – Der zuvor besuchte Ort wird aufgerufen. Die angrenzende
Aufklappliste enthält auch eine Auflistung zuvor besuchter Orte, um diese Orte schneller
aufrufen zu können.

■ Forward (Vorwärts) – Die dem Werkzeugleistenknopf "Back (Zurück)" entgegengesetzte
Aktion wird ausgeführt. Falls Sie zuvor zurücknavigiert sind, gelangen Sie mithilfe
dieses Knopfs nach vorne.

■ Up (Aufwärts) – Die übergeordnete Ebene, auf der sich der Elternordner des aktuellen
Ordners befindet, wird aufgerufen.

■ Reload (Aktualisieren) – Der Inhalt des aktuellen Ordners wird aktualisiert.
■ Browse Snapshots (Schnappschüsse durchsuchen) – Sie können den Inhalt vorhandener

ZFS-Schnappschüsse eines Ordners mithilfe des Zeitschiebereglers durchsuchen.
Weitere Informationen zum Zeitschieberegler finden Sie in Kapitel 7, Verwenden des
Zeitschiebereglers.

■ Home (Persönlicher Ordner) – Ihr persönlicher Ordner wird geöffnet.
■ Computer (Rechner) – Der Rechner-Ordner wird geöffnet.
■ Search (Suchen) – Die Suchleiste wird geöffnet.

Adressleiste Mithilfe der Adressleiste können Sie auf dem Rechner navigieren. Je nach Auswahl stehen
drei verschiedene Konfigurationen zur Verfügung. Weitere Informationen finden Sie unter
„Adressleiste verwenden“ [80]. Die Adressleiste enthält bei allen drei Konfigurationen
folgende Objekte:

■ Knöpfe zur Größenänderung – Mit diesen Knöpfen können Sie die Größe von Objekten
in der Ansichtsleiste ändern.

■ View as drop-down list (Aufklappliste Anzeigen als) – Hiermit können Sie festlegen,
wie Objekte in Ihrer Ansichtsleiste angezeigt werden sollen.

Seitenleiste Über die Seitenleiste können die folgenden Aktionen ausgeführt werden:

■ Informationen zur aktuellen Datei oder zum aktuellen Ordner anzeigen,
■ durch Dateien navigieren.

Wählen Sie zum Anzeigen der Seitenleiste "View -> Side Pane" (Ansicht -> Seitenleiste).
Die Seitenleiste enthält eine Aufklappliste, aus der Sie die Objekte wählen können, die in
der Seitenleiste angezeigt werden sollen:

■ Places (Orte) – Besonders relevante Orte werden angezeigt.
■ Information (Informationen) – Symbol für und Informationen zum aktuellen Ordner

werden angezeigt. In der Seitenleiste werden möglicherweise Knöpfe angezeigt.
Mithilfe dieser Knöpfe können Sie im aktuellen Ordner von Standardaktionen
abweichende Aktionen ausführen.

■ Tree (Baum) – Das Dateisystem wird in hierarchischer Form angezeigt. Sie können
mithilfe der Baumansicht durch Dateien navigieren.

■ History (Chronik) – Eine Chronikliste Ihrer Dateien, Ordner, FTP-Sites und URIs, die
Sie kürzlich besucht haben, wird angezeigt.

■ Notes (Notizen) – Notizen können zu Dateien oder Ordnern hinzugefügt werden.
■ Emblems (Embleme) – Hier sind Embleme, die Sie Dateien oder Ordnern hinzufügen

können, enthalten.
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Komponente Beschreibung
Klicken Sie zum Schließen der Seitenleiste auf den Knopf "X" rechts oben in der
Seitenleiste.

Ansichtsleiste Folgendes wird in der Ansichtsleiste angezeigt:

■ Ordner
■ FTP-Sites
■ Windows-Freigaben
■ WebDAV-Server
■ Orte, die bestimmten URIs entsprechen

Statusleiste Statusinformationen werden angezeigt.

Komponenten des Dateibrowserfensters ein- und
ausblenden

Um eine Komponente des Dateibrowsers ein- oder auszublenden, wählen Sie im
Menü "Ansicht" die entsprechende Komponente aus. Die Menüoptionen haben eine
Umschaltfunktion, mit der die Komponente entweder ein- oder ausgeblendet wird.

Tipp - Drücken Sie F9, um die Seitenleiste entweder ein- oder auszublenden.

Adressleiste verwenden

In der Adressleiste des Dateibrowsers kann entweder ein Eingabefeld, eine Knopfleiste oder ein
Suchfeld angezeigt werden. In der folgenden Tabelle sind die Adressleistenfelder aufgeführt.

TABELLE 8-3 Adressleistenfelder

Feld Beschreibung

Knopfleiste Die Knopfleiste wird standardmäßig angezeigt. Sie besteht aus einer Zeile von Knöpfen,
die die Hierarchie des aktuellen Ortes darstellt, wobei jedem Ordner ein Knopf zugeordnet
ist. Klicken Sie auf den Knopf, um in der Hierarchie zwischen den Ordnern zu wechseln.
Sie können zum ursprünglichen Ordner zurückkehren, der als letzter Knopf in der Zeile
angezeigt wird.

Um einen Ordner zu kopieren, können Sie die Knöpfe z.B. auch an einen anderen Ort
ziehen.

Eingabefeld Im Eingabefeld wird der aktuelle Ort als Textpfad angezeigt. Beispiel: /home/user/
Documents. Mithilfe des Eingabefelds können Sie zu einem bekannten Ordner navigieren.

Um zu einem neuen Ort zu gelangen, geben Sie einen neuen Pfad ein, oder bearbeiten
Sie den aktuellen Pfad, und drücken Sie dann die Eingabetaste. Das Eingabefeld wird
automatisch vervollständigt, wenn es nur eine zu einem vorhandenen Dateipfad passende
Möglichkeit gibt. Drücken Sie die Tabulatortaste, um den Vorschlag zu übernehmen.
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Feld Beschreibung
Klicken Sie links neben der Adressleiste auf den Umschaltknopf, wenn Sie das
Eingabefeld immer verwenden möchten.

Drücken Sie STRG+L, wählen Sie "Go -> Location" (Gehe zu -> Speicherort), um zum
Eingabefeld zu wechseln, während Sie die Schaltflächenleiste verwenden. Sie können auch
/ (Schrägstrich) drücken, um vom Root-Verzeichnis ausgehend einen Pfad anzugeben.
Wenn Sie die EINGABETASTE oder zum Abbrechen ESC drücken, werden in der
Adressleiste wieder die Adressschaltflächen angezeigt.

Suchleiste Drücken Sie zum Anzeigen der Suchleiste Strg+F, oder wählen Sie in der Werkzeugleiste
den Knopf "Search (Suchen)". Weitere Informationen zur Suchleiste finden Sie unter
„Suchen von Dateien“ [85].

Anzeigen des Standardverzeichnisses

Führen Sie eine der folgenden Aktionen in einem Dateibrowserfenster aus, um den persönlichen
Ordner anzuzeigen:

■ Wählen Sie "Go -> Home" (Gehe zu -> Standardverzeichnis).
■ Klicken Sie in der Werkzeugleiste auf den Knopf "Home (Persönlicher Ordner)".
■ Klicken Sie in der Seitenleiste "Places (Orte)" auf den Knopf "Home (Persönlicher

Ordner)".

Im Dateibrowserfenster wird der Inhalt Ihres persönlichen Ordners angezeigt.

Anzeigen von Ordnern

Der Inhalt eines Ordners kann entweder als Liste oder Symbol wie folgt angezeigt werden.
Weitere Informationen zur Listen- und Symbolansicht finden Sie unter „Dateien und Ordner
mithilfe von Ansichten anzeigen“ [87].

■ Doppelklicken Sie in der Ansichtsleiste auf den Ordner.
■ Verwenden Sie die Baumansicht in der Seitenleiste. Weitere Informationen finden Sie unter

„Baumansicht in der Seitenleiste verwenden“ [82].
■ Klicken Sie in der Adressleiste auf die Adressknöpfe.
■ Drücken Sie Strg+L, um das Eingabefeld anzuzeigen. Geben Sie den Pfad zu dem Ordner

ein, den Sie anzeigen möchten, und drücken Sie die Eingabetaste. Das Eingabefeld verfügt
über eine Funktion zur automatischen Vervollständigung. Wenn Sie einen Pfad eingeben,
wird das Dateisystem vom Dateimanager gelesen. Wenn genug Zeichen eingegeben wurden,
um ein Verzeichnis zu identifizieren, wird der Name des Ordners im Adressfeld vom
Dateimanager vervollständigt.

■ Verwenden Sie in der Werkzeugleiste die Knöpfe "Back (Zurück)" und "Forward
(Vorwärts)", um die Navigationschronik zu durchsuchen.
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Wählen Sie "Go -> Up" (Gehe zu -> Nach oben), um zur Ordnerebene über dem aktuellen
Ordner zu gelangen. Sie können stattdessen auch in der Werkzeugleiste auf den Knopf "Up
(Aufwärts)" klicken.

Elternordner anzeigen

Hierarchisch betrachtet ist der Elternordner derjenige Ordner, der sich oberhalb des aktuellen
Ordners befindet, den Sie gerade durchsuchen. Führen Sie einen der folgenden Schritte durch,
um den Inhalt des Elternordners anzuzeigen:

■ Klicken Sie in der Werkzeugleiste auf den Knopf "Up (Aufwärts)".
■ Wählen Sie "Go -> Open Parent" (Gehe zu -> Übergeordneten Ordner öffnen).
■ Drücken Sie die Rücktaste.

Baumansicht in der Seitenleiste verwenden

Die Baumansicht bietet eine der hilfreichsten Funktionen der Seitenleiste. In dieser Ansicht
wird das Dateisystem in hierarchischer Form dargestellt, wodurch das Durchsuchen und
Navigieren im Dateisystem erleichtert wird. Um die Baumansicht in der Seitenleiste
anzuzeigen, wählen Sie oben in der Seitenleiste aus der Aufklappliste "Tree (Baum)".

Geöffnete Ordner werden in der Baumansicht als nach unten weisende Pfeile dargestellt. In der
folgenden Tabelle sind die Aufgaben aufgeführt, die Sie mithilfe der Baumansicht durchführen
können.

TABELLE 8-4 Aufgaben in der Baumansicht

Aufgabe Aktion

Baumansicht öffnen Wählen Sie oben in der Seitenleiste aus der Aufklappliste "Tree (Baum)".

Baumansicht schließen Wählen Sie oben in der Seitenleiste aus der Aufklappliste "Tree (Baum)" ein
anderes Objekt aus.

Ordner in der Baumansicht
ausklappen

Klicken Sie in der Baumansicht auf den Pfeil neben dem Ordner.

Ordner in der Baumansicht einklappen Klicken Sie in der Baumansicht auf den Pfeil neben dem Ordner.

Zeigen Sie den Inhalt eines Ordners in
der Ansichtsleiste an.

Wählen Sie in der Baumansicht den Ordner aus.

Datei öffnen Wählen Sie in der Baumansicht die Datei aus.

In den Einstellungen können Sie festlegen, dass in der Baumansicht keine Dateien angezeigt
werden sollen. Weitere Informationen finden Sie unter „Ansichten“ [111].
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Verwenden der Navigationschronik
Im Dateibrowser wird eine Chronikliste Ihrer Dateien, Ordner, FTP-Sites und URI-Orte, die
Sie kürzlich besucht haben, verwaltet. Über die Chronikliste können Sie zu diesen Orten
zurückkehren. Ihre Chronikliste enthält die zehn zuletzt angezeigten Objekte.

Wählen Sie "Go -> Clear History" (Gehe zu -> Chronik leeren), um Ihre Chronikliste zu
löschen.

Mithilfe des Menüs "Go (Gehe zu)" durch die Chronikliste
navigieren

Um eine Liste zuvor angezeigter Objekte aufzurufen, öffnen Sie das Menü "Go (Gehe zu)". Die
Chronikliste wird im unteren Teil des Menüs "Go (Gehe zu)" angezeigt. Klicken Sie auf ein
Objekt in der Chronikliste, um es zu öffnen.

Mithilfe der Werkzeugleiste durch die Chronikliste navigieren

Führen Sie eine der folgenden Aktionen aus, um mithilfe der Werkzeugleiste durch die
Chronikliste zu navigieren:

■ Klicken Sie in der Werkzeugleiste auf den Knopf "Back (Zurück)" oder "Forward
(Vorwärts)", um einen Ordner oder URI in der Chronikliste zu öffnen.

■ Um eine Liste zuvor angezeigter Objekte aufzurufen, klicken Sie in der Werkzeugleiste
neben dem Knopf "Back (Zurück)" auf den Pfeil nach unten.

■ Um eine Liste der Objekte aufzurufen, die Sie nach dem aktuellen Objekt angezeigt haben,
klicken Sie in der Werkzeugleiste neben dem Knopf "Forward (Vorwärts)" auf den Pfeil
nach unten.

Mithilfe von "History (Chronik)" durch die Chronikliste in der
Seitenleiste navigieren

Um die Chronikliste in der Seitenleiste anzuzeigen, wählen Sie oben in der Seitenleiste aus
der Aufklappliste "History (Chronik)". In der Chronikliste in der Seitenleiste wird eine Liste
zuvor angezeigter Objekte angezeigt. Um ein Objekt aus der Chronikliste in der Ansichtsleiste
anzuzeigen, doppelklicken Sie in der Chronikliste auf das Objekt.

Dateien öffnen
Wenn Sie eine Datei öffnen, führt der Dateimanager die Standardaktion für diesen Dateityp aus.



So fügen Sie mit einem Dateityp verknüpfte Aktionen hinzu

84 Desktopbenutzerhandbuch zu Oracle Solaris 11.2 • Juli 2014

Beispiel: Wenn Sie eine Musikdatei öffnen, dann wird sie mit der Standardanwendung zum
Abspielen von Musik wiedergegeben. Wenn Sie eine Textdatei öffnen, können Sie diese in
einem Texteditor lesen und bearbeiten. Beim Öffnen einer Bilddatei wird das Bild angezeigt.

Der Inhalt einer Datei wird vom Dateimanager geprüft, um den Dateityp zu bestimmen.
Wenn sich der Dateityp nicht anhand der ersten Zeilen bestimmen lässt, wird die
Dateinamenerweiterung vom Dateimanager geprüft.

Anmerkung - Beim Öffnen einer ausführbaren Textdatei, d.h. einer vom Dateimanager als
ausführbares Programm eingestuften Datei, werden Sie dazu aufgefordert anzugeben, ob Sie
sie ausführen oder in einem Texteditor anzeigen möchten. Dieses Verhalten können Sie in den
Einstellungen zur Verwaltung von Dateien ändern.

Standardaktion ausführen

Doppelklicken Sie auf eine Datei, um die Standardaktion für diese Datei auszuführen. Beispiel:
Die Standardaktion für einfache Textdokumente ist das Anzeigen der Datei in einem Text-
Viewer. Wenn Sie auf eine Textdatei doppelklicken, wird sie in einem Text-Viewer angezeigt.

In den Einstellungen für den Dateimanager können Sie festlegen, dass Sie nur einmal auf eine
Datei klicken müssen, um die Standardaktion auszuführen. Weitere Informationen finden Sie
unter „Verhalten“ [112].

Andere Aktionen als die Standardaktionen
ausführen

Um eine andere als die Standardaktion für eine Datei auszuführen, wählen Sie die
entsprechende Datei aus. Im Menü "File (Datei)" werden entweder Optionen zu "Open With
(Öffnen mit)" oder das Untermenü "Open With (Öffnen mit)" angezeigt. Wählen Sie die
gewünschte Option aus dieser Liste aus.

So fügen Sie mit einem Dateityp verknüpfte
Aktionen hinzu

1. Wählen Sie in der Ansichtsleiste eine Datei, für die Sie eine Aktion hinzufügen
möchten.

2. Wählen Sie "File -> Open with Other Application" (Datei -> Mit anderer
Anwendung öffnen).
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3. Entweder wählen Sie im Dialog "Open With (Öffnen mit)" eine Anwendung
aus oder Sie suchen nach dem Programm, mit dem Sie diesen Dateityp öffnen
möchten.
Die ausgewählte Aktion wird der Liste der Aktionen für diesen bestimmten Dateityp
hinzugefügt. Wenn noch keine Aktion mit dem Dateityp verknüpft wurde, ist die neu
hinzugefügte Aktion die Standardaktion.

Tipp - Sie können auch unter "File -> Properties" (Datei -> Eigenschaften) auf der Registerkarte
"Open With" (Öffnen mit) Aktionen hinzufügen.

So ändern Sie Aktionen
1. Wählen Sie in der Ansichtsleiste eine Datei, für die Sie die Aktion ändern

möchten.

2. Wählen Sie "File -> Properties" (Datei -> Eigenschaften).

3. Klicken Sie auf die Registerkarte "Open With (Öffnen mit)".

4. Verwenden Sie die Knöpfe "Add (Hinzufügen)" oder "Remove (Entfernen)", um
die Liste der Aktionen anzupassen. Wählen Sie die Standardaktion mithilfe der
Option links neben der Liste aus.

Suchen von Dateien
Um eine Suche im Dateimanager zu starten, drücken Sie STRG+F, oder wählen Sie in der
Werkzeugleiste die Schaltfläche "Search" (Suchen). Die Suchleiste wird wie nachfolgend
dargestellt angezeigt.

ABBILDUNG 
  8-4

Suchleiste

Geben Sie Zeichen ein, die im Namen oder im Inhalt der Datei oder des Ordners, nach der bzw.
dem Sie suchen möchten, vorhanden sind, und drücken Sie die Eingabetaste.

Sie können die Suchergebnisse durch Hinzufügen weiterer Bedingungen verfeinern, indem Sie
sie auf einen bestimmten Dateityp oder Ort begrenzen. Um Suchbedingungen hinzuzufügen,
klicken Sie auf das Symbol "+".
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Suchvorgänge speichern

Suchvorgänge können auch zur späteren Nutzung gespeichert werden. Einmal gespeicherte
Suchvorgänge können später wieder geöffnet werden. Gespeicherte Suchvorgänge verhalten
sich genauso wie reguläre Ordner. Beispiel: Sie können die Dateien in einer gespeicherten
Suche öffnen, verschieben oder löschen.

Dateien und Ordner verwalten

In diesem Abschnitt wird die Arbeit mit Dateien und Ordnern beschrieben.

Dateisysteme sind in einer baumartigen Struktur hierarchisch angeordnet. Die oberste Ebene
des Dateisystems ist "/" oder das Wurzelverzeichnis. In dieser Designphilosophie wird alles als
Datei betrachtet, auch Festplatten, deren Partitionen oder Wechseldatenträger. Alle Dateien und
Verzeichnisse (einschließlich andere Festplatten und Partitionen) sind im Wurzelverzeichnis
vorhanden.

Beispiel: In /home/jebediah/cheeses.odt wird der korrekte, vollständige Pfad zur Datei
cheeses.odt angezeigt, die im Ordner jebediah liegt, der im persönlichen Ordner zu finden
ist, und dieser wiederum im Wurzelverzeichnis ("/").

Unterhalb des Wurzelverzeichnisses ("/") befinden sich oft verwendete Systemordner. In der
folgenden Liste sind die direkt unterhalb des Wurzelverzeichnisses ("/") vorhandenen Ordner
aufgeführt:

■ /etc – Konfigurationsdateien, Startskripte usw.
■ /home – persönliche Ordner der lokalen Benutzer
■ /bin – wichtige Anwendungen im Binärformat
■ /boot – für den Boot-Vorgang erforderliche Dateien
■ /dev – die Gerätedateien
■ /lib – Systembibliotheken
■ /lost+found – Ablageort für wiederhergestellte Dateien, die sich sonst im

Wurzelverzeichnis ("/") befinden
■ /opt – Ort für zu installierende Zusatzanwendungen
■ /proc – spezieller dynamischer Ordner mit Informationen zum Systemstatus einschließlich

der laufenden Prozesse
■ /media – eingehängte Wechseldatenträger wie CDs, Digitalkameras usw.
■ /mnt – eingehängte Dateisysteme
■ /root – persönlicher Ordner des Root-Benutzers, ausgesprochen als “slash-root”
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■ /sbin – wichtige Systemanwendungen
■ /srv – Ort für Daten, die von Servern verwendet werden
■ /sys – Systeminformationen
■ /tmp – temporäre Dateien
■ /usr – Anwendungen und Dateien, von denen die meisten allen Benutzern zugänglich sind
■ /var – Dateien mit veränderlichem Inhalt, z.B. Protokolldateien und Datenbanken

Dateien und Ordner mithilfe von Ansichten
anzeigen

Mithilfe der im Dateimanager enthaltenen Ansichten können Sie den Inhalt Ihrer Ordner
unterschiedlich anzeigen, d.h. in einer Symbolansicht und einer Listenansicht.

■ Symbolansicht – Die Objekte im Ordner werden als Symbole wie nachfolgend dargestellt
angezeigt.

■ Listenansicht – Die Objekte im Ordner werden als Liste wie nachfolgend dargestellt
angezeigt.

Wählen Sie die Symbol- oder Listenansicht über das Menü "View (Ansicht)" oder die
Aufklappliste "View As (Anzeigen als)" aus. In der Ansichtsleiste können Sie die Anordnung
oder die Sortierreihenfolge sowie die Größe von Objekten im Ordner festlegen. In den
folgenden Abschnitten wird die Arbeit mit der Symbolansicht und der Listenansicht
beschrieben.
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Dateien in der Symbolansicht anordnen

Wenn Sie den Inhalt eines Ordners in der Symbolansicht anzeigen, können Sie festlegen,
wie die Objekte im Ordner angeordnet werden sollen. Wählen Sie dazu "View -> Arrange
Items" (Ansicht -> Objekte anordnen). Das Untermenü "Arrange Items (Objekte anordnen)" ist
wie folgt aufgebaut:

■ Der obere Abschnitt enthält Optionen, mit denen Sie die Dateien manuell anordnen können.
■ Der mittlere Abschnitt enthält Optionen, mit denen Sie die Dateien automatisch sortieren

können.
■ Der untere Abschnitt enthält Optionen, mit denen Sie die Anordnung Ihrer Dateien ändern

können.

In der folgenden Tabelle sind die entsprechenden Optionen aufgeführt, die Sie im Untermenü
auswählen können.

Option Beschreibung

Manually (Manuell) Objekte werden manuell angeordnet. Ziehen Sie die Objekte an den gewünschten Ort in
der Ansichtsleiste.

By Name (Nach Name) Die Objekte werden alphabetisch nach dem Namen sortiert. Die Groß- und
Kleinschreibung spielt bei der Objektreihenfolge keine Rolle. Wenn im Dateimanager
festgelegt wurde, dass verborgene Dateien angezeigt werden sollen, dann werden diese
Dateien am Listenende angezeigt.

By Size (Nach Größe) Die Objekte werden nach Größe in aufsteigender Reihenfolge sortiert. Wenn Sie Objekte
nach Größe sortieren, werden die Ordner nach der Anzahl der darin enthaltenen Objekte
sortiert. Die Ordner werden nicht nach der Gesamtgröße aller darin enthaltenen Objekte
sortiert.

By Type (Nach Typ) Die Objekte werden alphabetisch nach Objekttyp sortiert. Die Objekte werden
alphabetisch nach der Beschreibung Ihres MIME-Typs sortiert. Durch den MIME-
Typ wird das Format einer Datei gekennzeichnet und das Lesen der Datei durch
Anwendungen ermöglicht. Beispiel: In einer E-Mail-Anwendung kann der MIME-Typ
image/png zur Erkennung einer PNG-Datei im Anhang einer E-Mail verwendet werden.

By Modification Date
(Nach Änderungsdatum)

Die Objekte werden nach dem Datum der letzten Änderung sortiert. Das zuletzt geänderte
Objekt steht an erster Stelle.

By Emblems (Nach
Emblemen)

Die Objekte werden nach Emblemen sortiert, die den Objekten hinzugefügt wurden. Die
Objekte werden alphabetisch nach Emblemnamen geordnet. Objekte ohne Embleme
stehen am Listenende.

Compact Layout
(Kompakte Anordnung)

Die Objekte werden so sortiert, dass sie dichter nebeneinander stehen.

Reversed Order
(Reihenfolge umkehren)

Die von Ihnen gewählte Objektsortierreihenfolge wird umgekehrt. Beispiel: Wenn Sie
die Objekte nach Namen sortieren, wählen Sie die Option "Reversed Order (Reihenfolge
umkehren)", um die Objekte in umgekehrter alphabetischer Reihenfolge zu sortieren.

Dateien in der Listenansicht anordnen

Wenn Sie den Inhalt eines Ordners in der Listenansicht anzeigen, können Sie festlegen, wie
die Objekte im Ordner angeordnet werden sollen. Um die Anordnung in der Listenansicht
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festzulegen, klicken Sie auf die Spaltenüberschrift, die die Eigenschaft bezeichnet, nach der die
Objekte angeordnet werden sollen. Um die Sortierreihenfolge umzukehren, klicken Sie erneut
auf dieselbe Spaltenüberschrift.

Um Spalten der Listenansicht hinzuzufügen oder daraus zu entfernen, wählen Sie "View ->
Visible Column" (Ansicht -> Anzuzeigende Spalten).

Der Dateimanager speichert Ihre Art der Anordnung der Objekte in einem bestimmten
Ordner. Wenn Sie den Ordner erneut anzeigen, werden die Objekte wie von Ihnen festgelegt
angeordnet. Sie können den Ordner so anpassen, dass die Objekte in der von Ihnen festgelegten
Anordnung angezeigt werden. Um die Anordnung des Ordners auf die Standardeinstellungen
zurückzusetzen, wählen Sie "View -> Reset View to Defaults" (Ansicht -> Ansicht auf
Vorgaben zurücksetzen).

Objektgröße in einer Ansicht ändern

Sie haben zum Ändern der Größe von Objekten in einer Ansicht, in der eine Datei oder ein
Ordner angezeigt wird, folgende Möglichkeiten:

■ Um Objekte in einer Ansicht zu vergrößern, wählen Sie "View -> Zoom In" (Ansicht ->
Ansicht vergrößern).

■ Um Objekte in einer Ansicht zu verkleinern, wählen Sie "View -> Zoom Out" (Ansicht ->
Ansicht verkleinern).

■ Um Objekte in einer Ansicht auf ihre normale Größe zurückzusetzen, wählen Sie "View ->
Normal Size" (Ansicht -> Normale Ansichtsgröße).

Sie können die Größe von Objekten in einer Ansicht auch ändern, indem Sie in einem
Browserfenster in der Adressleiste die Knöpfe zur Größenänderung verwenden.

In der folgenden Tabelle sind die Knöpfe zur Größenänderung aufgeführt.

TABELLE 8-5 Schaltflächen zur Größenänderung

Schaltfläche Name der Schaltfläche Beschreibung

Verkleinern Klicken Sie auf diesen Knopf, um Objekte in einer
Ansicht zu verkleinern.

Normalgröße Klicken Sie auf diesen Knopf, um ein Objekt
in einer Ansicht auf die normale Größe
zurückzusetzen.

Vergrößern Klicken Sie auf diesen Knopf, um die Größe von
Objekten in einer Ansicht zu vergrößern.

Der Dateimanager speichert die Größe von Objekten in einem bestimmten Ordner. Wenn
Sie den Ordner erneut anzeigen, werden die Objekte in der von Ihnen festgelegten Größe
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angezeigt. Wenn Sie die Größe der Objekte in einem Ordner ändern, können Sie diesen Ordner
so anpassen, dass die Objekte in dieser Größe angezeigt werden. Um die Objekte auf die in den
Einstellungen festgelegte Standardgröße zurückzusetzen, wählen Sie "View -> Reset View to
Defaults" (Ansicht -> Ansicht auf Vorgaben zurücksetzen).

Mit Dateien und Ordnern arbeiten

Sie haben zum Auswählen von Dateien und Ordnern im Dateimanager mehrere Möglichkeiten.
Außerdem können Sie eine Gruppe von Dateien auswählen, die einem bestimmten Muster
entspricht.

Dateien und Ordner auswählen

In der folgenden Tabelle sind die Aufgaben aufgeführt, die Sie im Dateimanager durchführen
können.

TABELLE 8-6 Objekte im Dateimanager auswählen

Aufgabe Aktion

Objekt auswählen Klicken Sie auf das Objekt.

Select a group of contiguous items (Gruppe
aufeinander folgender Objekte auswählen)

Verschieben Sie in der Symbolansicht durch Ziehen und Ablegen
die Dateien, die Sie auswählen möchten.

Klicken Sie in der Listenansicht auf das erste Objekt in der
Gruppe. Halten Sie die UMSCHALTTASTE gedrückt, und
klicken Sie dann auf das in der Gruppe zuletzt aufgeführte
Objekt.

Mehrere Objekte auswählen Halten Sie Strg gedrückt. Klicken Sie auf die Objekte, die Sie
auswählen möchten.

Select all items in a folder (Alle Objekte in einem
Ordner auswählen)

Wählen Sie "Edit -> Select All Files" (Bearbeiten -> Alle
Dateien auswählen).

Doppelklicken Sie auf ein Objekt, damit die Standardaktion für das Objekt ausgeführt wird.
In den Einstellungen für den Dateimanager können Sie festlegen, dass Sie nur einmal auf eine
Datei klicken müssen, um die Standardaktion auszuführen. Weitere Informationen finden Sie
unter „Verhalten“ [112].

Dateien nach einem bestimmten Muster auswählen

Sie können alle Dateien, die einem Muster entsprechen, anhand des Dateinamens und einer
frei wählbaren Anzahl von Platzhaltern auswählen. Die folgende Tabelle enthält Beispiele für
mögliche Muster und Dateien, die diesen Mustern entsprechen.
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TABELLE 8-7 Objekte im Dateimanager anhand eines Musters auswählen

Muster Passende Dateien

note.* Diesem Muster entsprechen alle Dateien mit dem Namen "note" und allen
Dateierweiterungen.

*.ogg Diesem Muster entsprechen alle Dateien mit der Erweiterung .ogg.

*memo* Diesem Muster entsprechen alle Dateien oder Ordner, deren Namen das Wort "memo"
enthalten.

Um den Befehl zur Auswahl eines Musters auszuführen, wählen Sie im Menü "Edit -> Select
Patterns" (Bearbeiten -> Muster auswählen). Nach der Eingabe des gewünschten Musters
werden alle Dateien oder Ordner angezeigt, die zum gewünschten Muster passen.

Dateien oder Ordner verschieben oder kopieren

Sie können eine Datei oder einen Ordner verschieben oder kopieren, indem Sie sie mit
gedrückter Maustaste ziehen oder die Befehle zum Kopieren und Einfügen verwenden.
Im Folgenden werden die zum Verschieben oder Kopieren einer Datei oder eines Ordners
erforderlichen Schritte beschrieben.

So kopieren oder verschieben Sie Dateien durch Ziehen und Ablegen

Tipp - Um eine Datei oder einen Ordner in einen Ordner unterhalb der aktuellen Ebene zu
verschieben, ziehen Sie die Datei oder den Ordner an den neuen Ort im selben Fenster. Wenn
Sie die Datei oder den Ordner kopieren, halten Sie beim Ziehen die Strg-Taste gedrückt.

1. Öffnen Sie zwei Dateimanagerfenster:

■ Fenster mit dem Objekt, das Sie verschieben oder kopieren möchten

■ Das Fenster, in das Sie die Datei oder den Ordner hineinkopieren
oder verschieben möchten, oder das Fenster mit dem Ordner, den Sie
verschieben oder kopieren möchten.

2. Ziehen Sie die Datei oder den Ordner, den Sie verschieben möchten, an den
neuen Ort. Wenn Sie die Datei oder den Ordner kopieren, halten Sie beim Ziehen
die Strg-Taste gedrückt.

■ Wenn der neue Ort ein Fenster ist, legen Sie die Datei oder den Ordner an
einer beliebigen Stelle im Fenster ab.

■ Wenn der neue Ort ein Ordner ist, ziehen Sie das Objekt auf das
Ordnersymbol.
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So verwenden Sie die Befehle zum Ausschneiden bzw. Kopieren und
Einfügen an einem neuen Ort

1. Wählen Sie die Datei oder den Ordner, den bzw. die Sie verschieben oder
kopieren möchten, und wählen Sie dann "Edit -> Cut" (Bearbeiten ->
Ausschneiden) bzw. "Edit -> Copy" (Bearbeiten -> Kopieren).

2. Öffnen Sie den Ordner, in den Sie die Datei oder den Ordner verschieben
möchten.

3. Wählen Sie "Edit -> Paste" (Bearbeiten -> Einfügen).

So duplizieren Sie eine Datei oder einen Ordner

1. Wählen Sie die Datei oder den Ordner, den Sie duplizieren möchten.

2. Wählen Sie "Edit -> Duplicate" (Bearbeiten -> Duplizieren).
Eine Kopie der Datei oder des Ordners wird im aktuellen Ordner angezeigt.

So legen Sie einen Ordner an

1. Öffnen Sie den Ordner, in dem Sie den neuen Ordner erstellen möchten.

2. Wählen Sie "File -> Create Folder" (Datei -> Ordner erstellen), oder klicken Sie
mit der rechten Maustaste auf den Hintergrund des Fensters, und wählen Sie
dann "Create Folder" (Ordner erstellen)".
Ein unbenannter Ordner wird dem Ort hinzugefügt. Der Name des Ordners wird ausgewählt.

3. Geben Sie einen Namen für den Ordner ein, und drücken Sie dann die
Eingabetaste.

So benennen Sie eine Datei oder einen Ordner um

1. Wählen Sie die Datei oder den Ordner, den Sie umbenennen möchten.

2. Wählen Sie "Edit -> Rename" (Bearbeiten -> Umbenennen), oder klicken Sie
mit der rechten Maustaste auf die Datei oder den Ordner, und wählen Sie
"Rename" (Umbenennen).
Der Name der Datei oder des Ordners wird ausgewählt.

3. Geben Sie einen neuen Namen für die Datei oder den Ordner ein, und drücken
Sie dann die Eingabetaste.
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So verschieben Sie eine Datei oder einen Ordner in den Müll

1. Wählen Sie die Datei oder den Ordner, den Sie in den Müll verschieben möchten.

2. Wählen Sie "Edit -> Move to Trash" (Bearbeiten -> In den Müll verschieben), oder
klicken Sie mit der rechten Maustaste auf die Datei oder den Ordner, und wählen
Sie "Move to Trash" (In den Müll verschieben).

Anmerkung - Wenn Sie eine Datei oder einen Ordner vom Wechseldatenträger in den Müll
verschieben, wird die Datei oder der Ordner an einem für den Müll vorgesehenen Ort auf dem
Wechseldatenträger gespeichert. Um die Datei oder den Ordner aus den Wechseldatenträgern
dauerhaft zu entfernen, müssen Sie den Müll leeren.

So löschen Sie eine Datei oder einen Ordner

Wenn Sie Dateien oder Ordner löschen, werden diese nicht in den Müll verschoben. Sie werden
aus Ihrem Dateisystem gelöscht. Der Menüeintrag "Delete (Löschen)" ist nur verfügbar, wenn
Sie im Dateimanagereinstellungsdialog die Option "Include a Delete command that bypasses
the Trash (Einen Löschbefehl bereitstellen, der den Müll umgeht)" auswählen.

1. Wählen Sie die Datei oder den Ordner, den Sie löschen möchten.

2. Sie haben zum Löschen der Datei oder des Ordners folgende Möglichkeiten.

■ Wählen Sie "Edit -> Delete" (Bearbeiten -> Löschen).

■ Klicken Sie mit der rechten Maustaste auf die Datei oder den Ordner, und
wählen Sie "Delete (Löschen)".

■ Drücken Sie UMSCHALT+ENTF.

Anmerkung - Diese Tastenkombination ist unabhängig von der Option "Delete command that
bypasses the Trash (Einen Löschbefehl bereitstellen, der den Müll umgeht)".

So erstellen Sie einen symbolischen Link zu einer Datei oder
einem Ordner

Ein symbolischer Verweis ist eine besondere Art von Datei, die auf eine andere Datei oder einen
anderen Ordner verweist. Bei einer symbolischen Verknüpfung ausgeführte Aktionen werden
in Wirklichkeit bei der Datei oder beim Ordner ausgeführt, auf die bzw. den die symbolische
Verknüpfung verweist. Wenn Sie jedoch eine symbolische Verknüpfung löschen, wird die
Verknüpfungsdatei und nicht die Datei gelöscht, auf die die symbolische Verknüpfung verweist.
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So erstellen Sie eine symbolische Verknüpfung zu einer Datei oder einem
Ordner

Wählen Sie die Datei oder den Ordner, zu der bzw. dem Sie eine symbolische
Verknüpfung erstellen möchten.

■ Wählen Sie "Edit -> Make Link" (Bearbeiten -> Verknüpfung anlegen).
Eine Verknüpfung zur Datei oder zum Ordner wird dem aktuellen Ordner hinzugefügt.

■ Erstellen Sie die Verknüpfung durch Ziehen und Ablegen.

a.    Halten Sie Strg+Umschalttaste gedrückt.

b.    Ziehen Sie das Objekt an den Ort, an dem Sie die Verknüpfung
platzieren möchten.
Den symbolischen Verknüpfungen werden durch den Dateimanager standardmäßig
Embleme hinzugefügt.

Anmerkung - Die Zugriffsrechte einer symbolischen Verknüpfung werden durch die Datei oder
den Ordner bestimmt, auf den die symbolische Verknüpfung zeigt.

Ziehen und Ablegen verwenden

Sie können mithilfe von Ziehen und Ablegen verschiedene Aufgaben im Dateimanager
durchführen. Beim Ziehen und Ablegen erhalten Sie über den Mauszeiger Informationen zu den
jeweils durchgeführten Aufgaben. In der folgenden Tabelle sind die Aufgaben aufgeführt, die
Sie im Dateimanager durch Ziehen und Ablegen durchführen können. In der Tabelle sind die
Mauszeigerveränderungen aufgeführt, die durch Ziehen und Ablegen bewirkt werden.

TABELLE 8-8 Ziehen und Ablegen im Dateimanager

Aufgabe Aktion

Objekt verschieben Ziehen Sie das Objekt an den neuen Ort.

Objekt kopieren Klicken Sie auf das Objekt, und halten Sie dann Strg gedrückt. Ziehen
Sie das Objekt an den neuen Ort, an dem Sie die Kopie ablegen möchten.

Symbolische Verknüpfung zu einem
Objekt erstellen

Klicken Sie auf das Objekt, und halten Sie dann Strg+Umschalttaste
gedrückt. Ziehen Sie das Objekt an den neuen Ort, an dem Sie die
symbolische Verknüpfung ablegen möchten.

Aktionen nach dem Ziehen und Ablegen
des Objekts

Klicken Sie auf das Objekt, und halten Sie dann Alt gedrückt. Sie
können auch die mittlere Maustaste verwenden, um denselben Vorgang
durchzuführen. Ziehen Sie das Objekt an den neuen Ort, an dem Sie es
ablegen möchten. Lassen Sie die Maustaste los. Wählen Sie eine der
folgenden Optionen aus dem Kontextmenü aus:
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Aufgabe Aktion
■ Move here (Hierher verschieben) – Das Objekt wird an den Ort

verschoben.
■ Copy here (Hierher kopieren) – Das Objekt wird an den Ort kopiert.
■ Link here (Verknüpfung erstellen) – Eine symbolische Verknüpfung

zum Objekt wird an dem Ort erstellt.
■ Set as Background (Als Hintergrund verwenden) – Handelt es sich

bei dem Objekt um ein Bild, wird es als Hintergrundbild festgelegt.
Mit diesem Befehl können Sie den Hintergrund für den Desktop, die
Seitenleiste oder die Ansichtsleiste einrichten.

■ Cancel (Abbrechen) – Der Ziehen-und-Ablegen-Vorgang wird
abgebrochen.

Datei- oder Ordnereigenschaften anzeigen

In der folgenden Tabelle sind die Eigenschaften aufgeführt, die Sie für Dateien und Ordner
anzeigen oder festlegen können. Die genauen Informationen hängen vom jeweiligen Objekttyp
ab.

Eigenschaft Beschreibung

Name (Name) Der Datei- oder Ordnername. Ihre Änderungen am Namen werden übernommen, wenn Sie auf
"Close (Schließen)" klicken.

Type (Typ) Der Objekttyp, z.B. Datei oder Ordner.

Location (Ort) Der Systempfad für das Objekt. Dieser bezeichnet den Ort des Objekts auf Ihrem Computer relativ
zum Wurzelverzeichnis.

Volume
(Datenträger)

Der Datenträger, auf dem sich ein Ordner befindet. Dies bezeichnet den physischen Ort, an dem
sich der Ordner befindet, z.B. eine Festplatte oder ein CD-ROM-Laufwerk.

Free space
(Freier
Speicherplatz)

Die Menge an freiem Speicherplatz auf dem Datenträger, auf dem sich der Ordner befindet. Dieser
Wert bezeichnet die maximale Datenmenge, die Sie in diesen Ordner kopieren können.

MIME Type
(MIME-Typ)

Die offizielle Bezeichnung des Dateityps.

Modified
(Geändert)

Datum und Uhrzeit der letzten Änderung am Objekt.

Accessed
(Zugegriffen)

Datum und Uhrzeit der letzten Anzeige des Objekts.

So zeigen Sie die Eigenschaften einer Datei oder eines
Ordners an

1. Wählen Sie die Datei oder den Ordner, dessen Eigenschaften Sie anzeigen
möchten.

2. Wählen Sie "File -> Properties" (Datei -> Eigenschaften).
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Der Dialog "Properties (Eigenschaften)" wird angezeigt, in dem die Eigenschaften der Datei
oder des Ordners angezeigt werden.

3. Klicken Sie auf "Close (Schließen)", um den Dialog "Properties (Eigenschaften)"
zu schließen.

Ändern von Zugriffsrechten

Bei Zugriffsrechten handelt es sich um Einstellungen für jede Datei und jeden Ordner, durch
die festgelegt wird, wie Benutzer auf die Datei oder den Ordner zugreifen können. Beispiel: Sie
können bestimmen, ob andere Benutzer eine Ihrer Dateien lesen und bearbeiten können, oder ob
sie die Datei nur lesen und nicht verändern können.

Jede Datei gehört zu einem bestimmten Benutzer und ist einer Gruppe zugeordnet, zu welcher
der Benutzer gehört. Der Superuser root  kann auf jede Datei im System zugreifen.

Sie können Zugriffsrechte für drei Benutzerkategorien einstellen:

■ Owner (Besitzer) – Der Benutzer, der die Datei oder den Ordner erstellt hat.
■ Group (Gruppe) – Eine Gruppe von Benutzern, zu der der Besitzer gehört.
■ Others (Andere) – Alle anderen noch nicht zugeordneten Benutzer.

Für jede Benutzerkategorie können unterschiedliche Zugriffsrechte festgelegt werden. Bei den
Zugriffsrechten für Dateien und Ordner wird wie folgt unterschieden:

■ Read (Lesen) – Dateien können geöffnet und der Verzeichnisinhalt angezeigt werden.
■ Write (Schreiben) – Dateien können bearbeitet oder gelöscht und der Verzeichnisinhalt

geändert werden.
■ Execute (Ausführen) – Ausführbare Dateien können als Programm ausgeführt und auf

Verzeichnisse zugegriffen werden.

So ändern Sie die Zugriffsrechte für eine Datei

1. Wählen Sie die Datei aus, die Sie ändern möchten.

2. Wählen Sie "File -> Properties" (Datei -> Eigenschaften).
Das Fenster "Properties (Eigenschaften)" für das Objekt wird angezeigt.

3. Klicken Sie auf die Registerkarte "Permissions (Zugriffsrechte)".

4. Um die Gruppenzuordnung der Datei zu ändern, wählen Sie in der Aufklappliste
aus den Gruppen aus, zu denen der Benutzer gehört.
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5. Legen Sie für alle Benutzer wie Besitzer und Gruppen die Dateizugriffsrechte wie
folgt fest:

■ None (Keiner) – Auf die Datei kann nicht zugegriffen werden (auf den Besitzer des Ordners
nicht anwendbar).

■ Read-only (Nur lesen) – Der Benutzer kann eine Datei öffnen, um deren Inhalt anzuzeigen,
aber keine Änderungen vornehmen.

■ Read and write (Lesen und schreiben) – Normaler Zugriff auf die Datei ist möglich, d.h. sie
kann geöffnet und gespeichert werden.

6. Wählen Sie "Execute (Ausführen)", damit eine Datei als Programm gestartet
werden kann.

So ändern Sie die Zugriffsrechte für einen Ordner

1. Wählen Sie den Ordner aus, den Sie ändern möchten.

2. Wählen Sie "File -> Properties" (Datei -> Eigenschaften).
Das Fenster "Properties (Eigenschaften)" für das Objekt wird angezeigt.

3. Klicken Sie auf die Registerkarte "Permissions (Zugriffsrechte)".

4. Um die Gruppenzuordnung des Ordners zu ändern, wählen Sie in der Auswahl
aus den Gruppen aus, zu denen der Benutzer gehört.

5. Wählen Sie für jeden Besitzer, die Gruppe und alle anderen Benutzer aus
folgenden Ordnerzugriffsrechten aus:

■ None (Keiner) – Auf den Ordner kann nicht zugegriffen werden (auf den Besitzer nicht
anwendbar).

■ List files only (Dateien nur auflisten) – Der Benutzer sieht die Objekte im Ordner, kann sie
aber nicht öffnen.

■ Access files (Auf Dateien zugreifen) – Objekte im Ordner können im Rahmen der
Zugriffsrechte geöffnet und geändert werden.

■ Create and delete files (Dateien erstellen und löschen) – Der Benutzer kann auf vorhandene
Dateien im Ordner zugreifen, neue Dateien im Ordner erstellen und Dateien aus dem Ordner
entfernen.

Anmerkung - Um die Zugriffsrechte für alle in einem Ordner enthaltenen Objekte festzulegen,
legen Sie die Eigenschaften "File Access (Dateizugriff)" und "Execute (Ausführen)" fest, und
klicken Sie dann auf "Apply Permissions to Enclosed Files (Zugriffsrechte auf enthaltene
Dateien übertragen)".
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Dateien und Ordnern Notizen hinzufügen

Sie haben folgende Möglichkeiten, um Dateien und Ordnern Notizen hinzuzufügen:

■ über den Dialog "Properties (Eigenschaften)",
■ über "Notes (Notizen)" in der Seitenleiste.

So fügen Sie über den Dialog "Properties (Eigenschaften)"
eine Notiz hinzu

1. Wählen Sie die Datei oder den Ordner, der bzw. dem Sie eine Notiz hinzufügen
möchten.

2. Wählen Sie "File -> Properties" (Datei -> Eigenschaften).
Das Fenster "Properties (Eigenschaften)" für das Objekt wird angezeigt.

3. Klicken Sie auf die Registerkarte "Notes (Notizen)".

4. Geben Sie auf der Registerkarte die Notiz ein.

5. Klicken Sie auf "Close (Schließen)", um den Dialog "Properties (Eigenschaften)"
zu schließen.
Ein Notizemblem wurde der Datei oder dem Ordner hinzugefügt.

Anmerkung - Sie können den Notiztext auf der Registerkarte "Notes (Notizen)" löschen.

So fügen Sie eine Notiz in der Seitenleiste über "Notes
(Notizen)" hinzu

1. Öffnen Sie die Datei oder den Ordner, der bzw. dem Sie eine Notiz in der
Ansichtsleiste hinzufügen möchten.

2. Wählen Sie zum Anzeigen der Seitenleiste "View -> Side Pane" (Ansicht ->
Seitenleiste).

3. Wählen Sie oben in der Seitenleiste aus der Aufklappliste "Notes (Notizen)".

4. Geben Sie in der Seitenleiste die Notiz ein.
Ein Notizemblem wird der Datei bzw. dem Ordner in der Ansichtsleiste hinzugefügt und ein
Notizsymbol in der Seitenleiste angezeigt. Sie können auf dieses Symbol klicken, um die Notiz
anzuzeigen.
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Anmerkung - Sie können den Notiztext auf der Registerkarte "Notes (Notizen)" löschen.

Dokumente anhand von Vorlagen erstellen

Sie können für häufig erstellte Dokumente Vorlagen erstellen. Beispiel: Wenn Sie oft
Rechnungen schreiben, können Sie ein leeres Rechnungsdokument erstellen und unter
invoice.doc im Ordner $HOME/Templates speichern.

Um von einem Dateibrowserfenster aus auf den Vorlagenordner zuzugreifen, wählen Sie "Go
-> Templates" (Gehe zu -> Vorlagen). Der Vorlagenname wird im Menü "Create Document
(Dokument anlegen)" als Untermenüeintrag angezeigt.

Sie können im Vorlagenordner auch Unterordner erstellen. Im Menü werden Unterordner als
Untermenüs angezeigt. Sie können außerdem Vorlagen gemeinsam nutzen. Erstellen Sie eine
symbolische Verknüpfung zu dem Ordner, der die gemeinsam genutzten Vorlagen enthält.

So erstellen Sie ein Dokument anhand einer Vorlage

1. Wählen Sie den Ordner, in dem Sie das neue Dokument erstellen möchten.

2. Wählen Sie "File -> Create Document" (Datei -> Dokument erstellen), oder
klicken Sie mit der rechten Maustaste auf den Hintergrund der Ansichtsleiste,
und wählen Sie dann "Create Document" (Dokument erstellen)".
Die Namen eventuell vorhandener Vorlagen werden im Menü "Create Document (Dokument
anlegen)" als Untermenüeinträge angezeigt.

3. Doppelklicken Sie auf den Namen der Vorlage, anhand derer Sie ein Dokument
erstellen möchten.

4. Benennen Sie das Dokument um, bevor Sie es im entsprechenden Ordner
speichern.

Lesezeichen verwenden

Sie können für Ordner und andere häufig geöffnete Orte eine Lesezeichenliste verwalten.

Ihre Lesezeichen werden an den folgenden Orten aufgeführt:

■ im oberen Panel im Menü "Places (Orte)"
■ in einem Ordnerfenster im Menü "Places (Orte)"
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■ im Dateimanagerbrowserfenster im Menü "Bookmarks (Lesezeichen)"
■ im Dialog "Open File (Datei öffnen)" in der Seitenleiste, über die Sie Dateien schnell öffnen

können, die sich an einem Ihrer als Lesezeichen gespeicherten Orte befinden
■ im Dialog "Save File (Datei speichern)" in der Liste häufig verwendeter Orte, über die Sie

Dateien schnell an Ihren als Lesezeichen gespeicherten Orte speichern können

Um ein Objekt in Ihren Lesezeichen zu öffnen, wählen Sie es aus einem Menü aus.

Lesezeichen hinzufügen oder löschen

Wenn Sie ein Lesezeichen hinzufügen möchten, öffnen Sie den Ordner oder den Speicherort,
den Sie hinzufügen möchten, und wählen Sie "Places -> Add Bookmark" (Orte -> Lesezeichen
hinzufügen).

Falls Sie ein Dateimanagerbrowserfenster verwenden, wählen Sie "Bookmarks -> Add
Bookmark" (Lesezeichen -> Lesezeichen hinzufügen).

Um ein Lesezeichen zu löschen, wählen Sie es auf der linken Seite des Dialogfeldes aus,
wählen Sie "Places -> Edit Bookmarks" (Orte -> Lesezeichen bearbeiten), und klicken Sie auf
"Delete" (Löschen).

So bearbeiten Sie ein Lesezeichen

1. Wählen Sie "Places -> Edit Bookmarks" (Orte -> Lesezeichen bearbeiten) bzw.
"Bookmarks -> Edit Bookmarks" (Lesezeichen -> Lesezeichen bearbeiten) in
einem Browserfenster. Der Dialog "Edit Bookmarks (Lesezeichen bearbeiten)"
wird angezeigt.

2. Wählen Sie das Lesezeichen auf der linken Seite des Dialogs "Edit Bookmarks
(Lesezeichen bearbeiten)" aus.

3. Bearbeiten Sie die Lesezeichendetails wie folgt:

■ Name (Name) – Geben Sie in diesem Textfeld den Namen an, unter dem das Lesezeichen in
den Menüs abgelegt werden soll.

■ Location (Ort) – Geben Sie in diesem Feld den Ort des Lesezeichens an. Ordner im System
verwenden file:/// URI.

Verwenden von Müll

Bei "Trash (Müll)" handelt es sich um einen speziellen Ordner, der nicht mehr benötigte
Dateien enthält. Dateien im Müll werden erst dauerhaft gelöscht, wenn Sie den Müll leeren.
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ABBILDUNG 
  8-5

Müllsymbol

Folgende Objekte können in den Müll verschoben werden:

■ Dateien
■ Ordner
■ Desktopobjekte

Wenn Sie eine Datei im Müll aufrufen müssen, verschieben Sie die Datei aus dem Müll. Wenn
Sie den Müll leeren, wird dessen Inhalt unwiderruflich gelöscht.

Objekte im Müll anzeigen

■ Wählen Sie in einem Browserfenster "Go -> Trash" (Gehe zu -> Müll). Der Inhalt des Mülls
wird im Fenster angezeigt.

■ Wählen Sie in einem räumlichen Fenster "Places -> Trash" (Orte -> Müll). Der Inhalt des
Mülls wird im Fenster angezeigt.

■ Klicken Sie auf dem Desktop im unteren Panel auf das Müllapplet.

Leeren des Mülls

■ Wählen Sie in einem Browserfenster "File -> Empty Trash" (Datei -> Müll leeren).
■ Klicken Sie auf dem Desktop im unteren Panel mit der rechten Maustaste auf das Symbol

"Trash (Müll)", und wählen Sie dann "Empty Trash (Müll leeren)".

Anmerkung - Wenn Sie den Müll leeren, zerstören Sie sämtliche Dateien im Müll.
Vergewissern Sie sich, dass der Müll nur Dateien enthält, die Sie nicht mehr benötigen.

Versehentlich gelöschte Dateien können mithilfe des Zeitschiebereglers wiederhergestellt
werden. Weitere Informationen zum Zeitschieberegler finden Sie in Kapitel 7, Verwenden des
Zeitschiebereglers.
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Anzeigen verborgener Dateien

Bestimmte System- und Sicherungsdateien werden standardmäßig im Dateimanager in Ordnern
nicht angezeigt. Dadurch soll verhindert werden, dass solche Dateien versehentlich geändert
oder gelöscht werden, wodurch der Computer nicht mehr ordnungsgemäß funktioniert, und dass
sich große Datenmengen beispielsweise im persönlichen Ordner ansammeln. Im Dateimanager
wird Folgendes nicht angezeigt:

■ verborgene Dateien, deren Dateiname mit einem Punkt (.) beginnt
■ Sicherungsdateien, deren Dateiname mit einer Tilde (~) endet
■ Dateien, die in der Datei .hidden eines bestimmten Ordners enthalten sind

Wenn Sie verborgene Dateien in einem bestimmten Ordner verbergen oder anzeigen
möchten, wählen Sie "View -> Show Hidden Files (Ansicht -> Verborgene Dateien zeigen)".
Wenn verborgene Dateien im Dateimanager immer angezeigt werden sollen, wählen
Sie in den Einstellungen für Ansichten "Show Hidden and Backup Files (Verborgene
Dateien und Sicherungsdateien anzeigen)". Weitere Informationen finden Sie unter
„Dateimanagereinstellungen festlegen“ [110].

Datei oder Ordner verbergen

Um eine Datei oder einen Ordner im Dateimanager zu verbergen, benennen Sie sie entweder
so um, dass der Name mit einem Punkt (.) beginnt, oder erstellen Sie im selben Ordner die
Textdatei .hidden, und fügen Sie den Datei- oder Ordnernamen hinzu.

Drücken Sie STRG+R, um das entsprechende Dateimanagerfenster zu aktualisieren und die
Änderungen anzuzeigen.

Verwenden von Objekteigenschaften

Im Fenster "Item Properties (Objekteigenschaften)" werden Informationen zu allen Dateien,
Ordnern oder anderen Dateimanagerobjekten angezeigt. In diesem Fenster können Sie folgende
Aktionen ausführen:

■ Symbol für ein Objekt ändern (siehe So ändern Sie das Symbol für eine Datei oder einen
Ordner [104]),

■ Embleme für ein Objekt hinzufügen oder entfernen (siehe So fügen Sie ein Emblem einer
Datei oder einem Ordner hinzu [105]),

■ UNIX-Dateizugriffsrechte für ein Objekt ändern (siehe „Ändern von
Zugriffsrechten“ [96]),

■ Anwendung zum Öffnen eines Objekts und anderer Objekte desselben Typs festlegen,
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■ Notizen zu einem Objekt hinzufügen (siehe So fügen Sie über den Dialog "Properties
(Eigenschaften)" eine Notiz hinzu [98]).

So zeigen Sie das Fenster "Item Properties
(Objekteigenschaften)" an

1. Wählen Sie das Objekt aus, dessen Eigenschaften Sie prüfen oder ändern
möchten.
Wenn Sie mehr als ein Objekt auswählen, werden im Fenster "Item Properties
(Objekteigenschaften)" die auf alle Objekte zutreffenden Eigenschaften angezeigt.

2. Sie haben zum Anzeigen des Dialogs folgende Möglichkeiten:

■ Wählen Sie "File -> Properties" (Datei -> Eigenschaften).
■ Klicken Sie mit der rechten Maustaste auf das ausgewählte Objekt, und wählen Sie

"Properties (Eigenschaften)".
■ Drücken Sie ALT+EINGABETASTE.

Darstellung von Dateien und Ordnern ändern

Sie können das Aussehen von Dateien und Ordnern anpassen, indem Sie Embleme oder
Hintergründe hinzufügen. Außerdem können Sie das Format ändern, in dem diese Objekte im
Dateimanager angezeigt werden.

Symbole und Embleme verwenden

Im Dateimanager werden Dateien und Ordner als Symbole angezeigt. Das Symbol, das den
Dateityp darstellt, kann je nach Dateityp ein Bild, ein kleines Miniaturvorschaubild oder eine
Vorschau des Dateiinhalts sein.

Sie können Datei- und Ordnersymbolen auch Embleme hinzufügen. Solche Embleme werden
zusätzlich zum Dateisymbol angezeigt und bieten andere Möglichkeiten zur Dateiverwaltung.
Beispiel: Um eine Datei als wichtig zu kennzeichnen, können Sie ihr das Emblem "Important
(Wichtig)" hinzufügen, wie in der folgenden Abbildung dargestellt.
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ABBILDUNG 
  8-6

Symbole und Embleme

Weitere Informationen zum Hinzufügen von Emblemen finden Sie unter So fügen Sie ein
Emblem einer Datei oder einem Ordner hinzu [105].

Folgenden Dateitypen werden über den Dateimanager automatisch Embleme hinzugefügt:

■ Symbolische Verknüpfungen
■ Objekte mit folgenden Zugriffsrechten:

■ keine Leserechte
■ keine Schreibrechte

In der folgenden Tabelle sind die Standardembleme aufgeführt.

Standardemblem Beschreibung

Symbolische Verknüpfung

keine Schreibrechte

keine Leserechte

So ändern Sie das Symbol für eine Datei oder einen Ordner

1. Wählen Sie die Datei oder den Ordner, dessen Symbol Sie ändern möchten.

2. Wählen Sie "File -> Properties" (Datei -> Eigenschaften).
Das Fenster "Properties (Eigenschaften)" für das Objekt wird angezeigt.

3. Klicken Sie auf der Registerkarte "Basic (Grundlegend)" auf das aktuelle
Symbol.
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Der Dialog "Select custom icon (Benutzerdefiniertes Symbol wählen)" wird angezeigt.

4. Wählen Sie das Symbol aus, das die Datei oder den Ordner darstellen soll.

5. Klicken Sie auf "Close (Schließen)", um den Dialog "Properties (Eigenschaften)"
zu schließen.

Anmerkung - Um ein benutzerdefiniertes Symbol auf das Standardsymbol zurückzusetzen,
wählen Sie die Datei oder den Ordner aus, die bzw. den Sie ändern möchten, und klicken Sie im
Dialog "Select custom icon (Benutzerdefiniertes Symbol wählen)" auf "Revert (Zurücksetzen)".

So fügen Sie ein Emblem einer Datei oder einem Ordner hinzu

1. Wählen Sie das Objekt, dem Sie ein Emblem hinzufügen möchten.

2. Klicken Sie mit der rechten Maustaste auf das Objekt, und wählen Sie
"Properties (Eigenschaften)".
Das Fenster "Properties (Eigenschaften)" für das Objekt wird angezeigt.

3. Klicken Sie auf die Registerkarte "Emblems (Embleme)", um den Inhalt der
Registerkarte "Emblems (Embleme)" anzuzeigen.

4. Wählen Sie das Emblem aus, das Sie dem Objekt hinzufügen möchten.

5. Klicken Sie auf "Close (Schließen)", um den Dialog "Properties (Eigenschaften)"
zu schließen.

Tipp - In Browserfenstern können Sie auch Objekten Embleme hinzufügen, indem Sie sie aus
der Emblemseitenleiste ziehen.

So erstellen Sie ein neues Emblem

1. Wählen Sie "Edit -> Backgrounds and Emblems" (Bearbeiten -> Hintergründe
und Embleme).

2. Klicken Sie auf den Knopf "Emblem (Emblem)" und dann auf "Add a New
Emblem (Ein neues Emblem hinzufügen)".
Der Dialog "Create a New Emblem (Ein neues Emblem anlegen)" wird angezeigt.

3. Geben Sie den Emblemnamen in das Textfeld "Keyword (Stichwort)" ein.

4. Klicken Sie auf "Image (Bild)".
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Klicken Sie in dem daraufhin angezeigten Dialog auf "Browse (Auswählen)".

5. Wählen Sie ein Emblem aus, und klicken Sie auf "OK (OK)".

6. Klicken Sie auf "OK (OK)".

Ändern von Hintergründen

Sie können das Aussehen Ihrer Ordner mithilfe der im Dateimanager verfügbaren
Hintergrundmuster und Embleme anpassen. Hintergrundmuster und Embleme können auch
für den Desktop, Ordner, verschiedene Seitenleisten im Dateibrowser und in Panels verwendet
werden.

So ändern Sie den Hintergrund eines Fensters, einer Leiste oder eines
Panels

1. Wählen Sie in einem Dateimanagerfenster "Edit -> Backgrounds and
Emblems" (Bearbeiten -> Hintergründe und Embleme).
Der Dialog "Backgrounds and Emblems (Hintergründe und Embleme)" wird angezeigt.

2. Klicken Sie auf den Knopf "Patterns (Muster)" oder "Colors (Farben)".
Eine Liste mit Hintergrundmustern bzw. -farben wird angezeigt.

3. (Optional) Fügen Sie der Liste ein neues Muster oder eine neue Farbe hinzu.

■ So fügen Sie ein neues Muster hinzu

a.    Klicken Sie auf den Knopf "Add a New Pattern (Ein neues Muster
hinzufügen)".

b.    Wählen Sie im Dateiauswahldialog eine Bilddatei aus, und klicken Sie
auf "Open (Öffnen)".
Das Bild wird nun in der Liste der verfügbaren Muster angezeigt.

■ So fügen Sie der Liste eine neue Farbe hinzu

a.    Klicken Sie auf den Knopf "Add a New Color (Eine neue Farbe
hinzufügen)".

b.    Wählen Sie im Dateiauswahldialog eine Farbe aus, und klicken Sie auf
"OK (OK)".
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Die Farbe wird nun in der Liste der verfügbaren Farben angezeigt.

4. Um den Hintergrund zu ändern, ziehen Sie ein Muster oder eine Farbe in
das gewünschte Fenster, Panel oder in die gewünschte Leiste. Um den
Hintergrund zurückzusetzen, ziehen Sie den Eintrag "Reset (Zurücksetzen)" in
das gewünschte Fenster, Panel oder in die gewünschte Leiste.

Verwenden von Wechseldatenträgern

Wenn Wechseldatenträger angezeigt werden, können über den Dateimanager verschiedene
Aktionen eingeleitet werden, z.B. Einhängen, Öffnen eines Dateimanagerfensters zum
Anzeigen des Inhalts oder Ausführen einer zweckgemäßen Anwendung (Beispiel:
Musikabspielgerät für Audio-CDs). Informationen zum Konfigurieren dieser Aktionen für
verschiedene Datenträgerformate finden Sie unter „Datenträger“ [116].

Einhängen von Datenträgern

Durch den Einhängevorgang kann auf das Dateisystem des Datenträgers zugegriffen
werden. Wenn Sie einen Datenträger einhängen, wird das Dateisystem des Datenträgers als
Unterverzeichnis an Ihr Dateisystem angehängt.

Um einen Datenträger einzuhängen, fügen Sie den Datenträger in ein geeignetes Gerät ein. Ein
Symbol, das den Datenträger darstellt, wird dem Desktop hinzugefügt. Dieses Symbol wird nur
dann hinzugefügt, wenn Ihr System so konfiguriert ist, dass erkannte Datenträger automatisch
eingehängt werden.

Wenn Ihr System nicht für das automatische Einhängen von Geräten konfiguriert ist, müssen
Sie das Gerät manuell einhängen.

So hängen Sie ein Gerät manuell ein

1. Wählen Sie im oberen Panel aus der Menüleiste "Places -> Computer" (Orte ->
Rechner).
Der Dialog "Computer (Computer)" wird angezeigt.

2. Doppelklicken Sie auf das Symbol, das den Datenträger darstellt. Beispiel: Um
eine CD-ROM einzuhängen, doppelklicken Sie auf das CD-ROM-Symbol.
Ein Symbol, das den Datenträger darstellt, wird dem Desktop hinzugefügt.

Anmerkung - Sie können den Namen eines Wechseldatenträgersymbols nicht ändern.
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Datenträgerinhalte anzeigen
Zum Anzeigen des Datenträgerinhalts haben Sie folgende Möglichkeiten:

■ Doppelklicken Sie auf das Symbol, das den Datenträger auf dem Desktop darstellt.
■ Klicken Sie mit der rechten Maustaste auf das Symbol, das den Datenträger auf dem

Desktop darstellt, und wählen Sie dann "Open (Öffnen)".

Der Datenträgerinhalt wird in einem Dateimanagerfenster angezeigt. Klicken Sie zum
Aktualisieren der Anzeige auf "Reload (Aktualisieren)".

Datenträgereigenschaften anzeigen
Klicken Sie zum Anzeigen der Eigenschaften von Wechseldatenträgern mit der rechten
Maustaste auf das Symbol, das den Datenträger auf dem Desktop darstellt, und wählen Sie dann
"Properties (Eigenschaften)". Die Datenträgereigenschaften werden in einem Dialog angezeigt.

Klicken Sie auf "Close (Schließen)", um den Dialog "Properties (Eigenschaften)" zu schließen.

Datenträger auswerfen
Klicken Sie zum Auswerfen von Datenträgern mit der rechten Maustaste auf das
Datenträgersymbol auf dem Desktop, und wählen Sie dann "Eject (Auswerfen)". Wenn
die Schublade des Laufwerks, in dem sich der Datenträger befindet, durch einen Motor
angetrieben wird, dann wird der Datenträger aus dem Laufwerk ausgeworfen. Wenn
die Laufwerksschublade nicht durch einen Motor angetrieben wird, warten Sie, bis das
Desktopsymbol für diesen Datenträger nicht mehr angezeigt wird, und werfen Sie den
Datenträger manuell aus.

Anmerkung - Datenträger in motorbetriebenen Laufwerken lassen sich nicht auswerfen,
solange sie eingehängt sind.

So werfen Sie einen Datenträger aus einem USB-
Flashlaufwerk aus

Vor dem Auswerfen müssen Sie die Wechseldatenträger aushängen. Hängen Sie ein USB-
Flashlaufwerk zuerst aus, bevor Sie es entfernen. Andernfalls kann es zum Datenverlust
kommen.

1. Schließen Sie alle Dateimanagerfenster, Terminalfenster und alle anderen
Fenster mit Zugriff auf das USB-Laufwerk.
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2. Klicken Sie mit der rechten Maustaste auf das Symbol, das das Laufwerk auf
dem Desktop darstellt, und wählen Sie dann "Eject (Auswerfen)".
Das Desktopsymbol für das Laufwerk wird nicht mehr angezeigt.

3. Entfernen Sie das USB-Flashlaufwerk.

Durch Remote-Server navigieren

Der Dateimanager bietet einen integrierten Zugriffspunkt auf Ihre Dateien, Anwendungen, FTP-
Sites, Windows-Freigaben, WebDav-Server und SSH-Server.

Auf Remote-Server zugreifen

Sie können mit dem Dateimanager auf Remote-Server wie eine FTP-Site, eine Windows-
Freigabe, einen WebDav-Server oder einen SSH-Server zugreifen.

Um auf einen Remote-Server zuzugreifen, wählen Sie "File -> Connect to Server" (Datei -> Mit
Server verbinden). Dasselbe Dialogfeld können Sie auch von der Menüleiste aus über "Places -
> Connect to Server" (Orte -> Mit Server verbinden) aufrufen.

Wählen Sie für eine Verbindung mit einem Remote-Server zuerst den Servicetyp, und geben
Sie dann den Serveradressentyp ein. Sie können nach Bedarf die folgenden optionalen
Informationen angeben.

Port Der Port für die Verbindung mit dem Server. Wenn Sie nicht den Standardport
verwenden, dann müssen Sie diese Einstellung auswählen. Normalerweise bleibt dieses
Feld leer.

Folder (Ordner) Ordner, der bei der Verbindung mit einem Server geöffnet wird.

User Name
(Benutzername)

Der Benutzername des Kontos, der bei der Verbindung mit dem Server angegeben wird.
Dieser Wert wird mit den Verbindungsinformationen bereitgestellt. Ein Benutzername ist
für öffentliche FTP-Server nicht angebracht.

Name to use for
connection (Zu
verwendender Name für
die Verbindung)

Die Bezeichnung der Verbindung im Dateimanager.

Share (Freigabe) Der Name der gewünschten Windows-Freigabe. Diese Einstellung kann nur auf
Windows-Freigaben angewendet werden.

Domain name (Domain-
Name)

Die Windows-Domain. Diese Einstellung kann nur auf Windows-Freigaben angewendet
werden.

Wenn die Serverinformationen in Form eines URI bereitgestellt werden oder Sie eine spezielle
Verbindung benötigen, wählen Sie als Servicetyp "Custom Location (Benutzerdefinierter Ort)".
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Wenn Sie die Informationen eingegeben haben, klicken Sie auf "Connect (Verbinden)". Wenn
die Verbindung hergestellt werden konnte, wird der Inhalt der Site angezeigt. Sie können
Dateien durch Ziehen und Ablegen auf den und vom Remote-Server verschieben.

Auf Orte im Netzwerk zugreifen

Wenn Ihr System für den Zugriff auf Orte in einem Netzwerk konfiguriert ist, können Sie
mithilfe des Dateimanagers auf diese Orte zugreifen.

Um auf Orte im Netzwerk zuzugreifen, öffnen Sie den Dateimanager, und wählen Sie
"Places -> Network" (Orte -> Netzwerk), oder wählen Sie in einem Browserfenster "Go -
> Network" (Gehe zu -> Netzwerk). Die verfügbaren Netzwerke werden in einem Fenster
angezeigt. Doppelklicken Sie auf das Netzwerk, auf das Sie zugreifen möchten.

Um auf UNIX-Freigaben zuzugreifen, doppelklicken Sie auf das Objekt "Unix Network (NFS)
(Unix-Netzwerk (NFS))". Im Dateimanagerfenster wird eine Liste verfügbarer UNIX-Freigaben
angezeigt.

Um auf Windows-Freigaben zuzugreifen, doppelklicken Sie auf das Objekt "Windows Network
(SMB) (Windows-Netzwerk (SMB))". Im Dateimanagerfenster wird eine Liste verfügbarer
Windows-Freigaben angezeigt.

Auf spezielle URI-Orte zugreifen

Der Dateimanager verfügt über bestimmte spezielle URI-Orte, die Ihnen den Zugriff auf
bestimmte Funktionen im Dateimanager ermöglichen. Diese Orte sind für fortgeschrittene
Benutzer bestimmt. In den meisten Fällen gibt es eine einfachere Möglichkeit, auf die Funktion
oder den Ort zuzugreifen.

Sie können den speziellen URI-Ort network:/// verwenden, sodass im Dateimanager Orte
im Netzwerk angezeigt werden, mit denen Sie eine Verbindung herstellen können, wenn Ihr
System für den Zugriff auf Orte in einem Netzwerk konfiguriert ist. Um auf einen Ort im
Netzwerk zuzugreifen, doppelklicken Sie auf den Netzwerkort. Außerdem können Sie mit
diesem URI Ihrem System Orte im Netzwerk hinzufügen. Siehe auch „Auf Orte im Netzwerk
zugreifen“ [110].

Dateimanagereinstellungen festlegen

Verwenden Sie den Dialog "File Management Preferences (Einstellungen zur Verwaltung von
Dateien)", um den Dateimanager anzupassen.
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Um das Dialogfeld "File Management Preferences" (Einstellungen zur Verwaltung von Dateien)
anzuzeigen, wählen Sie "Edit -> Preferences" (Bearbeiten -> Einstellungen). Sie können auf
dieses Dialogfeld auch direkt von der Menüleiste im oberen Panel aus zugreifen, indem Sie
"System -> Preferences -> File Management" (System -> Einstellungen -> Verwaltung von
Dateien) wählen.

Sie können Einstellungen in folgenden Kategorien festlegen:

■ Standardeinstellungen für Ansichten
■ Verhalten von Dateien und Ordnern, ausführbaren Textdateien und des Mülls
■ Symbolbeschriftungen und Zeitformat
■ Spalten, die in der Listenansicht angezeigt werden, und deren Reihenfolge
■ Vorschauoptionen zur Verbesserung der Dateimanagerleistung
■ Umgang mit Wechseldatenträgern und angeschlossenen Geräten

Ansichten

Sie können eine Standardansicht festlegen sowie Sortier- und Anzeigeoptionen auswählen.
Außerdem können Sie die Standardeinstellungen für Symbol- und Listenansichten festlegen.

Um Ihre Einstellungen für die Standardansicht festzulegen, wählen Sie "Edit ->
Preferences" (Bearbeiten -> Einstellungen). Klicken Sie auf die Registerkarte "Views
(Ansichten)". In der folgenden Tabelle sind alle veränderbaren Einstellungen unter "Views
(Ansichten)" aufgeführt.

TABELLE 8-9 Einstellungen unter "Views" (Ansichten)

Dialogfeldelement Beschreibung

View new folders using (Neue Ordner anzeigen mit) Hier können Sie die Standardansicht für Ordner
bestimmen. Wenn Sie einen Ordner öffnen, wird er in
der von Ihnen gewählten Ansicht angezeigt, d.h. in der
Symbolansicht, Listenansicht oder der Kompaktansicht.
Die Kompaktansicht ist eine Variante der Symbolansicht,
wobei die Symbole in Spalten anstelle von Zeilen
angezeigt werden.

Arrange items (Objekte anordnen) Wählen Sie das Merkmal aus, nach dem die Objekte in
den Ordnern sortiert werden sollen, die in dieser Ansicht
angezeigt werden.

Show hidden and backup files (Verborgene Dateien und
Sicherungsdateien anzeigen)

Hier werden Dateien angezeigt, die in Ordnern verborgen
werden. Weitere Informationen zu verborgenen
Dateien finden Sie unter „Anzeigen verborgener
Dateien“ [102].

Default zoom level (Voreingestellte Vergrößerungsstufe)
in den Abschnitten "Icon View (Symbolansicht)",
"Compact View (Kompakte Ansicht)" oder "List View
(Listenansicht)".

Legt die Standardvergrößerungsstufe für Ordner fest,
die in dieser Ansicht angezeigt werden. Durch die
Vergrößerungsstufe wird die Größe der Objekte in einer
Ansicht angegeben.
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Dialogfeldelement Beschreibung

Use compact layout (Kompakte Anordnung verwenden) Die Objekte werden in der Symbolansicht so angeordnet,
dass die Objekte im Ordner dichter nebeneinander
stehen.

Text beside icons (Text neben Symbolen) Die Symbolbeschriftungen für Objekte werden so
platziert, dass sie neben und nicht unter dem Symbol
stehen.

All columns have the same width (Gleiche
Spaltenbreiten)

Dadurch wird sichergestellt, dass in der kompakten
Ansicht alle Spalten dieselbe Breite aufweisen.

Show only folders (Nur Ordner anzeigen) Dadurch werden nur Ordner angezeigt, die sich in der
Seitenleiste in der Baumansicht befinden.

Verhalten

Um Ihre Einstellungen für Dateien und Ordner festzulegen, wählen Sie "Edit ->
Preferences" (Bearbeiten -> Einstellungen). Klicken Sie auf die Registerkarte "Behavior
(Verhalten)". Sie können die in folgender Tabelle beschriebenen Einstellungen festlegen.

TABELLE 8-10 Verhaltenseinstellungen

Dialogfeldelement Beschreibung

Single click to open items (Einfacher Klick zum Öffnen
von Objekten)

Die Standardaktion für ein Objekt wird ausgeführt,
wenn Sie auf das Objekt klicken. Wenn Sie diese Option
auswählen und mit dem Mauszeiger auf das Objekt
zeigen, wird der Objekttitel unterstrichen.

Double click to open items (Doppelklick zum Öffnen von
Objekten)

Wenn Sie auf das Objekt doppelklicken, wird die
Standardaktion für ein Objekt ausgeführt.

Open each folder in its own window (Jeden Ordner in
separatem Fenster öffnen)

Legt den räumlichen Modus und nicht den
Browsermodus als Standard fest. Im räumlichen Modus
können Sie Dateien und Ordner als Objekte in ihrem
eigenen Fenster durchsuchen. Andernfalls müssen Sie
die Dateien und Ordner als Objekte im selben Fenster
durchsuchen.

Run executable text files when they are opened
(Ausführbare Textdateien ausführen, wenn sie geöffnet
werden)

Wenn Sie eine Datei auswählen, wird eine ausführbare
Textdatei ausgeführt. Eine ausführbare Textdatei kann
ein Shellskript ausführen.

View executable text files when they are opened
(Ausführbare Textdateien anzeigen, wenn sie geöffnet
werden)

Der Inhalt einer ausführbaren Textdatei wird angezeigt,
wenn Sie sie auswählen.

Ask each time (Jedes Mal nachfragen) Wenn Sie eine ausführbare Textdatei auswählen, wird
ein Dialog angezeigt. Im Dialog werden Sie aufgefordert
anzugeben, ob Sie die Datei ausführen oder anzeigen
möchten.

Ask before emptying the Trash or deleting files (Vor
dem Leeren des Mülls oder dem Löschen von Dateien
nachfragen)

Es wird eine Nachricht zur Bestätigung angezeigt, bevor
der Müll geleert oder Dateien gelöscht werden.

Include a Delete command that bypasses Trash (Einen
Löschbefehl bereitstellen, der den Müll umgeht)

Der Menüeintrag "Delete (Löschen)" wird zu folgenden
Menüs hinzugefügt:
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Dialogfeldelement Beschreibung
■ Menü "Edit (Bearbeiten)"
■ Kontextmenü, das angezeigt wird, wenn Sie mit der

rechten Maustaste auf eine Datei, einen Ordner oder
ein Desktopobjekt klicken.

Wenn Sie ein Objekt und dann "Delete (Löschen)"
wählen, wird dieses Objekt aus dem Dateisystem
gelöscht. Sie können eine gelöschte Datei nicht
wiederherstellen.

Anzeige

In der Symbolansicht wird der Name einer Datei oder eines Ordners in der Symbolbeschriftung
angezeigt. Außerdem enthält die Symbolbeschriftung drei zusätzliche Angaben zur Datei
oder zum Ordner. Die zusätzlichen Angaben werden nach dem Dateinamen angezeigt.
Normalerweise wird nur eine Angabe angezeigt, aber wenn Sie ein Symbol vergrößern,
werden mehr Angaben angezeigt. Sie können diese in den Symbolbeschriftungen angezeigten
zusätzlichen Angaben ändern.

Um Ihre Einstellungen für Symbolbeschriftungen festzulegen, wählen Sie "Edit ->
Preferences" (Bearbeiten -> Einstellungen). Klicken Sie auf die Registerkarte "Display
(Anzeige)".

Wählen Sie aus den drei Aufklapplisten die Informationen aus, die in der Symbolbeschriftung
angezeigt werden sollen. In der folgenden Tabelle sind die auswählbaren Informationen
aufgeführt.

Informationen Beschreibung

Keine Zum Objekt werden keine Angaben angezeigt.

Size (Größe) Die Größe des Objekts wird angezeigt.

Type (Typ) Die Beschreibung des MIME-Typs des Objekts wird angezeigt.

Date Modified
(Änderungsdatum)

Das Datum der letzten Änderung am Objekt wird angezeigt.

Date Accessed
(Zugriffsdatum)

Das Datum des letzten Zugriffs auf das Objekt wird angezeigt.

Owner (Besitzer) Der Besitzer des Objekts wird angezeigt.

Group (Gruppe) Die Gruppe, zu der das Objekt gehört, wird angezeigt.

Permissions
(Zugriffsrechte)

Die Zugriffsrechte des Objekts werden in drei Sätzen zu je drei Zeichen angezeigt. Beispiel:
-rwxrw-r--.

Octal Permissions
(Oktale
Zugriffsrechte)

Die Zugriffsrechte des Objekts werden in oktaler Notierung angezeigt. Beispiel: 764.

MIME Type (MIME-
Typ)

Der MIME-Typ des Objekts wird angezeigt.
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Informationen Beschreibung

Location (Ort) Der vollständige UNIX-Pfadname des Objekts wird angezeigt.

Restore
(Wiederherstellen)

Hier wird angegeben, ob das Objekt im Dateisystem vorhanden ist, und überprüft, ob sich
dessen Inhalt ändert, wenn er mithilfe des Zeitschiebereglers in einem ZFS-Schnappschuss
angezeigt wird.

Mithilfe der Datumsformatoption können Sie festlegen, wie das Datum im Dateimanager
angezeigt werden soll.

Listenspalten
Sie können festlegen, welche Informationen in der Listenansicht von Dateimanagerfenstern
angezeigt werden sollen. Sie können angeben, welche Spalten in der Listenansicht angezeigt
werden, und wie diese angeordnet sind.

Um Ihre Einstellungen für Listenspalten festzulegen, wählen Sie "Edit ->
Preferences" (Bearbeiten -> Einstellungen). Klicken Sie auf die Registerkarte "List Columns
(Listenspalten)".

Um eine Spalte in der Listenansicht anzuzeigen, wählen Sie die der Spalte entsprechende
Option, und klicken Sie dann auf "Show (Anzeigen)". Um eine Spalte aus der Listenansicht
zu entfernen, wählen Sie die der Spalte entsprechende Option, und klicken Sie dann auf "Hide
(Verbergen)".

Um die Spalten in der Listenansicht anzuordnen, verwenden Sie die entsprechenden Knöpfe,
um die Spalten nach oben bzw. nach unten zu verschieben. Um die Standardspalten und deren
Anordnung zu verwenden, klicken Sie auf "Use Default (Vorgabe verwenden)".

In der folgenden Tabelle sind die Spalten aufgeführt, die Sie anzeigen können.

Informationen Beschreibung

Name (Name) Der Name des Objekts wird angezeigt.

Size (Größe) Die Größe des Objekts wird angezeigt.

Type (Typ) Die Beschreibung des MIME-Typs eines Objekts wird im Einstellungstool "File Types and
Programs (Dateitypen und Programme)" angezeigt.

Date Modified
(Änderungsdatum)

Das Datum der letzten Änderung am Objekt wird angezeigt.

Date Accessed
(Zugriffsdatum)

Das Datum des letzten Zugriffs auf das Objekt wird angezeigt.

Group (Gruppe) Die Gruppe, zu der das Objekt gehört, wird angezeigt.

MIME type (MIME-
Typ)

Der MIME-Typ des Objekts wird angezeigt.

Octal Permissions
(Oktale
Zugriffsrechte)

Die Zugriffsrechte des Objekts werden in oktaler Notierung angezeigt. Beispiel: 764.
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Informationen Beschreibung

Owner (Besitzer) Der Besitzer des Objekts wird angezeigt.

Permissions
(Zugriffsrechte)

Die Zugriffsrechte des Objekts werden in drei Sätzen zu je drei Zeichen angezeigt. Beispiel:
-rwxrw-r--.

Restore Information
(Informationen
wiederherstellen)

Hier wird angegeben, ob das Objekt im Dateisystem vorhanden ist, und überprüft, ob sich
dessen Inhalt ändert, wenn er mithilfe des Zeitschiebereglers in einem ZFS-Schnappschuss
angezeigt wird.

Vorschau
Der Dateimanager enthält einige Dateivorschaufunktionen. Die Vorschaufunktionen können
die Geschwindigkeit beeinflussen, mit der der Dateimanager auf Anforderungen reagiert. Sie
können das Verhalten einiger dieser Funktionen ändern, um die Reaktionsgeschwindigkeit des
Dateimanagers zu verbessern. Für jede Vorschaueinstellung können Sie eine der folgenden
Optionen auswählen.

Always (Immer) Die Aktion wird für lokale Dateien und Dateien in anderen Dateisystemen ausgeführt.

Local Files Only
(Nur lokale
Dateien)

Die Aktion wird nur für lokale Dateien ausgeführt.

Never (Nie) Die Aktion wird nie ausgeführt.

Visualize ZFS
snapshots
timeline
(Timeline
der ZFS-
Schnappschüsse
visualisieren)

Hier wird angegeben, ob Sie alte Schnappschüsse im Dateimanagerfenster eines Ordners mithilfe
des Menüeintrags "View -> Restore" (Ansicht -> Wiederherstellen) anzeigen können.

Um Ihre Vorschaueinstellungen festzulegen, wählen Sie "Edit -> Preferences" (Bearbeiten ->
Einstellungen). Klicken Sie auf die Registerkarte "Preview (Vorschau)".

In der folgenden Tabelle sind alle veränderbaren Vorschaueinstellungen aufgeführt.

TABELLE 8-11 Vorschaueinstellungen

Dialogfeldelement Beschreibung

Show text in icons (Text
in Symbolen anzeigen)

Gibt an, wann der Inhalt von Textdateien im Symbol, das die Datei darstellt, in einer
Vorschau angezeigt werden soll.

Show thumbnails
(Miniatur-
Vorschaubilder
anzeigen)

Hier wird angegeben, wann Miniaturvorschaubilder von Bilddateien angezeigt werden
sollen. Der Dateimanager speichert die Miniaturvorschaubilddateien für jeden Ordner im
Verzeichnis .thumbnails des persönlichen Ordners des Benutzers.

Only for files smaller
than (Nur für Dateien
kleiner als)

Geben Sie die maximale Größe einer Datei an, für die der Dateimanager ein
Miniaturvorschaubild erstellen soll.
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Dialogfeldelement Beschreibung

Preview sound files
(Vorschau für Sound-
Dateien)

Hier wird angegeben, wann eine Vorschau von Sound-Dateien angezeigt werden soll.

Count number of items
(Anzahl der Objekte)

Hier wird angegeben, wann die Anzahl von Objekten in Ordnern angezeigt werden
soll. In der Symbolansicht müssen Sie möglicherweise eine höhere Vergrößerungsstufe
wählen, um die Anzahl der Objekte in jedem Ordner anzuzeigen.

Datenträger

Sie können einstellen, wie der Dateimanager mit Wechseldatenträgern und Geräten umgehen
soll, die mit Ihrem Computer verbunden sind, z.B. Musikabspielgeräte oder Kameras. Im
Dateimanager ist zu jedem Datenträgerformat und Gerätetyp eine Anwendung mit der
entsprechenden Unterstützung sowie den folgenden Optionen vorhanden.

Option Beschreibung

Ask what to do (Nachfragen) Die gewünschte Aktion wird angefordert, wenn der Datenträger oder das Gerät
angezeigt wird.

Do Nothing (Nichts tun) Es wird nichts bewirkt.

Open Folder (Ordner öffnen) Der Datenträger oder das Gerät wird wie ein normaler Ordner in einem
Dateimanagerfenster geöffnet.

Open with other Application
(Mit anderer Anwendung
öffnen)

Der Anwendungsauswahldialog des Dateimanagers wird angezeigt, in dem Sie
eine Anwendung auswählen können, die ausgeführt werden soll. Beachten Sie,
dass Anwendungen, die bekanntermaßen für den Datenträger oder das Gerät
geeignet sind, direkt aus der Aufklappliste ausgewählt werden können.

Die am häufigsten vorkommenden Datenträgerformate können im Abschnitt "Media
Handling (Handhabung von Datenträgern)" konfiguriert werden: Audio-CDs, Video-DVDs,
Musikabspielgeräte, Kameras und Software-CDs.

Um die Handhabung anderer Datenträgerformate zu konfigurieren, wählen Sie zuerst das
Format in der Aufklappliste "Type (Typ)" und dann die gewünschte Handhabung aus der
Aufklappliste "Action (Aktion)"aus.

In der folgenden Tabelle finden Sie weitere Einstellungen zur Handhabung von Datenträgern,
die Sie ändern können.

TABELLE 8-12 Datenträgereinstellungen

Dialogfeldelement Beschreibung

Never prompt or start programs on media insertion
(Beim Einlegen von Datenträgern keine Aktion
ausführen)

Der Dateimanager wird daran gehindert, Dialoge zu
öffnen oder Programme auszuführen, wenn Datenträger
oder Geräte angezeigt werden. Wenn Sie diese Option
auswählen, dann werden die Einstellungen zur
Handhabung bestimmter Datenträgerformate ignoriert.
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Dialogfeldelement Beschreibung

Browse media when inserted (Wechselmedien beim
Einlegen öffnen)

Wenn Sie einen Datenträger einlegen, wird ein Ordner im
Dateimanager automatisch geöffnet. Diese Einstellung
gilt nur für Datenträgerformate, deren Handhabung nicht
explizit konfiguriert wurde.

Dateimanager erweitern

Zum Erweitern des Dateimanagers haben Sie zwei Möglichkeiten: Durch
Dateimanagererweiterungen oder Skripte.

Skripte

Der Dateimanager kann Skripte in jeder auf dem Computer ausführbaren Skriptsprache
ausführen. Typisch für Skripte ist ihre im Gegensatz zu Dateimanagererweiterungen einfachere
Ausführung. Wählen Sie zum Ausführen eines Skripts "File -> Scripts" (Datei -> Skripte), und
wählen Sie dann aus dem Untermenü das Skript, das Sie ausführen möchten.

Um ein Skript für eine bestimmte Datei auszuführen, wählen Sie die Datei in der Ansichtsleiste
aus. Wählen Sie "File -> Scripts" (Datei -> Skripte) und dann aus dem Untermenü das Skript,
das Sie für die Datei ausführen möchten. Sie können auch mehrere Dateien auswählen, für die
das Skript ausgeführt werden soll. Auch über das Kontextmenü haben Sie Zugriff auf Skripte.

Anmerkung - Wenn Sie keine Skripte installiert haben, wird das Skriptmenü nicht angezeigt.

Dateimanagerskripte installieren

Der Dateimanager beinhaltet einen speziellen Ordner, in dem Sie Ihre Skripte speichern
können. Alle ausführbaren Dateien in diesem Ordner werden im Skriptmenü angezeigt. Sie
finden den Skriptordner unter $HOME/.gnome2/nautilus-scripts.

Um ein Skript zu installieren, kopieren Sie es in den Skriptordner, und weisen Sie dem Benutzer
Ausführungsrechte zu.

Um den Inhalt Ihres Skriptordners anzuzeigen, wählen Sie "File -> Scripts -> Open Scripts
Folder" (Datei -> Skripte -> Skriptordner öffnen). Wenn Sie noch keine Skripte installiert
haben, navigieren Sie mithilfe des Dateimanagers zum Skriptordner. Wenn Sie verborgene
Dateien anzeigen müssen, damit das Skript angezeigt wird, wählen Sie "View -> Show Hidden
Files" (Ansicht -> Verborgene Dateien anzeigen).
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Dateimanagerskripte schreiben

Wenn ein Skript in einem lokalen Ordner ausgeführt wird, dann wird es auf die gewählten
Dateinamen angewendet. Wenn ein Skript in einem Remote-Ordner ausgeführt wird, dann
akzeptiert es keine Parameter.

In der folgenden Tabelle sind im Skript anwendbare Variablen aufgeführt.

Umgebungsvariable Beschreibung

NAUTILUS_SCRIPT_SELECTED_FILE_PATHS Newline-delimited paths for selected files (Durch
Zeilenvorlauf getrennte Adressen der ausgewählten
Dateien) (nur wenn lokal)

NAUTILUS_SCRIPT_SELECTED_URIS Newline-delimited URIs for selected files (Durch
Zeilenvorlauf getrennte Adressen der ausgewählten
Dateien)

NAUTILUS_SCRIPT_CURRENT_URI URI for current location (Adresse des aktuellen Ortes)

NAUTILUS_SCRIPT_WINDOW_GEOMETRY Position and size of current window (Position und Größe
des aktuellen Fensters)

Erweiterungen

Der Systemadministrator installiert die Dateimanagererweiterungen.

Häufig verwendete Dateimanagererweiterungen:

■ nautilus-actions – Diese Erweiterung ermöglicht Ihnen die einfache Zuweisung von
dateitypbasierten Aktionen.

■ nautilus-send-to – Sie können eine Datei oder einen Ordner auf einfache Weise an
jemanden per E-Mail, Sofortnachricht oder Bluetooth senden.

■ nautilus-open-terminal – Sie können mithilfe dieser Erweiterung ein Terminal am
ausgewählten Startort auf einfache Weise öffnen.

Anmerkung - Sie müssen die Erweiterung nautilus-open-terminal installieren, um den
Befehl Open Terminal verwenden zu können.
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Desktoptools und -dienstprogramme verwenden

In diesem Kapitel werden einige Tools und Dienstprogramme auf dem Oracle Solaris-Desktop
beschrieben. In diesem Kapitel sind die folgenden Informationen enthalten:

■ „Ausführen von Anwendungen“ [119]
■ „Bildschirmfotos aufnehmen“ [120]
■ „Überblick über den Yelp-Hilfebrowser“ [121]

Ausführen von Anwendungen

Über den Dialog "Anwendung ausführen" können Sie auf die Befehlszeile zugreifen. Beachten
Sie, dass beim Ausführen eines Befehls im Dialog "Anwendung ausführen" nichts ausgegeben
wird.

So führen Sie eine Anwendung von der
Befehlszeile aus aus

1. Folgende Möglichkeiten stehen Ihnen beim Öffnen des Dialogs "Anwendung
ausführen" zur Verfügung:

■ Drücken Sie Meta+R bzw. ALT+F2.
Sie können die Tastenkombinationen ändern, die im Dialog "Run Application (Anwendung
ausführen)" des Einstellungstools "Keyboard Shortcuts (Tastaturkurzbefehle)" angezeigt
werden.

■ Klicken Sie auf den Knopf "Run Application (Anwendung ausführen)",
sofern Sie diese einem Panel hinzugefügt haben.

Der Dialog "Run Application (Anwendung ausführen)" wird angezeigt.

2. Geben Sie den Befehl ein, den Sie ausführen möchten, oder wählen Sie eine
Anwendung aus der Liste bekannter Anwendungen aus.
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Wenn Sie nur den Speicherort einer Datei eingeben, wird eine für das Öffnen der Datei
geeignete Anwendung gestartet. Wenn Sie eine Webseitenadresse eingeben, wird die Seite vom
Standardwebbrowser geöffnet. Geben Sie vor der Webseitenadresse http:// ein. Beispiel:
http://www.oracle.com.

Wählen Sie einen Befehl, den Sie zuvor ausgeführt haben, klicken Sie auf den Pfeil nach
unten neben dem Befehlsfeld, und wählen Sie dann den Befehl aus. Sie können auch mithilfe
des Knopfes "Run with File (Datei anhängen)" eine Datei auswählen und der Befehlszeile
hinzufügen. Beispiel: Sie geben den Befehl emacs ein, und wählen dann eine Datei zum
Bearbeiten aus.

3. (Optional) Wählen Sie die Option "Im Terminal ausführen", um die Anwendung
oder den Befehl in einem Terminalfenster auszuführen.
Wählen Sie diese Option, wenn eine Anwendung oder ein Befehl kein Fenster für den
Ausführungsvorgang erzeugt.

4. Klicken Sie im Dialog "Anwendung ausführen" auf "Ausführen".

Bildschirmfotos aufnehmen

Zum Aufnehmen von Bildschirmfotos haben Sie folgende Möglichkeiten:

■ Klicken Sie zum Erstellen eines Screenshots des gesamten Bildschirms auf den Knopf
"Take Screenshot (Bildschirmfoto aufnehmen)", sofern Sie diese einem Panel hinzugefügt
haben.

■ Verwenden Sie eine der folgenden Tastenkombinationen:
■ Druck – Erstellt ein Foto des ganzen Bildschirms.
■ Alt+Druck – Erstellt ein Foto des aktiven Fensters.

Mit dem Einstellungstool "Keyboard Shortcuts (Tastaturkurzbefehle)" können Sie die
vorgegebenen Tastenkombinationen ändern.

■ Wählen Sie aus der Menüleiste "Applications -> Accessories -> Take
Screenshot" (Anwendungen -> Werkzeuge -> Bildschirmfoto aufnehmen).

■ Geben Sie in einem Terminalfenster den Befehl gnome-screenshot ein. Der Befehl gnome-
screenshot nimmt ein Foto des gesamten Bildschirms auf und öffnet den Dialog "Save
Screenshot (Bildschirmfoto speichern)", sodass Sie das Bildschirmfoto speichern können.

Für den Befehl gnome-screenshot stehen Ihnen außerdem die folgenden Optionen zur
Verfügung:

Option Funktion

-window Nimmt ein Foto des aktiven Fensters auf.

http://www.oracle.com


Überblick über den Yelp-Hilfebrowser

Kapitel 9. Desktoptools und -dienstprogramme verwenden 121

Option Funktion

-delay=seconds Nimmt nach der angegebenen Anzahl an Sekunden ein
Bildschirmfoto auf und zeigt den Dialog "Save Screenshot
(Bildschirmfoto speichern)" an. Verwenden Sie den Dialog
"Bildschirmfoto speichern", um das Bildschirmfoto zu speichern.

-include-border-- Nimmt ein Foto des aktiven Fensters einschließlich des
Fensterrahmens auf.

-remove-border-- Nimmt ein Foto des aktiven Fensters ohne den Fensterrahmen auf.

-border-effect=shadow-- Nimmt ein Bildschirmfoto mit einem umlaufenden Schatteneffekt
auf.

-border-effect=border-- Nimmt ein Bildschirmfoto mit einem umlaufenden Rahmen auf.

-interactive-- Öffnet ein Fenster, in dem Sie vor der Aufnahme des Bildschirmfotos
einige Einstellungen vornehmen können.

-help Zeigt die Optionen für den Befehl an.

Um ein Bildschirmfoto als Bilddatei zu speichern, geben Sie den Dateinamen ein, wählen
einen Ort aus der Aufklappliste aus, und klicken auf "Speichern". Sie können auch "In die
Zwischenablage kopieren" anklicken, um das Bild in die Zwischenablage zu kopieren oder von
dort aus durch Ziehen und Ablegen in eine andere Anwendung zu kopieren.

Überblick über den Yelp-Hilfebrowser

Der Yelp-Hilfebrowser ermöglicht Ihnen, die Dokumentation zu GNOME und anderer
Komponenten in einer Vielzahl von Formaten anzuzeigen. Zu diesen Formaten gehören
docbook-Dateien, HTML-Hilfeseiten, Manpages und Infoseiten (die Unterstützung für
Manpages und Infoseiten muss optional bei der Kompilierung von Yelp angegeben werden).
Mit Yelp soll, unabhängig vom zugrunde liegenden Dokumentformat, eine einheitliche Ansicht
erreicht werden.

Da der Yelp-Hilfebrowser internationalisiert ist, können Dokumente in verschiedenen
Sprachen angezeigt werden. Die Dokumente müssen zunächst lokalisiert bzw. übersetzt und so
abgespeichert werden, dass der Yelp-Hilfebrowser sie anzeigen kann.

Zum Starten des Yelp-Hilfebrowser haben Sie folgende Möglichkeiten:

■ Wählen Sie "System -> Hilfe".
■ Geben Sie in die Befehlszeile yelp ein.

Benutzeroberfläche des Yelp-Hilfebrowsers

In der Verwaltungsleiste wird das Inhaltsverzeichnis oder die Dokumentation angezeigt.
Navigieren Sie mithilfe des Inhaltsverzeichnisses zur gewünschten Dokumentation.
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Der Yelp-Hilfebrowser enthält die in folgender Tabelle beschriebenen Elemente.

Menüleiste

Datei Verwenden Sie dieses Menü, um ein neues Fenster zu öffnen, die
Seite "About this Document (Informationen über dieses Dokument)"
anzuzeigen, das aktuelle Dokument zu drucken oder das Fenster zu
schließen.

Bearbeiten Verwenden sie dieses Menü zum Kopieren, Auswählen, Suchen oder zum
Festlegen von Einstellungen.

Gehe zu Verwenden Sie dieses Menü, um durch die Hilfethemenseiten zu
navigieren. Wenn Sie ein docbook-Dokument betrachten, können Sie auf
diese Weise zum nächsten Abschnitt, zum vorherigen Abschnitt oder zum
Inhaltsverzeichnis springen.

Lesezeichen Verwenden Sie dieses Menü, um Lesezeichen hinzuzufügen oder diese zu
bearbeiten.

Hilfe Zeigen Sie die Informationen zum Yelp-Hilfebrowser und den
Mitwirkenden am Projekt über den Menüeintrag "About (Info)" an.
Rufen Sie dieses Dokument über den Menüeintrag "Contents (Inhalt)"
oder durch Drücken von F1 auf.

Werkzeugleiste

Zurück Navigieren Sie in der Dokumentenhistorie zurück.

Vor Navigieren Sie in der Dokumentenhistorie nach vorne.

Persönlicher
Ordner

Sie kehren zum Hauptinhaltsverzeichnis zurück.

Suchen Durchsuchen Sie alle Desktop-Hilfedokumente nach einem bestimmten
Wort oder Ausdruck.

Mit Yelp arbeiten

Sie können mit Yelp folgende Aktionen durchführen:

■ Dokumente öffnen
■ Dokumente suchen
■ Seite "About this Document (Informationen über dieses Dokument)" eines Dokuments

anzeigen
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■ Seite oder Dokument drucken
■ Legen Sie Einstellungen fest, um mit den Dokumenten zu arbeiten
■ Lesezeichen hinzufügen und bearbeiten

So öffnen Sie ein Dokument über die GUI

Sie haben zum Öffnen eines Dokuments über den Yelp-Hilfebrowser folgende
Möglichkeiten:

■ Wählen Sie in einer Anwendung "Hilfe -> Inhalt", und rufen Sie das
gewünschte Dokument über das Inhaltsverzeichnis auf.

■ Ziehen Sie eine DocBook-XML-Datei vom Dateimanager in das Yelp-Fenster
oder den Anwendungsstarter.

■ Drücken Sie F1.

Tipp - Um das aktuell geöffnete DocBook-Dokument zu aktualisieren, drücken Sie STRG+R.
Mithilfe dieser Tastenkombination können Sie Änderungen an Dokumenten sofort anzeigen.

Nach Dokumenten suchen

In diesem Abschnitt wird die Suche nach Dokumenten beschrieben.

So suchen Sie auf einer aktuellen Seite

1. Wählen Sie "Edit -> Find (Bearbeiten -> Suchen)", oder drücken Sie Strg+F.
Die Suchleiste wird unten im Fenster angezeigt.

2. Geben Sie in der Suchleiste im Suchfeld das Wort oder den Ausdruck ein, nach
dem Sie suchen möchten, und drücken Sie dann die Eingabetaste.
Wenn das Wort oder der Ausdruck auf der Seite gefunden wurde, wird der erste Treffer
hervorgehoben. Drücken Sie die Eingabetaste erneut, um den nächsten Treffer hervorzuheben.

3. (Optional) Klicken Sie zum Schließen der Suchleiste auf "Schließen".

So suchen Sie nach indizierten Dokumenten

1. Klicken Sie in der Werkzeugleiste auf das Suchfeld, oder drücken Sie ALT+S.
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2. Geben Sie das Wort oder den Ausdruck ein, nach dem Sie suchen möchten, und
drücken Sie dann die EINGABETASTE.
Eine Liste aller Dokumente, in denen das Wort oder der Ausdruck gefunden wurde, wird
angezeigt.

3. Klicken Sie auf den Dokumentnamen, um eine entsprechende Seite anzuzeigen.
Nachdem eine entsprechende Seite angezeigt wurde, klicken Sie in der Werkzeugleiste auf den
Knopf "Back (Zurück)", um zur Liste mit den Suchergebnissen zurückzukehren.

So öffnen Sie ein neues Fenster

1. Klicken Sie auf "File -> New Window" (Datei -> Neues Fenster).

2. Drücken Sie STRG+N.

So zeigen Sie Informationen zu einem DocBook-Dokument an

Diese Option ist nur für die DocBook-Dokumentation verfügbar. Rechtliche Hinweise und
Mitwirkende an der Dokumentation werden in diesem Abschnitt aufgeführt.

Wählen Sie "File -> About This Document" (Datei -> Informationen über dieses
Dokument), um Informationen zu dem aktuell geöffneten Dokument anzuzeigen.

So drucken Sie die aktuelle Seite

Wählen Sie "File -> Print this Page" (Datei -> Diese Seite drucken), um die gerade
angezeigte Seite zu drucken.

So drucken Sie ein DocBook-Dokument

Diese Option ist nur für die DocBook-Dokumentation verfügbar.

Wählen Sie "File -> Print this Document" (Datei -> Dieses Dokument drucken),
um das gesamte Dokument zu drucken.

So schließen Sie ein Fenster

Ihnen stehen zum Schließen eines Fensters folgende Möglichkeiten zur
Verfügung:
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■ Wählen Sie "File -> Close Window" (Datei -> Fenster schließen).

■ Drücken Sie STRG+W.

So legen Sie Einstellungen fest

Wählen Sie "Edit -> Preferences" (Bearbeiten -> Einstellungen).
Die folgenden Optionen sind im Dialog "Einstellungen" verfügbar:

■ Use system fonts (Systemschriften verwenden) – Zeigt die Dokumentation mithilfe der
Standardschriften des Oracle Solaris-Desktops an. Um eigene Schriften für die Anzeige von
Dokumentation auszuwählen, deaktivieren Sie die Option, und klicken Sie auf den Knopf
"Variable Width (Variable Breite)" bzw. "Fixed Width (Feste Breite)".

■ Variable Breite – Wählen Sie diese Schrift, wenn eine Schrift mit statischer oder fester
Breite nicht notwendig ist.

■ Feste Breite – Wählen Sie diese Schrift, wenn alle Zeichen gleich groß sein müssen. Eine
solche Schrift wird zur Kennzeichnung von Befehlen, Programmcodeblöcken oder anderen
Texten verwendet, die unter diese Kategorien fallen.

■ Mit Textcursor navigieren – Wählen Sie diese Option, wenn Sie einen Cursor im Dokument
anzeigen lassen möchten, während Sie das Dokument durchsuchen.

So fügen Sie ein Lesezeichen hinzu

1. Wählen Sie "Bookmarks -> Add Bookmark" (Lesezeichen -> Lesezeichen
hinzufügen), oder drücken Sie STRG+D.
Das Fenster "Add Bookmark (Lesezeichen hinzufügen)" wird angezeigt.

2. Geben Sie den gewünschten Lesezeichentitel im Feld "Titel" ein.

3. Klicken Sie auf "Hinzufügen", um das Lesezeichen hinzuzufügen.

So bearbeiten Sie Lesezeichen

1. Wählen Sie "Bookmarks -> Edit Bookmarks" (Lesezeichen -> Lesezeichen
bearbeiten), oder drücken Sie STRG+B.
Das Fenster "Bookmarks (Lesezeichen)" wird angezeigt. Es umfasst die folgenden Optionen:

■ Öffnen – Das ausgewählte Lesezeichen wird in einem neuen Fenster angezeigt.
■ Umbenennen – Ändert den Titel eines Lesezeichens.
■ Entfernen – Entfernt das Lesezeichen aus der Sammlung.
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2. Klicken Sie auf "Schließen", um das Lesezeichenfenster zu schließen.

So zeigen Sie die Hilfe an

Wählen Sie "Help -> Contents" (Hilfe -> Inhalte), um die Onlinehilfe zum Yelp-
Hilfebrowser anzuzeigen.

Durch den Yelp-Hilfebrowser navigieren

Sie können durch den Yelp-Hilfebrowser wie folgt navigieren:

■ So navigieren Sie in der Dokumentenhistorie zurück
■ Wählen Sie "Go -> Back" (Gehe zu -> Zurück).
■ Drücken Sie Alt+Pfeiltaste nach links.
■ Verwenden Sie den Knopf "Back (Zurück)" in der Werkzeugleiste.

■ So navigieren Sie in der Dokumentenhistorie nach vorne
■ Wählen Sie "Go -> Forward" (Gehe zu -> Vor).
■ Drücken Sie Alt+Pfeiltaste nach rechts.
■ Verwenden Sie den Knopf "Forward (Vorwärts)" in der Werkzeugleiste.

■ So navigieren Sie zu den Hilfethemen
■ Wählen Sie "Go -> Help Topics" (Gehe zu -> Hilfethemen).
■ Drücken Sie ALT+POS1.
■ Verwenden Sie den Knopf "Help Topics (Hilfe-Themen)" in der Werkzeugleiste.

■ So gehen Sie zum vorherigen Abschnitt
■ Wählen Sie "Go -> Previous Section" (Gehe zu -> Vorheriger Abschnitt).
■ Drücken Sie ALT+BILD-AUF-TASTE.

■ So gehen Sie zum nächsten Abschnitt
■ Wählen Sie "Go -> Next Section" (Gehe zu -> Nächster Abschnitt).
■ Drücken Sie ALT+BILD-AB-TASTE.

Dokumente von der Befehlszeile aus öffnen

Der Yelp-Hilfebrowser unterstützt das Öffnen von Dokumenten von der Befehlszeile aus. Unter
anderem können folgende URIs (Uniform Resource Identifiers) verwendet werden:

-file: Greift über Yelp auf eine Datei zu. Beispiel:

yelp file:///usr/share/gnome/help/gcalctool/C/gcalctool.xml
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-ghelp: oder
-gnome-help:

Greift auf GNOME-Hilfedokumente mit DocBook-Format zu.

yelp ghelp:gcalctool

Wenn Sie das Hilfedokument in einem bestimmten Abschnitt öffnen
möchten, fügen Sie ein Fragezeichen am Ende des URI hinzu, und dann
die Abschnitts-ID.

yelp ghelp:user-guide?yelp-advanced-cmdline

-man: Greift auf eine bestimmte Manpage zu. Wenn mehrere Manpages mit
demselben Namen vorhanden sind, können Sie den Manpage-Abschnitt
anhängen, den Sie anzeigen möchten. Die Abschnittsnummer muss in
Klammern eingeschlossen werden, um das Argument auszuschließen,
sodass die Shell die Klammer nicht interpretiert.

yelp man:gcalctool

oder

yelp 'man:intro(1)'

yelp 'man:intro(2)'

-info: Greift auf die angegebene GNU-Infoseite zu.

yelp info:make
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Anpassen des Desktops

Dieses Kapitel erläutert die Verwendung des Einstellungstools zur benutzerdefinierten
Anpassung des Oracle Solaris-Desktops. In diesem Kapitel sind die folgenden Informationen
enthalten:

■ „Einstellungstools“ [129]
■ „Einstellungen zur Darstellung“ [133]
■ „Internet- und Netzwerkeinstellungen festlegen“ [144]
■ „Tastatureinstellungen festlegen“ [147]
■ „Hardwareeinstellungen festlegen“ [155]
■ „Sitzungseinstellungen festlegen“ [159]

Einstellungstools

Ein Einstellungstool ermöglicht es Ihnen, die Einstellungen für den Oracle Solaris-Desktop
zu verändern. Jedes Einstellungstool behandelt einen bestimmten Aspekt Ihres Computers.
Beispielsweise können Sie mit dem Einstellungstool der Maus die Maus von rechtshändigem
auf linkshändigen Gebrauch umstellen oder die Geschwindigkeit des Mauszeigers auf
dem Bildschirm ändern. Mit dem Fenstereinstellungstool ändern Sie das allgemeine
Fensterverhalten, so zum Beispiel auf welche Art Sie mit der Maus ein Fenster auswählen.

Sie öffnen ein Einstellungstool, indem Sie im oberen Fensterbereich "System ->
Preferences" (System -> Einstellungen) wählen. Wählen Sie das Tool aus dem Untermenü.

Bis auf wenige Ausnahmen werden die mit Einstellungstools vorgenommenen
Einstellungsänderungen unmittelbar angewendet, ohne dass Sie das Einstellungstool zuvor
schließen müssen. Sie können das Fenster des Einstellungstools offen halten, während Sie die
Änderungen ausprobieren, und dann nach Ihren Wünschen weitere Änderungen vornehmen.

Einige Anwendungen oder Systemkomponenten fügen Ihre eigenen Einstellungstools zum
Menü hinzu.
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Anmerkung - Einige Einstellungstools erlauben Ihnen, grundlegende Teile Ihres Systems zu
verändern, und erfordern daher Administratorrechte. Wenn Sie ein Einstellungstool öffnen,
werden Sie in einem Dialogfeld nach Ihrem Passwort gefragt. Diese Tools befinden sich
im Untermenü "System -> Administration" (System -> Verwaltung). Dieses Menü enthält
außerdem auch komplexere Dienstprogramme für das Verwalten und Aktualisieren Ihres
Systems.

Dieser Abschnitt beschreibt die Einstellungen, die Sie vornehmen können. Die Einstellungen
beinhalten:

■ Einstellungen für Hilfstechnologien
■ Einstellungen der Tastenkombinationen
■ Einstellungen bevorzugter Anwendungen

Hilfstechnologien
Das Einstellungstool für Hilfstechnologien aktiviert Hilfstechnologien auf dem Oracle Solaris-
Desktop. Das Einstellungstool für Hilfstechnologien können Sie ebenfalls einsetzen, um andere
Einstellungstools zu starten, die auf Hilfstechnologien bezogene Einstellmöglichkeiten bieten.

■ Unter "Preferred Applications (Bevorzugte Anwendungen)" können Sie festlegen, welche
Hilfstechnologieanwendungen bei Ihrer Anmeldung automatisch gestartet werden sollen.
Weitere Informationen erhalten Sie unter „Bevorzugte Anwendungen“ [132].

■ Unter "Keyboard Accessibility (Tastatur-Barrierefreiheit)" können Sie
Barrierefreiheitsfunktionen der Tastatur wie "sticky keys (klebrige Tasten)", "slow keys
(Tastenverzögerungen)" und "bounce keys (springende Tasten)" einstellen. Weitere
Informationen erhalten Sie unter „Barrierefreiheit“ [151].

■ Unter "Mouse Accessibility (Maus-Barrierefreiheit)" können Sie die
Barrierefreiheitsfunktionen der Maus wie verzögertes Klicken einstellen. Weitere
Informationen erhalten Sie unter „Barrierefreiheitseinstellungen der Maus“ [163].

Wählen Sie "Enable Assistive Technologies (Hilfstechnologien aktivieren)", um
Hilfstechnologien auf dem Oracle Solaris-Desktop zu aktivieren. Nachdem diese Option
aktiviert wurde, melden Sie sich ab und anschließend wieder an, damit die Option wirksam
werden kann.

Tastenkombinationen
Verwenden Sie das Einstellungstool für Tastenkombinationen, um benutzerdefinierte
Anpassungen an den standardmäßigen Tastenkombinationen vorzunehmen.

Eine Tastenkombination ist eine Taste oder eine Kombination mehrer Tasten, die eine
Alternative zur Standardvorgehensweise für eine Aktion darstellt. Weitere Informationen zu
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Tastenkombinationen sowie eine Liste der Standardtastenkombinationen, die auf dem Oracle
Solaris-Desktop verwendet werden, erhalten Sie unter Anhang B, Bedienung der Tastatur.

Die Tastenkombinationen wurden wie folgt eingeteilt:

■ Desktop (Arbeitsfläche) – Dies sind Tastenkombinationen für Aufgaben, die sich auf den
gesamten Desktop beziehen. Dazu gehören das Abmelden, die Bildschirmsperre, das Öffnen
der Panel-Menüleiste oder das Starten eines Webbrowsers.

■ Sound (Audio) – Tastenkombinationen für die Steuerung der Systemlautstärke und der
Lautstärke Ihres Musikabspielers.

■ Window Management (Fensterverwaltung) – Tastenkombinationen für die Arbeit mit
Fenstern und Arbeitsflächen, z.B. zum Maximieren oder Verschieben des aktuellen Fensters
sowie der Wechsel zu einer anderen Arbeitsfläche. Weitere Informationen zu dieser Art
von Aktionen erhalten Sie unter „Mit Fenstern arbeiten“ [20] und „Überblick über die
Arbeitsflächen“ [25].

■ Accessibility (Barrierefreiheit) – Tastenkombinationen zum Starten von Hilfstechnologien
wie Bildschirmleser, Lupe oder Bildschirmtastatur.

■ Custom Shortcuts (Eigene Tastenkombinationen) – Tastenkombinationen, die Sie über
die Schaltfläche "Add (Hinzufügen)" hinzugefügt haben. Dieser Abschnitt wird nur dann
angezeigt, wenn tatsächlich eigene Tastenkombinationen vorhanden sind.

So fügen Sie eine eigene Tastenkombination hinzu

1. Wählen Sie "System -> Preferences -> Keyboard Shortcuts" (System ->
Einstellungen -> Tastenkombinationen).

2. Klicken Sie im Aktionsbereich auf die Schaltfläche "Add (Hinzufügen)".

3. Geben Sie einen Namen und einen Befehl für die neue Tastenkombination ein.
Die neue eigene Tastenkombination erscheint in der Liste und kann auf die gleiche Weise wie
die voreingestellten Tastenkombinationen bearbeitet werden.

Anmerkung - Verwenden Sie zum Entfernen einer eigenen Tastenkombination die Schaltfläche
"Remove (Entfernen)".

So bearbeiten Sie eine Tastenkombination

1. Wählen Sie "System -> Preferences -> Keyboard Shortcuts" (System ->
Einstellungen -> Tastenkombinationen).

2. Klicken Sie auf die Aktion in der Liste oder verwenden Sie die Pfeiltasten für die
Auswahl der Tastenkombination. Betätigen Sie dann die Eingabetaste.
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3. Drücken Sie nun die neue Taste oder Tastenkombination, die Sie der Aktion
zuweisen möchten.
Um eine Tastenkombination zu löschen, drücken Sie die Rücktaste. Die Aktion ist nun als
"Disabled (Deaktiviert)" gekennzeichnet.

Anmerkung - Um die Zuweisung einer Tastenkombination abzubrechen, klicken Sie auf eine
beliebige Stelle im Fenster oder betätigen Sie die Taste Esc.

Bevorzugte Anwendungen

Verwenden Sie das Einstellungstool "Preferred Applications (Bevorzugte Anwendungen)", um
die Anwendungen anzugeben, die für den Start einer Anwendung durch den Oracle Solaris-
Desktop verwendet werden sollen. So können Sie beispielsweise einen Webbrowser (Epiphany,
Mozilla Firefox oder Opera) starten, wenn Sie auf eine Verknüpfung in anderen Anwendungen
wie etwa E-Mail- oder Dokumentenbetrachtern klicken.

Zugang zu diesem Einstellungstool erhalten Sie unter "System -> Preferences -> Preferred
Applications" (System -> Einstellungen -> Bevorzugte Anwendungen).

Sie können benutzerdefinierte Veränderungen an den Einstellungen des Einstellungstools für
bevorzugten Anwendungen in den nachfolgenden Funktionsbereichen vornehmen:

■ Internet (Web, E-Mail)
■ Multimedia (Audio- und Videoplayer)
■ System (Terminal)
■ Barrierefreiheit (Visuell, Mobillität)

Für jede Kategorie bevorzugter Anwendungen wird in einem Dropdown-Menü eine Liste
möglicher Anwendungen angezeigt, aus denen Sie wählen können. Der Inhalt dieser Liste hängt
davon ab, welche Anwendungen auf Ihrem Computer installiert sind.

In jeder der Kategorien können Sie mit dem letzten Menüeintrag (Benutzerdefiniert) den Befehl
einstellen, der vom System ausgeführt wird, wenn die spezifische Startaktion ausgeführt wird.
Die nachfolgende Tabelle fasst die verschiedenen Optionen zusammen, die Sie wählen können,
wenn Sie "Custom (Benutzerdefiniert)" wählen.

TABELLE 10-1 Benutzerdefinierte Befehlszeilenoptionen

Dialogfeldelement Beschreibung

Befehl Geben Sie den zum Starten der benutzerdefinierten Anwendung erforderlichen
Befehl ein. Bei einem Webbrowser und einem E-Mail-Betrachter können Sie ein
%s nach dem Befehl verwenden, um der Anwendung mitzuteilen, dass sie die
von Ihnen angeklickte Adresse oder E-Mail-Adresse öffnen soll. Die genauen
Befehlszeilenargumente hängen von der jeweiligen Anwendung ab.



Einstellungen zur Darstellung

Kapitel 10. Anpassen des Desktops 133

Dialogfeldelement Beschreibung

Run in terminal (Im Terminal
ausführen)

Wählen Sie diese Option, um den Befehl im Terminalfenster auszuführen. Diese
Option eignet sich für eine Anwendung, die kein Fenster für die Ausführung
erstellt.

Option "Execute
(Ausführen)" (nur Terminal)

Die meisten Terminalanwendungen verfügen über eine Option, die bewirkt,
dass die verbleibenden Befehlszeilenoptionen als ausführbare Befehle betrachtet
werden (-x für Terminal). Geben Sie diese Option hier ein. Beispiel: Diese
Einstellung wird verwendet, wenn ein Befehl eines Starters ausgeführt wird, für
den der Typ "Application in Terminal (Anwendung im Terminal)" gewählt wurde.

Run at start (Beim Starten
ausführen) (nur Barrierefreiheit)

Wählen Sie diese Option, wenn Sie diesen Befehl direkt nach dem Start Ihrer
Sitzung ausführen wollen. Weitere Barrierefreiheitsoptionen finden Sie unter
„Oracle Solaris 11 Desktop Accessibility Guide “.

Einstellungen zur Darstellung
Dieser Abschnitt erläutert die Verwendung des Erscheinungsbildeinstellungstools zur
Konfiguration des Desktops.

Erscheinungsbild
Das Erscheinungsbildseinstellungstool erlaubt Ihnen die Konfiguration mehrerer Aspekte des
Desktops:

■ Thema
■ Arbeitsflächenhintergrund
■ Schriftarten
■ Visuelle Effekte

Themeneinstellungen

Ein Thema ist eine Gruppe koordinierter Einstellungen, die das visuelle Erscheinungsbild
eines Teils des Oracle Solaris-Desktops bestimmt. Wählen Sie zwischen Themen, um das
Erscheinungsbild des Oracle Solaris-Desktops zu ändern. Verwenden Sie die Registerkarte
"Theme (Thema)", um ein Thema auszuwählen. Sie können aus einer Liste der verfügbaren
Themen wählen. Die Liste der verfügbaren Themen enthält auch mehrere Themen für Benutzer
mit Barrierefreiheitserfordernissen.

Ein Thema beinhaltet Einstellungen in der Registerkarte "Customize Theme (Thema
anpassen)", die folgende Auswirkungen auf verschiedene Teile des Oracle Solaris-Desktops
haben:

■ Controls (Fensterinhalt) – Mithilfe der Einstellung auf der Registerkarte "Controls
(Fensterinhalt)" wird das Aussehen von Fenstern, Panels und Applets bestimmt. Die

http://www.oracle.com/pls/topic/lookup?ctx=dsc&id=/app/docs/doc/E54036
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Einstellung des Fensterinhalts bestimmt auch das visuelle Erscheinungsbild von Elementen
der Benutzeroberfläche, die in Fenstern, Panels und Applets erscheinen, wie zum Beispiel
Menüs, Symbole und Schaltflächen. Einige der verfügbaren Einstellungsoptionen des
Fensterinhalts wurden für spezielle Erfordernisse der Barrierefreiheit entworfen. Im
Fenster "Customize Theme (Thema anpassen)" können Sie auf der Registerkarte "Controls
(Fensterinhalt)" eine Option für die Einstellung des Fensterinhalts auswählen.

■ Colors (Farben) – Durch die Farbeinstellung für ein Thema auf der Registerkarte "Colors
(Farben)" wird die Farbe verschiedener Benutzeroberflächenelemente bestimmt.

Anmerkung - Es ist vorteilhaft, gut voneinander abhebende Farben zu verwenden, da Text
anderenfalls nur schwer zu lesen sein könnte.

■ Window frame (Fensterrahmen) – Durch die Fenterrahmeneinstellung auf der Registerkarte
"Window Border (Fenterrahmen)" wird lediglich das Aussehen der Rahmen rund um die
Fenster festgelegt.

■ Symbole – Die Symboleinstellung in der Registerkarte "Icon (Symbol)" bestimmt das
Erscheinunbgsbild der Symbole in den Panels und dem Desktophintergrund.

■ "Pointer (Zeiger)" - Die Zeigereinstellung in der Registerkarte "Pointer (Zeiger)" bestimmt
Erscheinungsbild und Größe des Mauszeigers.

So erstellen Sie ein benutzerdefiniertes Thema

Die in der Registerkarte "Theme (Thema)" aufgelisteten Themen sind verschiedene
Kombinationen aus Fensterinhalten, Fensterrahmenoptionen und Symboloptionen. Sie können
ein benutzerdefiniertes Thema erzeugen, das verschiedene Kombinationen aus Fensterinhalten,
Fensterrahmenoptionen und Symboloptionen verwendet.

1. Wählen Sie "System -> Preferences -> Appearance" (System -> Einstellungen ->
Erscheinungsbild).
Öffnen Sie die Registerkarte "Theme (Thema)".

2. Wählen Sie ein Thema aus der Themenliste aus.

3. Klicken Sie auf "Customize" (Anpassen).
Der Dialog "Customize Theme (Thema anpassen)" wird angezeigt.

4. Wählen Sie die Optionen, die Sie im benutzerdefinierten Thema verwenden
möchten.
Weitere Informationen zu den Optionen erhalten Sie unter „Themeneinstellungen“ [133].

5. Klicken Sie auf "Close (Schließen)", um den Dialog "Customize Theme (Thema
anpassen)" zu schließen.
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6. Klicken Sie im Erscheinungsbildeinstellungstool auf "Save As (Speichern
unter)".
Der Dialog "Save Theme As (Thema speichern unter)" wird angezeigt.

7. Geben Sie im Dialog den Namen und eine Kurzbeschreibung des
benutzerdefinierten Themas ein und klicken Sie anschließend auf "Save
(Speichern)".
Das benutzerdefinierte Thema erscheint ab sofort in der Liste der verfügbaren Themen.

So installieren Sie ein neues Thema

Sie können ein Thema zur Liste der verfügbaren Themen hinzufügen. Das neue Thema muss
eine Archivdatei sein. Das bedeutet, dass die Datei eine .tar.gz-Datei sein muss.

1. Wählen Sie "System -> Preferences -> Appearance" (System -> Einstellungen ->
Erscheinungsbild).
Öffnen Sie die Registerkarte "Theme (Thema)".

2. Klicken Sie auf "Install" (Installieren).
Der Dialog "File Chooser (Dateiwähler)" wird angezeigt.

3. Geben Sie den Ort der Themenarchivdatei in das Adressfeld ein, oder wählen Sie
die Themenarchivdatei in der Liste aus. Klicken Sie auf "Open (Öffnen)".

4. Klicken Sie auf "Install (Installieren)", um das neue Thema zu installieren.

So entfernen Sie eine Themenoption

Sie können Optionen für Fensterinhalte, Fensterrahmen oder Symbole entfernen.

1. Wählen Sie "System -> Preferences -> Appearance" (System -> Einstellungen ->
Erscheinungsbild).
Öffnen Sie die Registerkarte "Theme (Thema)".

2. Klicken Sie auf "Customize" (Anpassen).
Der Dialog "Customize Theme (Thema anpassen)" wird angezeigt.

3. Klicken Sie auf die Registerkarte mit der Option, die sie entfernen wollen.

4. Wählen Sie die zu löschende Themenoption aus.

5. Klicken Sie auf "Delete (Löschen)", um die gewählte Option zu löschen.
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Anmerkung - Sie können systemweit installierte Themen nicht löschen.

Einstellungen für den Desktophintergrund

Der Desktophintergrund ist das Bild oder die Farbe, die auf dem Desktop angezeigt wird. Sie
können die Registerkarte "Background" (Hintergrund) im Erscheinungsbildeinstellungstool
öffnen, indem Sie mit der rechten Maustaste auf den Desktop klicken und "Desktop
Appearance" (Aussehen der Arbeitsoberfläche) wählen, oder im Menü "System ->
Preferences" (System -> Einstellungen).

Sie haben folgende Möglichkeiten, den Desktophintergrund anzupassen:

■ Wählen Sie ein Bild für den Desktophintergrund. Das Bild überlagert die Hintergrundfarbe
des Desktops. Die Hintergrundfarbe des Desktops sehen Sie, wenn Sie ein transparentes
Bild auswählen oder wenn das Bild nicht den gesamten Desktophintergrund ausfüllt.

■ Wählen Sie eine Farbe für den Desktophintergrund aus. Sie können eine durchgehende
Farbe auswählen oder einen Übergangseffekt aus zwei Farben erzeugen. Ein
Übergangseffekt ist ein visueller Effekt, bei dem eine Farbe allmählich in eine andere Farbe
übergeht.

Anmerkung - Sie können auch eine Farbe oder ein Muster aus dem Dialog "Backgrounds and
Emblems (Hintergründe und Embleme)" im Dateimanager auf den Desktop ziehen.

In der nachfolgenden Tabelle sind die Hintergrundeinstellungen enthalten, die von Ihnen
konfiguriert werden können.

TABELLE 10-2 Einstellungen für den Desktophintergrund

Dialogfeldelement Beschreibung

Arbeitsflächenhintergrund Bestimmt den Desktophintergrund. Wählen Sie ein Bild aus der Liste oder wählen
Sie die Schaltfläche "Add (Hinzufügen)", um ein beliebiges Bild auf Ihrem
Computer auszuwählen.

"Style (Stil)" Bestimmt, wie das Bild angezeigt werden soll:

■ "Centered (Zentrieren)" - Zeigt das Bild unter Erhaltung der Originalgröße in der
Mitte des Desktops an.

■ "Fill Screen (Bildschirm füllen)"– Vergrößert das Bild so weit, dass der gesamte
Desktop ausgefüllt ist. Die Seitenverhältnisse des Bildes werden dabei angepasst.

■ "Scaled (Skalieren)" - Vergrößert das Bild bis in die Bildschirmecken unter
Beibehaltung der Seitenverhältnisse des Bildes.

■ "Zoom (Zoom)" - Vergrößert das Bild in seinen Dimensionen bis es die
Bildschirmecken erreicht. Es kann passieren, dass das Bild in den neuen
Dimensionen abgeschnitten wird.

■ "Tiled (Kacheln)" - Dupliziert das Bild (unter Beibehaltung der Originalgröße)
so oft wie nötig und reiht die Bilder aneinander, bis sie den gesamten Desktop
ausfüllen.
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Dialogfeldelement Beschreibung

"Add (Hinzufügen)" Klicken Sie auf "Add (Hinzufügen)", um auf Ihrem Computer nach einer Bilddatei
zu suchen. Wählen Sie das gewünschte Bild aus, und klicken Sie auf "Open
(Öffnen)".

"Remove (Entfernen)" Wählen Sie das Bild aus, das Sie entfernen möchten, und klicken Sie auf "Remove
(Entfernen)". Dies entfernt das Bild aus der Liste der verfügbaren Hintergründe,
löscht das eigentliche Bild auf Ihrem Computer jedoch nicht.

"Colors (Farben)" Zum Festlegen eines Farbschemas verwenden Sie die Optionen in der Dropdown-
Liste "Style (Stil)"sowie die Schaltflächen zur Farbauswahl.

Sie können die folgenden Farbschemata bestimmen:

■ "Solid Color (Durchgängige Farbe)" legt eine einzige Farbe für den
Desktophintergrund fest.

Für die Farbauswahl klicken Sie auf "Color (Farbe)", wählen eine Farbe und
klicken anschließend auf "OK".

■ "Horizontal gradient (Horizontaler Verlauf)" erstellt einen Übergangseffekt vom
linken hin zum rechten Bildschirmrand.

Klicken Sie auf die Schaltfläche "Left Color (Linke Farbe)", und wählen Sie die
Farbe aus, die am linken Rand erscheinen soll.

Klicken Sie auf die Schaltfläche "Right Color (Rechte Farbe)", und wählen Sie
die Farbe aus, die am rechten Rand erscheinen soll.

■ "Vertical gradient (Vertikaler Verlauf)" erstellt einen Übergangseffekt vom
oberen hin zum unteren Bildschirmrand.

Klicken Sie auf die Schaltfläche "Top Color (Obere Farbe)", und wählen Sie die
Farbe aus, die am oberen Rand erscheinen soll.

Klicken Sie auf die Schaltfläche "Bottom Color (Untere Farbe)", und wählen Sie
die Farbe aus, die am unteren Rand erscheinen soll.

Schrifteinstellungen

Verwenden Sie die Registerkarte "Fonts (Schrift)" im Erscheinungsbildeinstellungstool, um
auszuwählen, welche Schriften in den unterschiedlichen Teilen des Desktops benutzt werden
sollen und um zu bestimmen, wie die Schriften auf dem Bildschirm angezeigt werden.

Sie können Schriften für die folgenden Teile des Desktops auswählen:

■ "Application font (Schriftart in Anwendungen)" – Diese Schrift wird in Anwendungen für
Menüleisten, Werkzeugleisten und Dialogfeldern verwendet.

■ "Document font (Dokumenten-Schrift)" – Wird in Anwendungen zur Anzeige von
Dokumenten verwendet.

Anmerkung - In einigen Anwendungen können Sie diese Auswahl im Einstellungsdialog der
Anwendung überschreiben.

■ "Desktop font (Schrift auf der Arbeitsfläche)" – Wird in Symbolbeschriftungen des
Desktops verwendet.
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■ "Window title font (Schrift für Fenstertitel)" - Wird in den Titelleisten von Fenstern
verwendet.

■ "Fixed width font (Dicktengleiche Schrift)" – Wird in der Terminal-Anwendung und in
Anwendungen verwendet, die mit Programmierung zu tun haben.

So wählen Sie Schriften aus

Die Schaltfläche "Font Selector (Schriftwähler)" zeigt den Namen der Schrift und ihre Größe in
Punkt. Der Name wird sowohl in normaler, als auch in fetter und kursiver Schrift dargestellt.

1. Wählen Sie "System -> Preferences -> Appearance" (System -> Einstellungen ->
Erscheinungsbild).

2. Klicken Sie auf die Registerkarte "Fonts (Schrift)".

3. Klicken Sie auf "Font Selector" (Schriftauswahl).
Der Dialog "Font Picker (Schriftwähler)" wird angezeigt.

4. Wählen Sie die Schriftfamilie, den Stil und die Größe in Punkt in den Listen aus.
Der Vorschaubereich zeigt ihre aktuelle Auswahl an.

5. Klicken sie auf "OK", um die Änderungen zu bestätigen und den Desktop zu
aktualisieren.

"Font Rendering (Schriftwiedergabe)"

Um festzulegen, wie die Schriftwiedergabe auf Ihrem Bildschirn erfolgen soll, wählen Sie eine
der folgenden Optionen aus:

■ "Rendering (Schriftwiedergabe)" – Bestimmt, wie Schriften auf dem Bildschirm
wiedergegeben werden:
■ "Monochrome (Schwarz-Weiß)" - Stellt Schriften ausschließlich in schwarz-weiß dar.

Die Ränder der Zeichen erscheinen in einigen Fällen ausgefranst, weil die Zeichen
nicht geglättet sind. ("Kantenglättung" ist ein Effekt, der auf die Ränder der Zeichen
angewendet wird, um diese weicher aussehen zu lassen.)

■ Best shapes (Beste Form): Glättet die Schrift, sofern dies möglich ist. Verwenden Sie
diese Option bei Standard-Röhrenmonitoren (CRT).

■ Bester Kontrast: Stellt die Schrift so ein, dass größtmögliche Schärfe erreicht wird.
Die Schriften werden zudem geglättet, so dass die Zeichen glatte Ränder aufweisen.
Diese Option verbessert eventuell die Barrierefreiheit des Oracle Solaris-Desktops für
Sehbehinderte.

■ "Subpixel smoothing (Glättung mittels Subpixel)" (LCDs): Verwendet Techniken
zur Auswertung der Form der Pixel auf Flüssigkristallbildschirmen (LCD), um
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Schriften geglättet wiederzugeben. Verwenden Sie diese Option bei LCD- oder
Flachbildschirmen.

■ Details – Bestimmt, wie Schriften auf dem Bildschirm wiedergegeben werden:
■ "Resolution (Auflösung)" (Pixel pro Zoll): Bestimmt die Bildschirmauflösung, die für

die Schriftwiedergabe auf dem Bildschirm zu verwenden ist.
■ "Smoothing (Glättung)" - Legt fest, wie die Schriften geglättet werden.
■ "Hinting (Hinting)" – Hinting ist eine Technik zur Schriftwiedergabe, die die Qualität

bei kleinen Schriften und niedrigen Bildschirmauflösungen verbessert. Wählen Sie eine
der Optionen, um anzugeben, wie Sie Hinting auf Ihre Schriften anwenden wollen.

■ "Subpixel order (Reihenfolge der Subpixel)" - Wählen Sie eine der Optionen, um die
Farbreihenfolge der Subpixel für Ihre Schriften zu bestimmen. Verwenden Sie diese
Option bei LCD- oder Flachbildschirmen.

Visuelle Effekte

Die Registerkarte "Visual Effects (Visuelle Effekte)" des Erscheinungsbildeinstellungstools
ermöglicht es Ihnen, die Art der Animation, die Durchsichtigkeit und andere, während der
Interaktion mit Fenstern, Menüs und Arbeitsflächen sichtbare Effekte, zu steuern. Diese Effekte
können die Funktionalität und das visuelle Erscheinungsbild des Desktops verbessern. Einige
Effekte erfordern allerdings eine Grafikkarte, die Hardwarebeschleunigung unterstützt.

Sie können aus den nachfolgenden voreingestellten Stufen visueller Effekte aussuchen:

■ "None (Keine)" - Es werden keinerlei spezielle visuelle Effekte aktiviert. Dies ist die
Standardoption, wenn Ihre Grafikkarte Hardwarebeschleunigung nicht unterstützt und
Metacity-Fenstermanager verwendet.

■ "Normal (Normal)" - Nur eine kleine Auswahl visueller Effekte ist aktiviert. Dies ist die
Standardoption, wenn Ihre Grafikkarte Hardwarebeschleunigung unterstützt und Compiz-
Fenstermanager verwendet.

■ "Extra (Extra)"– Eine größere Auswahl visueller Effekte wird aktiviert. Wenn diese Option
ausgewählt wird, wird der Compiz-Fenstermanager verwendet.

Anmerkung - Sollten Sie während der Benutzung der Registerkarte "Visual Effects (Visuelle
Effekte)" eine Option auswählen, die von Ihrer Grafikkarte nicht unterstützt wird, werden die
vorherigen Einstellungen wieder hergestellt.

So aktivieren und konfigurieren Sie einen benutzerdefinierten Satz
visueller Effekte

1. Wählen Sie die Schaltfläche "Custom (Benutzerdefiniert)" und klicken Sie dann
auf "Preferences (Eigenschaften)".
Der Dialog für den Compiz-Einstellungsverwalter wird angezeigt.
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2. Wählen Sie im Dialog des Compiz-Einstellungsverwalters die Felder aus oder
ab, die Sie aktivieren oder deaktivieren möchten, und klicken Sie dann auf den
Namen eines Effekts, um dessen Einstellungen zu ändern.

3. Klicken Sie auf "Close (Schließen)", um Ihre Änderungen zu speichern.

Symbole in Menüs anzeigen

Wählen Sie diese Option aus, um neben jeder Funktion in einem Anwendungsmenü und einem
Panel-Menü ein Symbol anzuzeigen. Einige Menüpunkte besitzen kein Symbol.

Anpassbare Menü-Tastenkombinationen

Über diese Option können Sie neue Tastenkombinationen für Menüelemente definieren. Um
eine Tastenkombination in einer Anwendung zu ändern, öffnen Sie das Menü. Bewegen Sie
dann den Mauszeiger über den Menüeintrag, den Sie ändern wollen, und drücken dann die neue
Tastenkombination. Umn eine Tastenkombination zu entfernen, drücken Sie die Rücktaste oder
Löschen.

Anmerkung - Wenn Sie diese Funktion verwenden, werden Sie bei der Zuweisung einer neuen
Tastenkombination nicht gewarnt, falls diese schon einer anderen Aktion zugewiesen wurde
und die alte Zuweisung daher gelöscht wird.

Es gibt keine Möglichkeit, die ursprüngliche Standard-Tastenkombination für einen Befehl
wiederherzustellen.

Diese Funktion unterstützt nicht die bei anderen Anwendungen üblichen Tastenkombinationen,
wie beispielsweise Strg+C für "Copy (Kopieren)". Auf diese Weise werden Inkonsistenzen
innerhalb Ihrer Anwendungen vermieden.

Schaltflächenbeschriftungen in Werkzeugleisten

Die nachfolgenden Schaltflächenbeschriftungen geben an, was in den Wekzeugleisten Ihrer
Anwendungen angezeigt werden kann.

■ "Text Below Icons (Text unter Symbolen)" – Wählen Sie diese Option aus, um
Werkzeugleisten mit Text sowie einem Symbol auf jeder Schaltfläche anzuzeigen.

■ "Text Beside Icons (Text neben Symbolen)" - Wählen Sie diese Option aus, um
Werkzeugleisten nur mit einem Symbol auf den Schaltflächen und mit Text auf den
wichtigsten Schaltflächen anzuzeigen.

■ "Icons Only (Nur Symbole)" - Wählen Sie diese Option aus, um Werkzeugleisten nur mit
einem Symbol auf jeder Schaltfläche anzuzeigen.
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■ "Text Only (Nur Text)" - Wählen Sie diese Option aus, um Werkzeugleisten nur mit Text
auf jeder Schaltfläche anzuzeigen.

Fenster
Verwenden Sie das Fenster-Einstellungstool, um das Verhalten der Fenster im Oracle Solaris-
Desktop anzupassen.

In der nachfolgenden Tabelle sind Fenstereinstellungen enthalten, die von Ihnen geändert
werden können.

TABELLE 10-3 Einstellungen für Fenster

Dialogfeldelement Beschreibung

"Select windows when the mouse moves over them
(Fenster aktivieren, wenn sich die Maus darüber
befindet)"

Wählen Sie diese Option, um ein Fenster zu aktivieren,
wenn sich die Maus darüber befindet. Das Fenster wird
wieder inaktiv, wenn Sie die Maus zu einem anderen
Fenster verschieben.

"Raise selected windows after an interval (Aktivierte
Fenster nach einer bestimmten Zeit anheben)"

Wählen Sie diese Option, wenn Sie aktivierte Fenster
nach einer vorgegebenen Zeit nach dem Aktivieren des
Fensters anheben wollen.

"Interval before raising (Verzögerung vor dem
Anheben)"

Gibt die Wartezeit an, bis ein Fenster nach der
Aktivierung angehoben wird.

Doppelklicken Sie auf die Titelleiste, um diese Aktion
auszuführen

Wählen Sie die auszuführende Aktion beim Doppelklick
auf die Titelleiste eines Fensters. Wählen Sie aus einer
der folgenden Optionen:

■ "Maximize (Maximieren)" – Maximiert das Fenster.
■ "Maximize Vertically (Vertikal maximieren)" –

Maximiert das Fenster vertikal, ohne dessen Breite zu
verändern.

■ "Maximize Horizontally (Horizontal maximieren)" -
Maximiert das Fenster horizontal, ohne dessen Höhe
zu verändern.

■ " Minimize(Minimieren)" - Minimiert das Fenster.
■ "Roll up (Aufrollen)" - Rollt das Fenster auf, so dass

nur die Titelleiste angezeigt wird.
■ "None (Nichts) - Nichts tun.

Falls ein Fenster schon maximiert oder eingerollt ist,
doppelklicken Sie auf die Titelleiste, um das Fenster in
seinen normalen Zustand zurückkehren zu lassen.

Zum Verschieben eines Fensters folgende Taste beim
Klicken gedrückt halten

Gibt die Taste an, die beim Verschieben eines Fensters
gedrückt gehalten werden soll.

Anmerkung - Die Position der Strg-, Alt- und Super-Tasten können im
Tastatureinstellungsdialog angepasst werden. Weitere Informationen erhalten Sie unter
„Tastaturbelegungseinstellungen“ [150].
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Bildschirmschoner

Ein Bildschirmschoner zeigt bewegte Bilder auf Ihrem Bildschirm an, wenn Ihr Rechner nicht
genutzt wird. Die Bildschirmschoneranwendung, die vom Oracle Solaris-Desktop genutzt
wird, ist XScreenSaver. Die nachfolgenden Abschnitte beschreiben, wie Sie Einstellungen an
XScreenSaver vornehmen können, und wie Sie die für den Bildschirmschoner verfügbaren
Anzeigen ändern können.

Dieser Abschnitt behandelt das Festlegen von Bildschirmschonereinstellungen. Zusätzlich
bietet Ihnen dieser Abschnitt Informationen zur Änderung von Anzeigen, die für den
Bildschirmschoner zur Verfügung stehen.

Festlegen der Bildschirmschonereinstellungen

Die standardmäßigen Bildschirmschonereinstellungen sind in der Datei /usr/share/X11/
app-defaults/XScreenSaver gespeichert. Um das Bildschirmschonereinstellungstool zu
starten, führen Sie den Befehl xscreensaver-demo aus dem Verzeichnis /usr/bin/ aus. Um
das Bildschirmschonereinstellungswerkzeug aus dem Menü "System (System)" zu öffnen,
wählen Sie "System -> Einstellungen -> Bildschirmschoner aus.

Standardmäßige Bildschirmschonereinstellungen für alle
Benutzer festlegen

Um standardmäßige Bildschirmschonereinstellungen für alle Benutzer festzulegen, müssen Sie
die Datei XScreenSaver anpassen. Oder Sie verwenden den XScreenSaver-Dialog, um eine
$HOME/.xscreensaver-Datei zu erstellen, und kopieren die Datei anschließend an den Ort der
XScreenSaver-Datei.

Standardmäßige Bildschirmschonereinstellungen eines Benutzers
wiederherstellen

Um die Standardeinstellungen eines Benutzers wiederherstellen zu können, müssen Sie die
$HOME/.xscreensaver-Datei aus dem Standardverzeichnis des Benutzers löschen. Falls keine
$HOME/.xscreensaver-Datei vorhanden ist, verwendet das System die Standardeinstellungen
der XScreenSaver-Datei.

Anmerkung - Das standardmäßige Verhalten der Anwendung XScreenSaver besteht aus der
Anzeige eines leeren Bildschirms.
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Damit Änderungen der Bildschirmschonereinstellungen aktiviert werden können, verwenden
Sie den folgenden Befehl, um die Bildschirmschonereinstellungen zu aktualisieren:

# xscreensaver-command -restart

Ändern der Einstellungen des Bildschirmschoners

Um Bildschirmschonereinstellungen zu ändern, können Sie das
Bildschirmschonereinstellungstool verwenden. Wenn Sie die Bildschirmschonereinstellungen
ändern, werden die Einstellungen im Home-Verzeichnis des Benutzers in der
$HOME/.xscreensaver-Datei gespeichert.

Die Darstellung des Bildschirmschoners ändern

Die Bildschirmschoneranzeigen werden in der XScreenSaver-Datei und der
$HOME/.xscreensaver-Datei aufgelistet. Die Bildschirmschoneranwendung erlaubt es
Benutzern, eine oder mehrere Bildschirmschoneranzeigen auszuwählen.

So fügen Sie eine Bildschirmschoneranzeige hinzu

1. Kopieren Sie die ausführbare Datei der Anzeige in das /usr/lib/xscreensaver/
hacks/-Verzeichnis.

2. Fügen Sie den Befehl für die Bildschirmschoneranzeige entweder der
XScreenSaver-Datei oder der $HOME/.xscreensaver-Datei hinzu.
Um die Bildschirmschoneranzeige im Vollbildmodus und nicht in einem Fenster auszuführen,
müssen entsprechende Argumente eingesetzt werden. Wenn Sie beispielsweise die -Root-
Option einbeziehen, können Sie die Bildschirmschoneranzeige im Vollbildmodus anzeigen.

Bildschirmschoneranzeige deaktivieren

Um die Bildschirmschoneranzeigen für alle Benutzer auf einem Sun Ray™-Client zu
deaktivieren, geben Sie den nachfolgenden Befehl ein:

# pkg uninstall 'desktop/xscreensaver/hacks*'

Anmerkung - Der PAM-Servicename (Pluggable Authentication Modules) der Anwendung
XScreenSaver lautet dtsession. Dieser Name wird zwecks Kompatibilität mit vorherigen
Anwendungen verwendet.
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Internet- und Netzwerkeinstellungen festlegen

Dieser Abschnitt beschreibt die Internet- und Netzwerkkonfigurationen, die Sie festlegen
können.

Netzwerk

In Oracle Solaris verwalten NCPs (Network Configuration Profiles) die Netzwerkkonfiguration
des Systems. Nur jeweils ein NCP kann in einem System nacheinander aktiv sein. Oracle
Solaris unterstützt zwei NCP-Typen: "reactive" und "fixed". Abhängig von dem jeweiligen Typ,
bestimmt das aktive NCP, ob die Netzwerkkonfiguration des Systems "reactive" oder "fixed"
ist.

Standardmäßig verwendet Oracle Solaris zur Vereinfachung der Netzwerkkonfiguration eine
Funktion namens Reactive-Netzwerkkonfiguration (NWAM). Das Netzwerkeinstellungstool
ermöglicht Ihnen das Konfigurieren dieser Funktion.

Die Reactive-Netzwerkkonfiguration vereinfacht die Basisnetzwerkkonfiguration, indem
verdrahtete und drahtlose Netzwerke automatisch konfiguriert und verwaltet werden. NWAM
ist für das Ethernet und drahtlose Konfigurationen gedacht und ermöglicht Ihnen, verschiedene
Vernetzungsaufgaben auszuführen, beispielsweise das Herstellen einer Verbindung mit
Ihrem verdrahteten oder drahtlosen Netzwerk beim Start und das Konfigurieren neuer
verdrahteter oder Drahtlosnetzwerke. Die NWAM-Funktion vereinfacht zudem komplexe
Netzwerkkonfigurationen wie eine systemübergreifende Netzwerkkonfiguration. Außerdem
zeigt diese Funktion Informationsmeldungen zum aktuellen Status Ihrer Netzwerkverbindung
und den Gesamtzustand Ihres Netzwerks an.

Weitere Funktionen:

■ Mehrere gleichzeitige Netzwerkverbindungen
■ Erkennung von Hot-Plug-Ereignissen
■ Netzwerkmodifizierer unterstützen beispielsweise VPN-Clientanwendungen (Virtual Private

Network).

Die Netzwerkkonfiguration wird verwaltet, indem die entsprechenden Eigenschaftswerte in
Form von Profilen gespeichert werden. NWAM bestimmt in Abhängigkeit von den aktuellen
Netzwerkbedingungen, welches Profil zu einem bestimmten Zeitpunkt aktiv sein soll und
aktiviert anschließend das Profil.

Es gibt zwei primäre Profiltypen: das "Netzwerkprofil", das zur Angabe der Konfiguration
von einzelnen Netzwerkschnittstellen dient, und "Speicherorte", das zur Angabe von
systemübergreifenden Netzwerkkonfigurationen dient. Die einzelnen Komponenten, aus denen
das Netzwerkprofil besteht, werden als "Netzwerkverbindungen" bezeichnet. Sie können diese
Anwendung verwenden, um beide Profiltypen zu konfigurieren und zu verwalten.
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Weitere Informationen zur Verwendung von NWAM finden Sie unter „Configuring and
Administering Network Components in Oracle Solaris 11.2“.

Netzwerkproxy

Die Netzwerk-Proxy-Einstellungen erlauben Ihnen einzustellen, wie sich Ihr System mit dem
Internet verbindet.

Sie haben die Möglichkeit, den Oracle Solaris-Desktop mit einem Proxy-Server zu
verbinden und die Details des Proxy-Servers anzugeben. Ein Proxy-Server ist ein Server, der
Anforderungen an einen anderen Server abfängt und selbst bearbeitet, sofern er dazu in der
Lage ist. Sie können den Domainnamen oder die IP-Adresse des Proxy-Servers eingeben.
Ein Domainname ist eine eindeutige alphabetische Kennung für einen Computer in einem
Netzwerk. Eine IP-Adresse ist eine eindeutige numerische Kennung für einen Computer in
einem Netzwerk.

Seit es möglich ist, verschiedene Proxy-Konfigurationen an verschiedenen Orten zu nutzen,
können Sie diese in den Netzwerk-Proxy-Einstellungen angeben. Sie können dann zwischen
den verschiedenen Konfigurationen mittels der Auswahlliste "Location (Ort)" oben im Fenster
wechseln. Wählen Sie "New location (Neuer Ort)", um eine Proxy-Konfiguration für einen
neuen Ort zu erstellen. Orte können mit der Schaltfläche "Delete Location (Ort löschen)" unten
im Fenster entfernt werden.

Die Proxy-Einstellungen des Netzwerks sind in der nachfolgenden Tabelle enthalten.

TABELLE 10-4 Netzwerkproxyeinstellungen

Dialogfeldelement Beschreibung

Direct internet
connection (Direkte
Verbindung zum
Internet)

Wählen Sie diese Option aus, wenn Sie sich nicht über einen Proxy-Server mit dem Internet
verbinden möchten.

Manual proxy
configuration
(Manuelle
Proxykonfiguration)

Wählen Sie diese Option, wenn Sie sich über einen Proxy-Server mit dem Internet
verbinden, und Sie diesen Proxy-Server per Hand konfigurieren möchten.

■ HTTP proxy (HTTP-Proxy) – Der Domainname oder die IP-Adresse des Proxy-
Servers, die für Anfragen an einen HTTP-Service verwendet werden sollen. Geben Sie
die Portnummer des sicheren HTTP-Services auf dem Proxy-Server im Feld "Port" ein.
If the HTTP proxy server requires authentication, click the Details button to enter your
username and password.

■ Secure HTTP proxy (Sicherer HTTP-Proxy) – Der Domainname oder die IP-Adresse
des Proxy-Servers, die für Anfragen an einen sicheren HTTP-Service verwendet
werden sollen. Geben Sie die Portnummer des sicheren HTTP-Services auf dem Proxy-
Server im Feld "Port (Port)" ein.

■ FTP proxy (FTP-Proxy) - Der Domainname oder die IP-Adresse des Proxy-Servers,
die für Anfragen an einen FTP-Service verwendet werden sollen. Geben Sie die
Portnummer für den FTP-Service auf dem Proxy-Server im Feld "Port (Port)" ein.

http://www.oracle.com/pls/topic/lookup?ctx=E36784&id=NWCFG
http://www.oracle.com/pls/topic/lookup?ctx=E36784&id=NWCFG


Internet- und Netzwerkeinstellungen festlegen

146 Desktopbenutzerhandbuch zu Oracle Solaris 11.2 • Juli 2014

Dialogfeldelement Beschreibung
■ Socks host (Rechnername des Socks-Proxy) – Der Domainname oder die IP-Adresse

des Rechnernamens des Socks-Proxy. Geben Sie die Portnummer für das Socks-
Protokoll auf dem Proxy-Server in das Feld "Port" ein.

Automatic proxy
configuration
(Automatische Proxy-
Konfiguration)

Wählen Sie diese Option, wenn Sie sich über einen Proxy-Server mit dem Internet
verbinden wollen, und wenn Sie möchten, dass dieser Proxy-Server automatisch
konfiguriert wird.

Die automatische Proxy-Konfiguration geschieht durch eine sogenannte PAC-Datei, die
Ihr Browser von einem Webserver herunterladen kann. Falls Sie keine URL für eine PAC-
Datei im Eintrag "Autoconfiguration URL" angeben, versucht Ihr Browser, diese Adresse
automatisch zu ermitteln.

■ "Autoconfiguration URL (URL für Auto-Konfiguration)" – Geben Sie die URL einer
PAC-Datei ein, die die benötigten Informationen für die automatische Konfiguration
des Proxy-Servers enthält.

Wenn Sie Rechner verwenden, die sich direkt ohne Proxy mit dem Internet verbinden sollen,
dann fügen Sie sie der "Ignore Host List (Ignorierte Rechnerliste)" in der Registerkarte "Ignored
Hosts (Ignorierte Rechner)" hinzu. Wenn Sie auf diese Rechner zugreifen, verbinden Sie sich
direkt ohne Proxy-Server mit dem Internet.

Gemeinsame Desktopnutzung

Das Einstellungstool für die gemeinsame Desktopnutzung erlaubt Ihnen, eine Oracle Solaris-
Desktopsitzung mit mehreren Benutzern zu teilen sowie die Einstellungen für das Teilen von
Sitzungen anzupassen.

Die nachfolgende Tabelle enthält die Einstellungen für die gemeinsame Nutzung von Sitzungen,
die Sie festlegen können. Diese Einstellungen haben direkten Einfluss auf den Sicherheitsstatus
Ihres Systems.

TABELLE 10-5 Einstellungen für das Teilen von Sitzungen

Dialogfeldelement Beschreibung

"Allow other users to view your desktop (Anderen
Benutzern erlauben, Ihren Desktop zu betrachten)"

Wählen Sie diese Option, wenn Sie entfernten Benutzern
erlauben möchten, Ihre Sitzung anzuzeigen. Alle
Tastatureingaben, Mausaktionen und mittels der
Zwischenablage des entfernten Benutzers ausgeführten
Vorgänge werden dabei ignoriert.

"Allow other users to control your desktop (Anderen
Benutzern erlauben, Ihren Desktop zu steuern)"

Wählen Sie diese Option, um anderen zu ermöglichen,
auf Ihre Sitzung von einem entfernten Ort aus
zuzugreifen.

Sicherheit Bestimmt die Sicherheitsmethoden, wenn ein Benutzer
versucht, Ihre Sitzung anzuzeigen oder zu steuern:

■ "You must confirm each access to this machine
(Jeder Zugriff auf diesen Rechner muss bestätigt
werden)" – Zeigt einen Bestätigungsdialog an, wenn
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Dialogfeldelement Beschreibung
ein Benutzer versucht, eine Verbindung zu Ihrem
Desktop herzustellen. Wählen Sie diese Option ab,
wenn Sie eine Remote-Verbindung zu Ihrem eigenen
Desktop herstellen möchten.

■ "Require the user to enter this password (Der
Benutzer muss folgendes Passwort eingeben)" – Gibt
an, dass von einem entfernten Benutzer ein Passwort
angegeben werden muss, damit dieser auf Ihren
Desktop zugreifen kann. Sie müssen ein Passwort für
Ihren Desktop festlegen.

■ "Configure network automatically to accept
connections (Netzwerkeinstellungen so ändern, dass
Verbindungen akzeptiert werden)" – Ermöglicht
es Benutzern, über das Internet auf Ihren Desktop
zuzugreifen. Wenn diese Option nicht ausgewählt
wird, können Benutzer nur über das lokale Netzwerk
auf Ihren Desktop zugreifen.

Notification Area (Benachrichtigungsfeld) Bestimmt, wann ein Symbol für "Entfernte Desktops"
im Benachrichtigungsfeld des Desktoppanels angezeigt
werden soll:

■ "Always display an icon (Symbol immer anzeigen)"
– Zeigt immer dann ein Symbol an, wenn Ihr
Desktop zum Teilen bereit steht. Dies gilt auch, wenn
keine entfernten Benutzer verbunden sind.

■ "Only display an icon when there is somebody
connected (Nur dann ein Symbol anzeigen, wenn
jemand verbunden ist)" – Zeigt nur dann ein Symbol
an, wenn entfernte Benutzer mit Ihrem Desktop
verbunden sind.

■ "Never display an icon (Symbol nie anzeigen)" – Es
wird selbst dann kein Symbol angezeigt, wenn ein
oder mehrere entfernte Benutzer verbunden sind.

Tastatureinstellungen festlegen
Dieser Abschnitt beschreibt, wie Sie die automatische Wiederholung, die Belegungen und
die Eingabemethoden Ihrer Tastatur für das Tippen in unterschiedlichen Sprachen sowie die
Barrierefreiheitsfunktionen der Tastatur für den Oracle Solaris-Desktop konfigurieren können.

Sie können Einstellungen zur Tastaturbelegung und zum Tastaturmodell konfigurieren. Die
beiden Hauptbereiche sind:

■ "Input Methods (IM) (Eingeabemethoden)" – Wählen Sie diese Methode, wenn Sie
regelmäßig in Sprachen tippen, die über eine große Anzahl Zeichen oder komplexere
Zeichen verfügen. Dies trifft auf einige asiatische Sprachen wie beispielsweise das
Chinesische, Japanische oder Koreanische zu.

■ GNOME-Einstellungen zur Tastaturbelegung – Wählen Sie diese Methode, wenn Sie
regelmäßig in Sprachen tippen, die über eine geringere Zeichenanzahl verfügen. Dies
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gilt beispielsweise für Sprachen, die an lateinische Zeichen angepasst sind, wie etwa das
Englische, Spanische, Französische und Deutsche.

Obwohl die Eingabemethoden einen komplexeren Mechanismus für die Zusammenstellung von
Zeichen zur Verfügung stellen, können Sie auch für romanische Sprachen verwendet werden.
Ähnlich können auch die GNOME-Einstellungen zur Tastaturbelegung für Sprachen verwendet
werden, die nicht romanisch sind.

Tastatur

Verwenden Sie das Einstellungstool "Keyboard (Tastatur)", um Tastatureinstellungen
wie Modell, Layout und Variante festzulegen. Sie können auch zusätzliche erweiterte
Tastatureinstellungen, wie etwa die Einstellungen zur automatischen Wiederholung oder die
Tipppauseneinstellungen, bearbeiten.

Wählen Sie "System -> Preferences -> Keyboard" (System -> Einstellungen -> Tastatur), um
das Tastatureinstellungstool anzuzeigen.

Tastatureinstellungen werden standardmäßig aktiviert. Wenn mehr als eine Tastaturbelegung
ausgewählt wird, erscheint das Tastaturindikator-Applet in der rechten Ecke des Panels. Weitere
Informationen zu diesem Applet erhalten Sie unter GNOME Keyboard Indicator Manual.

Allgemein

Verwenden Sie die Registerkarte "Allgemein", um generelle Tastatureinstellungen festzulegen.
In der nachfolgenden Tabelle sind die Tastatureinstellungen enthalten, die verändert werden
können.

TABELLE 10-6 Tastatureinstellungen

Dialogfeldelement Beschreibung

"Key presses repeat when key is held down (Tasten
wiederholt auslösen, wenn Sie gedrückt gehalten
werden)"

Wählen Sie die Option, um die Tastaturwiederholung
zu aktivieren. Wenn die Tastaturwiederholung aktiviert
ist und Sie eine Taste gedrückt halten, wird die mit der
Taste verknüpfte Aktion mehrfach ausgeführt. Halten Sie
beispielsweise eine Buchstabentaste gedrückt, wird der
Buchstabe mehrfach eingegeben.

"Delay (Verzögerung)" Legt den Wert für die Verzögerung vom Drücken einer
Taste bis zum Wiederholen der Aktion fest.

"Speed (Geschwindigkeit)" Legt die Geschwindigkeit fest, mit der die Aktion
wiederholt wird.

"Cursor blinks in text fields (Blinkender Cursor in
Textfeldern)"

Lässt den Cursor in Feldern und Textfeldern blinken.

"Speed (Geschwindigkeit)" Legt die Geschwindigkeit fest mit der der Cursor in
Feldern und Textfeldern blinkt.

http://library.gnome.org/users/gswitchit/2.32
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Dialogfeldelement Beschreibung

"Type to test settings (Einstellungen überprüfen)" Stellt eine interaktive Oberfläche zur Verfügung, in der
Sie sehen können, wie sich die Tastatureinstellungen
bei der Eingabe auf die Anzeige auswirken. Geben
Sie in den Testbereich Text ein, um die Wirkung der
Einstellungen zu testen.

"Layouts (Belegungen)"

Verwenden Sie die Registerkarte "Belegungen", um die Spracheinstellungen für die Tastatur
sowie deren Marke und Modell festzulegen.

Die nachfolgenden Einstellungen ermöglichen es Ihnen, die speziellen Medientasten Ihrer
Tastatur zu verwenden, sowie die korrekten Zeichen für die Sprache Ihrer Tastatur anzuzeigen:

■ "Keyboard model (Tastatur-Modell)"– Verwenden Sie die Schaltfläche "Browse
(Durchsuchen)", die mit dem Namen des gegenwärtig ausgewählten Tastaturmodells
beschriftet ist, um ein anderesTastaturmodell auszuwählen.

■ "Separate layout for each window (Separate Belegung für jedes Fenster)" – Wenn diese
Option ausgewählt wird, verfügt jedes Fenster über seine eigene Tastaturbelegung. Der
Wechsel zu einer anderen Belegung betrifft nur das aktuelle Fenster.
Sie können beispielsweise mit einer russischen Tastaturbelegung in einem
Textverarbeitungsprogramm arbeiten, zu Ihrem Webbrowser wechseln und mit einer
englischen Tastaturbelegung tippen.

■ Gewählte Belegungen – Sie können zwischen gewählten Belegungen umschalten, um die
Zeichen zu ändern, die Ihre Tastatur beim Tippen hervorbringt.
Um zwischen Tastaturbelegungen umzuschalten, verwenden Sie das Panel-Applet
"Keyboard Indicator (Tastaturindikator)".
Um eine Belegung der Liste gewählter Belegungen hinzuzufügen, verwenden Sie die
Schaltfläche "Add (Hinzufügen)". Im angezeigten Dialog zur Layoutauswahl müssen Sie
ein Layout gemäß Land oder Sprache auswählen. Sie können bis zu vier Belegungen haben.
Um eine Belegung zu entfernen,müssen Sie es auswählen und anschließend auf "Remove
(Entfernen)" klicken.

Klicken Sie auf "Reset to Defaults (Zurücksetzen)", um die ursprünglichen Einstellungen zur
Tastaturbelegung für Ihr System und Ihre Lokalisierungskennung wiederherzustellen.

Klicken Sie auf die Schaltfläche "Layout Options (Belegungseinstellungen)", um den Dialog
"Keyboard Layout Options (Tastaturbelegungseinstellungen) zu öffnen.

Anmerkung - Sie können bei der Anmeldung eine Tastaturbelegung auswählen. Weitere
Informationen erhalten Sie unter So verwenden Sie ein anderes Tastaturlayout [14].
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Anmerkung - Der setxkbmap-Befehl ermöglicht es Ihnen, alle Tastaturbelegungen im X Server
über die Befehlszeile festzulegen und anzupassen. Weitere Informationen erhalten Sie auf der
Manpage setxkbmap(1).

Tastaturbelegungseinstellungen

Der Dialog "Keyboard Layout Options (Tastaturbelegungseinstellungen)" ermöglicht es Ihnen,
das Verhalten von Modustasten und die Optionen bestimmter Tastenkombinationen festzulegen.

Erscheint die Bezeichnung in Fettdruck, wird dadurch angezeigt, dass die Standardeinstellungen
der Optionen in der Gruppe geändert wurden.

Anmerkung - Die in diesem Dialog angezeigten Optionen hängen von dem X Window-System
ab, das Sie verwenden. Es kann sein, dass nicht alle Optionen auf Ihrem System gelistet sind
und darauf arbeiten.

In der nachfolgenden Tabelle werden die Einstellungen zur Tastaturbelegung erläutert.

TABELLE 10-7 Tastaturbelegungseinstellungen

Dialogfeldelement Beschreibung

Adding the Euro sign to certain keys (Hinzufügen des
Euro-Symbols zu bestimmten Tasten)

Das europäische Währungssymbol -b$ wird einer Taste
als Zeichen der dritten Ebene hinzugefügt. Um auf dieses
Symbol zuzugreifen, müssen Sie eine Auswahltaste der
dritten Ebene zuweisen.

Alt/Win key behavior (Verhalten der Alt/Windows-
Tasten)

Weist das Verhalten der UNIX-Modustasten "Super",
"Meta" und "Hyper" den Alt und Windows-Tasten Ihrer
Tastatur zu.

CapsLock key behavior (CapsLock-Verhalten) Bestimmt das Verhalten der Hochstelltaste.

Compose key position (Position der Compose-Taste) Ermöglicht es Ihnen zwei Tastenanschläge zu
kombinieren, um ein einziges Zeichen zu erzeugen.
Auf diese Weise können Sie ein akzentuiertes Zeichen
erstellen, das sich eventuell nicht auf Ihrer Tastatur
befindet. Drücken Sie beispielsweise Compose+'+e, um
ein e-Akut-Zeichen zu erhalten.

Control key position (Position der Strg-Taste) Legt den Ort der Strg-Taste fest, um die
Übereinstimmung mit dem Layout älterer Tastaturen zu
gewährleisten.

Group Shift/Lock behavior (Umschalt- und
Hochstelltasten gruppieren)

Die Tasten bzw. Tastenkombinationen, mit denen das
Tastaturlayout gewechselt werden kann, werden dadurch
festgelegt.

Miscellaneous compatibility options (Verschiedene
Kompatibilitätsoptionen)

■ Umschalttaste funktioniert mit den Tasten des
Nummernblocks wie in MS Windows – Wenn diese
Option aktiviert ist, erweitert die Umschalttaste
zusammen mit den Tasten des Nummernblocks bei
ausgeschaltetem NumLock die aktuelle Auswahl.
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Dialogfeldelement Beschreibung
Wenn diese Option nicht ausgewählt ist, dann
benutzen Sie die Umschalttaste, um die Umkehrung
des gegenwärtigen Verhaltens für diese Taste zu
erreichen. Beispiel: Wenn NumLock nicht aktiviert
ist, fungiert die Taste 8 als Pfeil nach oben. Drücken
Sie die Umschalttaste+8, um eine 8 zu tippen.

■ Special keys (Spezialtasten für Server) (STRG+
ALT+<key>): Wählen Sie diese Option, wenn
bestimmte Tastenkombinationen direkt an das X-
Window-System weitergereicht werden sollen, anstatt
vom Desktop verarbeitet zu werden.

Third level choosers (Auswahltasten der dritten Ebene) Die dritte Ebene einer Taste ermöglicht Ihnen die
Eingabe eines dritten Zeichens mit einer Taste, ebenso
wie die gedrückt gehaltene Umschalttaste beim Druck
einer Taste ein anderes Zeichen ausgibt als ein Druck auf
die Taste allein.

Verwenden Sie diese Gruppe, um eine Taste als
Modifikationstaste der dritten Ebene auszuwählen.

Wenn Sie die Taste der dritten Ebene zusammen mit der
Umschalttaste gedrückt halten, wird das vierte Zeichen
einer Taste ausgegeben.

Die Zeichen der dritten und vierten Ebene Ihrer
Tastaturbelegung werden im Ansichtsfenster des
Tastaturindikators angezeigt.

Use keyboard LED to show alternative group (Tastatur-
LED zur Anzeige der alternativen Gruppe verwenden)

Verwenden Sie diese Option, wenn eine der LEDs
Ihrer Tastatur leuchten soll, wenn eine alternative
Tastaturbelegung verwendet wird. Die Standardfunktion
der ausgewählten Tastatur-LED wird nicht mehr
angezeigt. Beispiel: Die Beleuchtung der Feststelltaste
reagiert nicht mehr auf die Feststelltaste.

Barrierefreiheit

Auf der Registerkarte "Accessibility (Barrierefreiheit)" können Sie Optionen wie
das Herausfiltern versehentlicher Betätigungen von Tasten oder die Verwendung von
Tastenkombinationen, ohne dass mehrere Tasten gleichzeitig gedrückt gehalten werden müssen.
Dieses Funktionsmerkmal ist auch als AccessX bekannt.

Dieser Abschnitt beschreibt jede der möglichen Einstellungen. Eine verstärkt auf Aufgaben
ausgerichtete Beschreibung zur Barrierefreiheit der Tastatur erhalten Sie im Oracle Solaris 11
Handbuch zur Barrierefreiheit für GNOME-Desktop.

In der nachfolgenden Tabelle sind die Barrierefreiheitseinstellungen enthalten, die verändert
werden können.
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TABELLE 10-8 Barrierefreiheitseinstellungen

Dialogfeldelement Beschreibung

Barrierefreiheitsfunktionen können über
Tastenkombinationen umgeschaltet werden

Im Benachrichtigungsfeld wird ein Symbol angezeigt,
über das Sie schnell auf die Barrierefreiheitsfunktionen
zugreifen können.

Simulate simultaneous key presses (Gleichzeitige
Tastenanschläge simulieren)

Tastenkombinationen werden durch das Drücken
mehrerer Tasten hintereinander ersetzt. Alternativ können
Sie die Einrastfunktion durch fünfmaliges Drücken der
UMSCHALTTASTE aktivieren.

Disable sticky keys if two keys are pressed together
(Deaktivieren, wenn zwei Tasten zusammen gedrückt
werden)

Wenn Sie zwei Tasten gleichzeitig drücken,
können Sie keine Tasten nacheinander drücken, um
Tastenkombinationen auszuführen.

Only accept long key presses (Nur lange Tastenanschläge
akzeptieren)

Sie können festlegen, wie lange eine Taste gedrückt
gehalten werden muss, damit der Tastendruck akzeptiert
wird. Stattdessen können Sie zur Aktivierung der
Tastenverzögerung auch die Umschalttaste für acht
Sekunden gedrückt halten.

Delay (Verzögerung) Sie können festlegen, wie lange eine Taste gedrückt
gehalten werden muss, damit der Tastendruck akzeptiert
wird.

Ignore fast duplicate key presses (Schnelle doppelte
Tastenanschläge ignorieren)

Die Wiederholungscharakteristik der Tastatur wird
dadurch gesteuert.

Delay (Verzögerung) Dadurch wird der Intervall zwischen dem ersten
Tastendruck und der automatischen Wiederholung einer
gedrückten Taste festgelegt.

Type to test settings (Testbereich) Auf einer Benutzeroberfläche können Sie sehen, wie
sich die Tastatureinstellungen bei der Eingabe auf die
Anzeige auswirken. Geben Sie einen beliebigen Text in
den Testbereich ein, um den Einfluss Ihrer Einstellungen
zu überprüfen.

"Audio Feedback (Signaltöne)"

Um die akustische Rückmeldung für die Barrierefreiheitsfunktionen zu aktivieren, klicken Sie
auf den Knopf "Audio Feedback (Signaltöne)". Der Dialog "Keyboard Accessibility Audio
Feedback (Tastatur-Barrierefreiheit - Signaltöne)" wird angezeigt.

In der nachfolgenden Tabelle sind die Einstellungen zu Signaltönen enthalten, die verändert
werden können.

TABELLE 10-9 Einstellungen für akustische Rückmeldungen

Dialogfeldelement Beschreibung

Beep when accessibility features are turned on
or off (Signalton ausgeben, wenn Funktionen zur
Barrierefreiheit aktiviert oder deaktiviert werden)

Wählen Sie diese Option, falls ein akustisches Signal
ertönen soll, wenn eine Funktion wie "Klebrige Tasten"
oder "Tastenverzögerung" aktiviert bzw. deaktiviert wird.

Beep when a toggle key is pressed (Signalton ausgeben,
wenn eine Zusatztaste gedrückt wird)

Wählen Sie diese Option, damit beim Drücken einer
Umschalttaste ein akustisches Signal ertönt. Wenn eine
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Dialogfeldelement Beschreibung
Umschalttaste aktiviert wird, ertönt ein akustisches
Signal. Wenn eine Umschalttaste deaktiviert wird,
ertönen zwei akustische Signale.

Beep when a modifier key is pressed (Signalton
ausgeben, wenn eine Zusatztaste gedrückt wird)

Wählen Sie diese Option, damit beim Drücken einer
Kombinationstaste ein akustisches Signal ertönt.

Show visual feedback for the alert sound (Visuelle
Rückmeldungen bei Alarmklängen geben)

Ein Teil des Bildschirms blinkt, wenn eine Anwendung
eine Warnung durch ein akustisches Signal meldet.

Flash window titlebar (Fensterleiste blinken) Lassen Sie bei einem akustischen Signal einer
Anwendung kurz die Fensterleiste blinken, in der das
Signal abgegeben wurde.

Ganzen Bildschirm blinken Lassen Sie bei einem akustischen Signal einer
Anwendung den ganzen Bildschirm blinken.

Beep when a key is pressed (Signalton ausgeben, wenn
eine Taste gedrückt wird)

Wenn eine Taste gedrückt wird, ertönt ein akustisches
Signal.

Beep when a key is accepted (Signalton ausgeben, wenn
eine Taste akzeptiert wird)

Wenn eine Taste akzeptiert wird, ertönt ein akustisches
Signal.

"Beep when a key is rejected (Signalton ausgeben, wenn
eine Taste abgewiesen wird)"

Klänge für einen hörbaren Hinweis darauf, dass eine
Taste abgewiesen wurde.

Maustasten

Verwenden Sie die Optionen der Registerkarte "Mouse Keys (Maustasten)", um die Tastatur als
Ersatz für die Maus zu konfigurieren.

In der nachfolgenden Tabelle sind die Maustasteneinstellungen enthalten, die verändert werden
können.

TABELLE 10-10Einstellungen für Tipppausen

Dialogfeldelement Beschreibung

"Pointer can be controlled using the keypad (Mauszeiger
per Tastatur steuern)"

Aktiviert den Nummernblock, damit Mausaktionen
emuliert werden können. Eine Liste der Tasten und ihrer
Äquivalente finden Sie unter „To Use the Keyboard
to Emulate the Mouse“ in „Oracle Solaris 11 Desktop
Accessibility Guide “.

Acceleration (Beschleunigung) Legt die Zeit fest, die der Zeiger benötigt, um auf
maximale Geschwindigkeit zu beschleunigen.

"Speed (Geschwindigkeit)" Legt die maximale Geschwindigkeit fest, mit der sich der
Zeiger über den Bildschirm bewegen lässt.

"Delay (Verzögerung)" Legt die Zeitspanne fest, die nach einem Tastenanschlag
verstreichen muss, damit sich der Zeiger bewegt.

http://www.oracle.com/pls/topic/lookup?ctx=dsc&id=/app/docs/doc/E54036dtconfig-10
http://www.oracle.com/pls/topic/lookup?ctx=dsc&id=/app/docs/doc/E54036dtconfig-10
http://www.oracle.com/pls/topic/lookup?ctx=dsc&id=/app/docs/doc/E54036dtconfig-10
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Tipppause

Die Einstellung einer Tipppause bewirkt, dass Sie daran erinnert werden, eine Pause einzulegen,
nachdem Sie längere Zeit mit Tastatur und Maus gearbeitet haben. Während einer Tipppause
wird der Bildschirm gesperrt.

In der nachfolgenden Tabelle sind die Tipppauseneinstellungen enthalten, die verändert werden
können.

TABELLE 10-11 Einstellungen für Tipppausen

Dialogfeldelement Beschreibung

"Lock screen to enforce typing break (Bildschirm sperren
und so eine Tipppause erzwingen)"

Wählen Sie diese Option, um den Bildschirm während
einer Tipppause zu sperren.

"Work interval lasts (Arbeitsintervall dauert)" Bestimmt die Zeit, die Sie noch arbeiten können, bevor
eine Tipppause eingelegt wird.

"Break interval lasts (Pausenintervall dauert)" Bestimmt die Dauer Ihrer Tipppausen.

"Allow postponing of breaks (Verschieben von Pausen
zulassen)"

Wählen Sie diese Option aus, wenn Sie in der Lage sein
möchten, Tipppausen zu verschieben.

Wenn Sie aufhören, Ihre Tastatur und Ihre Maus zu verwenden, und wenn dieser Zeitraum dem
eingestellten Pausenintervall entspricht, dann wird das aktuelle Arbeitsintervall zurückgesetzt.

Input Method Selector (Auswahl der
Eingabemethode)

"Input Methods (IM) (Eingeabemethoden)" helfen Ihnen, in Sprachen zu tippen, die über eine
große Anzahl Zeichen oder komplexere Zeichen verfügen. Dies trifft beispielsweise auf das
Chinesische, Japanische oder Koreanische zu.

Der Oracle Solaris-Desktop bietet verschiedene Eingabemethoden-Frameworks, die entweder
auf dem System installiert oder im Repository zur Installation zur Verfügung stehen. Eines der
zentralen Eingabemethoden-Frameworks des Oracle Solaris-Desktops ist IBus (Intelligent Input
Bus).

Das IBus-Framework bietet folgende Funktionen:

■ Komplette Engine zur Unterstützung der meisten asiatischen Sprachen
■ Tastaturlayoutemulationsunterstützung für zahlreiche Regionen einschließlich Europa,

Naher Osten und Afrika.
■ Unterstützung virtueller Tastaturen und X-Tastaturdatenemulation

Standardmäßig sind Eingabemethoden nur dann aktiviert, wenn Sie sich in einer der folgenden
Sprachen anmelden:
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■ Japanisch
■ Chinesisch
■ Koreanisch
■ Thai
■ Indisch

Eingabemethoden sind für andere Sprachen standardmäßig nicht aktiviert. Die Aktivierung
erfolgt manuell über die "Input Method Framework Selector (Auswahl für Eingabemethoden-
Framework)".

So aktivieren oder deaktivieren Sie Eingabemethoden

1. Wählen Sie "System -> Preferences -> Input Method Selector" (System ->
Einstellungen -> Auswahl der Eingabemethode).
Das Fenster "Input Method Framework Selector (Auswahl für Eingabemethoden -Framework)"
wird angezeigt.

2. Wählen Sie die Option "Eingabemethoden-Framework aktivieren" und dann aus
der Liste das gewünschte Eingabemethoden-Framework.

3. Klicken Sie auf "OK (OK)".

Hardwareeinstellungen festlegen

In diesem Abschnitt werden die Monitor- und Audioeinstellungen beschrieben, die Sie
konfigurieren können.

Einstellungstool "Monitor" (Bildschirm)

Verwenden Sie das Bildschirmeinstellungstool, um die Bildschirme zu konfigurieren, die Ihr
Computer verwendet.

Anmerkung - Auf den meisten Laptoptastaturen kann mit der Tastenkombination Fn+F7
zwischen mehreren typischen Bildschirmkonfigurationen gewechselt werden, ohne dass
"Monitor Preferences" (Bildschirmeinstellungen) aufgerufen werden muss.

Wählen Sie "System -> Preferences -> Monitor" (System -> Einstellungen -> Bildschirm), um
das Bildschirmeinstellungstool anzuzeigen.
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Sie können die grafische Darstellungen der Monitore im oberen linken Teil des Fensters durch
Ziehen und Ablegen anders anordnen. Mithilfe der Beschriftungen unter "Monitor Preferences
(Bildschirmeinstellungen)", die auf jedem Bildschirm oben links angezeigt werden, können Sie
feststellen, welches Fenster welchem Bildschirm entspricht.

Ihre unter "Monitor Preferences (Bildschirmeinstellungen)" vorgenommenen Änderungen
werden erst wirksam, wenn Sie auf den Knopf "Apply (Anwenden)" klicken. Wenn Sie
die Änderungen nicht bestätigen, werden die Optionen auf die vorherigen Einstellungen
zurückgesetzt. Dadurch soll verhindert werden, dass Ihr Computer durch eine falsch eingestellte
Anzeige unbrauchbar wird.

Die unten nachfolgende Tabelle erläutert die Bildschirmeinstellungen

TABELLE 10-12Bildschirmeinstellungen

Dialogfeldelemente Beschreibung

Same image in all monitors (Gleiches Bild auf allen
Bildschirmen)

Wenn Sie diese Option auswählen, wird Ihr gesamter
Desktop auf einem Bildschirm angezeigt, wobei auf
jedem Bildschirm derselbe Desktopinhalt angezeigt
wird. Wenn Sie diese Option nicht auswählen, wird Ihr
Desktop auf mehreren Bildschirmen angezeigt, wobei auf
jedem Bildschirm nur ein Teil Ihres gesamten Desktops
angezeigt wird.

Detect monitors (Bildschirme erkennen) Dadurch werden Bildschirme erkannt, die vor kurzem
hinzugefügt oder angeschlossen wurden.

Show monitors in panel (Bildschirme im Panel anzeigen) Ihrem Panel wird ein Symbol hinzugefügt, über das Sie
bestimmte Einstellungen schnell ändern können, ohne
das Bildschirmeinstellungstool aufzurufen.

Im Folgenden werden die Optionen beschrieben, die Sie für jeden Bildschirm festlegen
können. Der aktuell ausgewählte Bildschirm ist schwarz umrandet. Die Hintergrundfarbe der
Abschnittsbeschriftung weist ebenfalls darauf hin.

■ On (Ein)/Off (Aus) – Sie können einzelne Bildschirme komplett deaktivieren, indem Sie
"Off (Aus)" auswählen.

■ Resolution (Auflösung) – Die Auflösung für den aktuell ausgewählten Bildschirm wird
festgelegt. Die Auflösung bezieht sich auf die Pixeldichte auf dem Bildschirm. Durch
eine höhere Auflösung passen mehr Elemente auf den Bildschirm, werden jedoch kleiner
angezeigt.

■ Refresh rate (Aktualisierungsrate) – Die Aktualisierungsrate wird für den aktuell
ausgewählten Bildschirm festgelegt. Die Aktualisierungsrate bestimmt, wie oft der
Computer die Bildschirmanzeige aktualisiert. Eine zu niedrige Aktualisierungsrate refresh
(unter 60) führt zu Bildschirmflackern, das das Auge belastet. Dieses Problem fällt bei einer
LCD-Anzeige weniger auf.

■ Rotation (Rotation) – Die Rotation wird für den aktuell ausgewählten Bildschirm festgelegt.
Diese Option wird möglicherweise nicht von allen Grafikkarten unterstützt.
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Einstellungstool "Sound" (Klang)

Mit dem Einstellungstool "Sound (Klang)" können Sie Geräte und die Lautstärke für Audioein-
und ausgänge steuern. Sie können außerdem angeben, welche akustischen Signale bei
bestimmten Ereignissen ertönen sollen.

Wählen Sie "System -> Preferences -> Sound" (System -> Einstellungen -> Sound), um das
Soundeinstellungstool anzuzeigen.

Sie können Einstellungen in den folgenden Funktionsbereichen anpassen:

■ Playback (Wiedergabe)
■ Recording (Aufnahme)
■ Sound Theme (Klangthema)

Die meisten Computer verfügen nur über ein Audiogerät, das sowohl die Aufnahme als auch
die Wiedergabe steuert. Wenn Ihr Computer über mehr als ein Audiogerät verfügt, können Sie
zwischen diesen wechseln, indem Sie die Dropdown-Liste "Gerät" verwenden, die sich ganz
oben im Fenster befindet.

Wiedergabeeinstellungen

Auf der Registerkarte "Playback (Wiedergabe)" In der nachfolgenden Tabelle sind die
Aufnahmeeinstellungen enthalten, die verändert werden können.

TABELLE 10-13Wiedergabeeinstellungen

Dialogfeldelement Beschreibung

Volume (Datenträger) Die allgemeine Wiedergabelautstärke kann hierdurch gesteuert werden.

Knopf "Link sliders (Regler
verbinden)"

Alle Regler werden auf denselben Wert eingestellt und gleichzeitig bewegt,
wenn ein einzelner Regler bewegt wird.

Knopf "Mute (Stumm)" Alle Klänge werden vorübergehend ohne Auswirkungen auf die aktuelle
Lautstärke stumm geschaltet.

Anmerkung - Sie können die Lautstärke auch über das Lautsprechersymbol regeln, das im
Benachrichtigungsbereich des Panels angezeigt wird.

Abhängig von der Soundkarte Ihres Computers und den damit verbundenen Geräten, kann
es sein, dass Sie andere Schieberegler, Kontrollkästchen oder Listen in der Registerkarte
"Playback (Wiedergabe)" sehen, die Ihnen eine Steuerung der Tonausgabe ermöglichen. Sie
können bestimmen, welche Steuerelemente auf der Registerkarte angezeigt werden sollen,
indem Sie auf den Knopf "Preferences (Einstellungen)" klicken.
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Aufnahmeeinstellungen

Sie können auf der Registerkarte "Recording (Aufnahme)" Ihre Einstellungen für
Klangaufnahmen festzulegen. In der nachfolgenden Tabelle sind die Aufnahmeeinstellungen
enthalten, die verändert werden können.

TABELLE 10-14Aufnahmeeinstellungen

Dialogfeldelement Beschreibung

Record (Aufnahme) Hier können Sie die Aufnahmelautstärke einstellen.

Gain (Pegel) Dadurch wird die auf die Aufnahme angewandte Verstärkung eingestellt.

Knopf "Link sliders (Regler verbinden)" Alle Regler werden auf denselben Wert eingestellt und gleichzeitig
bewegt, wenn ein einzelner Regler bewegt wird.

Knopf "Mute (Stumm)" Alle Aufnahmen werden vorübergehend ohne Auswirkungen auf die
aktuelle Aufnahmelautstärke stumm geschaltet.

Abhängig von der Soundkarte Ihres Computers und den damit verbundenen Geräten, kann
es sein, dass Sie andere Schieberegler, Kontrollkästchen oder Listen in der Registerkarte
"Recording (Aufnahme)" sehen, die Ihnen eine Steuerung der Toneingabe ermöglichen. Sie
können bestimmen, welche Steuerelemente auf der Registerkarte angezeigt werden sollen,
indem Sie auf den Knopf "Preferences (Einstellungen)" klicken.

Klangthemeneinstellungen

Ein Klangthema ist eine Zusammenstellung von Klangeffekten, das mit verschiedenen
Ereignissen, wie zum Beispiel dem Öffnen eines Dialogs, dem Klicken auf eine Schaltfläche
oder der Auswahl eines Menüelements, in Verbindung steht. Einer der bekanntesten
Ereignisklänge ist die Systemalarmklang, der oft bei einem Eingabefehler der Tastatur ertönt.
Verwenden Sie die Registerkarte "Sound Theme (Klangthema)" des Einstellungstools "Sound
(Klang)", um ein Klangthema zu wählen und den Klang der Systemglocke zu ändern.

In der nachfolgenden Tabelle sind die Soundeffekteinstellungen enthalten, die verändert werden
können.

TABELLE 10-15Klangeffekteinstellungen

Dialogfeldelement Beschreibung

Sound Theme (Klangthema) Das Klangthema wird festgelegt.

Wählen Sie "No sounds (Keine Klänge)", um alle
Ereignisklänge zu deaktivieren.

Liste "Choose an alert sound (Wählen Sie einen
Warnklang)"

Der Klang der Systemglocke wird festgelegt.

Der Klang ertönt, wenn ein Listenelement ausgewählt
wird.
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Dialogfeldelement Beschreibung

Enable window and button sounds (Fenster- und
Knopfklänge einschalten)

Wählen Sie diese Option ab, wenn Sie keine Signaltöne
für fensterbezogene Ereignisse (beispielsweise, wenn ein
Dialog oder ein Menü erscheint) und Tastenklicks hören
möchten.

Anwendungsklangeinstellungen

Regeln Sie die Lautstärke von Klängen einzelner Anwendungen auf der Registerkarte
"Applications (Anwendungen)". Eine Anwendung, von der gerade ein Klang ausgeht, kann
anhand von Namen und Symbol identifiziert werden.

Sitzungseinstellungen festlegen

Mithilfe des Einstellungstools für Startprogramme können Sie Ihre Sitzungen verwalten.
Sie können Sitzungseinstellungen festlegen und angeben, welche Anwendungen beim
Start einer Sitzung gestartet werden sollen. Sie können Sitzungen so konfigurieren, dass
der Anwendungsstatus auf dem Oracle Solaris-Desktop gespeichert und wiederhergestellt
wird, wenn Sie eine andere Sitzung starten. Dieses Einstellungstool können Sie auch dafür
verwenden, um mehrere GNOME-Sitzungen zu verwalten.

Sie können Einstellungen in den folgenden Funktionsbereichen anpassen:

■ Sitzungsoptionen
■ Startprogramme

Verwenden Sie die Registerkarte "Session Options (Sitzungsoptionen)", um Einstellungen für
die aktuelle Sitzung festzulegen. Die nachfolgende Tabelle enthält die Sitzungsoptionen, die
von Ihnen verändert werden können.

TABELLE 10-16Sitzungsoptionen

Dialogfeldelement Beschreibung

Automatically remember running applications when
logging out (Automatisch die laufenden Programme
beim Abmelden merken)

Wählen Sie diese Option, wenn der Status Ihrer
Sitzung beim Abmelden von der Sitzungsverwaltung
gespeichert werden soll. Über die Sitzungsverwaltung
werden die von der Sitzung verwalteten geöffneten
Anwendungen und die mit diesen Anwendungen
verbundenen Einstellungen gespeichert. Beim nächsten
Sitzungsstart werden die Anwendungen automatisch mit
den gespeicherten Einstellungen gestartet.

Remember currently running applications (Momentan
laufendes Programm merken)

Wählen Sie diese Option, wenn der aktuelle
Sitzungsstatus von der Sitzungsverwaltung gespeichert
werden soll. Über die Sitzungsverwaltung werden die
von der Sitzung verwalteten geöffneten Programme und
die mit diesen Programmen verbundenen Einstellungen
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Dialogfeldelement Beschreibung
gespeichert. Beim nächsten Sitzungsstart werden
die Programme automatisch mit den gespeicherten
Einstellungen gestartet.

Startprogramme konfigurieren

Wählen Sie die Registerkarte "Startup Programs" (Startprogramme) des Einstellungstools
für Startprogramme, um Startprogramme anzugeben, die nicht von der Sitzung verwaltet
werden. Als Startprogramme werden Programme bezeichnet, die automatisch gestartet werden,
wenn Sie eine Sitzung starten. Geben Sie die Befehle an, über die Programme, die nicht von
der Sitzung verwaltet werden, auf der Registerkarte "Startup Programs" (Startprogramme)
ausgeführt werden. Die Befehle werden automatisch ausgeführt, wenn Sie sich anmelden.

Sie können darüber hinaus von der Sitzung verwaltete Programme automatisch starten. Weitere
Informationen erhalten Sie unter „Sitzungseinstellungen festlegen“ [159].

Sie können ein Startprogramm hinzufügen, bearbeiten oder löschen.

■ Um ein Startprogramm hinzuzufügen, klicken Sie auf den Knopf "Add (Hinzufügen)".
Der Dialog "New Startup Program (Neues Startprogramm)" wird angezeigt. Geben Sie
den Namen der Anwendung im Feld "Name (Name)" ein. Geben Sie dann den Befehl ein,
um das Programm im Feld "Command (Befehl)" zu starten. Außerdem können Sie einen
Kommentar im Feld "Comment (Kommentar)" eingeben.

■ Um ein Startprogramm zu bearbeiten, wählen Sie das Startprogramm aus, und klicken Sie
auf den Knopf "Edit (Bearbeiten)". Der Dialog "Edit Startup Program (Startprogramm
bearbeiten)" wird angezeigt. Ändern Sie den Befehl und die Startreihenfolge für das
Startprogramm.

■ Löschen Sie ein Startprogramm, indem Sie es auswählen und dann auf den Knopf "Remove
(Löschen)" klicken.
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Verwenden der Maus

Dieser Anhang beschreibt die Aktionen der Maus und die verschiedenen Mauszeiger. Er
umfasst die folgenden Informationen:

■ „Konventionen für Maustasten“ [161]
■ „Mauszeiger“ [165]

Eine Maus ist ein Zeigegerät, das dabei behilflich ist, den Mauszeiger über den Bildschirm zu
bewegen. Der Mauszeiger ist ein kleiner Pfeil, mit dem Sie auf Objekte auf Ihrem Bildschirm
zeigen können. Das Drücken einer Maustaste führt eine bestimmte Aktion mit dem Objekt
aus, über dem sich der Mauszeiger befindet, und ist abhängig davon, welche der Maustasten
gedrückt wird.

Konventionen für Maustasten

Die Konventionen für Maustasten lauten wie folgt:

■ Linke Maustaste - Die Taste auf der linken Seite der Maus. Die linke Maustaste wird häufig
benutzt zum Auswählen, Aktivieren, Betätigen von Schaltflächen und so weiter. Klicken Sie
bei Aufforderung mit der linken Maustaste.

■ Mittlere Maustaste – Die mittlere Taste einer Maus. Bei vielen Mäusen, die über ein
Mausrad verfügen, kann das Mausrad heruntergedrückt werden, um so einen Klick mit der
mittleren Maustaste auszuführen.

■ Rechte Maustaste – Die Taste auf der rechten Seite einer Maus. Häufig wird über diese
Taste ein Kontextmenü zu dem Objekt unter dem Mauszeiger angezeigt.

Manche Mäuse verfügen über keine mittlere Taste. Wenn Sie eine Maus mit zwei Tasten
benutzen, sollte das System so konfiguriert werden, dass Chording angewendet wird, um die
Funktion der mittleren Taste zu simulieren. Wenn Chording aktiviert ist, drücken Sie die linke
und die rechte Maustaste gleichzeitig, um die Wirkung einer mittleren Maustaste zu simulieren.

Verwenden Sie das Einstellungstool der Maus, um die Orientierung der Maus umzukehren.
Sie werden die Konventionen für Maustasten, die in diesem Handbuch verwendet werden,
umkehren müssen.
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Einstellungstool der Maus

Mit dem Einstellungstool der Maus können die folgenden Einstellungen bestimmt werden:

■ Konfigurieren Sie Ihre Maus für rechtshändigen oder linkshändigen Gebrauch.
■ Bestimmen Sie Geschwindigkeit und Empfindlichkeit der Mausbewegung.
■ Konfigurieren Sie die Barrierefreiheitsfunktionen der Maus.

Wählen Sie "System -> Preferences -> Mouse" (System -> Einstellungen -> Maus), um das
Einstellungstool der Maus anzuzeigen.

Allgemeine Einstellungen für die Maus

Verwenden Sie die Registerkarte "General (Allgemein)", um anzugeben, ob die Maustasten für
Links- oder Rechtshänder konfiguriert werden sollen, und legen Sie dann die Geschwindigkeit
und Empfindlichkeit Ihrer Maus fest.

In der nachfolgenden Tabelle sind die allgemeinen Mauseinstellungen enthalten, die von Ihnen
verändert werden können.

TABELLE A-1 Einstellungen für die Maustasten

Dialogfeldelement Beschreibung

Right-handed (Mit rechts bediente Maus) Konfiguriert die Maus für rechtshändigen Gebrauch. Die
linke Maustaste ist die primäre Maustaste und die rechte
die sekundäre Maustaste.

Left-handed (Mit links bediente Maus) Konfiguriert die Maus für linkshändigen Gebrauch. Die
Funktionen der linken und der rechten Maustaste werden
getauscht.

Show position of pointer when the Control key is pressed
(Position des Cursors anzeigen, wenn die Strg-Taste
gedrückt wird)

Aktiviert eine Mauszeigeranimation, wenn Sie die
STRG-Taste drücken und wieder loslassen. Diese
Funktion kann Ihnen das Auffinden des Mauszeigers
erleichtern.
Anmerkung - Die Position der Strg-
Taste auf der Tastatur, kann im Dialog der
Tastaturbelegungseinstellungen verändert
werden. Weitere Informationen erhalten Sie unter
„Tastaturbelegungseinstellungen“ [150].

Acceleration (Beschleunigung) Bestimmt die Geschwindigkeit, mit welcher sich der
Mauszeiger auf dem Bildschirm bewegt, wenn Sie die
Maus bewegen.

Sensitivity (Empfindlichkeit) Bestimmt, wie empfindlich der Mauszeiger auf
Bewegungen der Maus reagiert.

Threshold (Schwellwert) Bestimmt die Strecke, um die ein Objekt verschoben
werden muss, bevor die Verschiebungsaktion als Ziehen-
und-Ablegen-Aktion interpretiert wird.
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Dialogfeldelement Beschreibung

Timeout (Zeitüberschreitung) Verwenden Sie den Schieberegler, um die Zeitspanne
festzulegen, die maximal zwischen den Klicks beim
Doppelklicken liegen darf. Wenn das Intervall zwischen
dem ersten und dem zweiten Klick länger als der
hier festgelegte Wert ist, wird die Aktion nicht als
Doppelklick interpretiert.

Verwenden Sie das Glühlampensymbol, um die
Doppelklickempfindlichkeit zu überprüfen: Das Licht
wird bei einem einfachen Klick kurz aufleuchten, bzw.
bei einem Doppelklick eingeschaltet bleiben.

Barrierefreiheitseinstellungen der Maus

Verwenden Sie die Registerkarte "Accessibility (Barrierefreiheit)" zur Einstellung der
Barrierefreiheitsfunktionen für Benutzer, denen das exakte Setzen des Mauszeigers oder die
Bedienung der Maustasten schwerfällt:

■ Öffnen Sie ein Kontextmenü durch Klicken und Gedrückthalten der primären Maustaste.
Diese Einstellung ist nützlich für Benutzer, die nur eine Taste bedienen können.

■ Ausführen verschiedener Typen von Mausklicks durch die Software. Dies ist nützlich für
Benutzer, die nicht in der Lage sind, Tasten zu bedienen. Die ausführbaren Klicktypen sind:
■ Einfacher Klick - Ein einfacher Klick der primären Maustaste.
■ Doppelklick – Ein Doppelklick der primären Maustaste.
■ Mitziehklick – Ein Klick, der eine Operation zum Ziehen und Ablegen einleitet.
■ Sekundärer Klick – Ein einfacher Klick der sekundären Maustaste.

In der nachfolgenden Tabelle sind die Barrierefreiheitseinstellungen der Maus enthalten, die
von Ihnen verändert werden können.

TABELLE A-2 Einstellungen für Mausbewegungen

Dialogfeldelement Beschreibung

Kontextklick durch Gedrückthalten der primären Taste
auslösen

Ermöglicht simulierte Klicks der sekundären Maustaste,
indem die primäre Maustaste längere Zeit gedrückt wird.

Schieberegler "Delay (Verzögerung)" im Abschnitt
"Simulated Secondary Click (Simulierter Kontextklick)"

Bestimmt, wie lange die primäre Maustaste gedrückt
werden muss, um einen sekundären Klick zu simulieren.

Klick ausführen, wenn sich der Mauszeiger nicht mehr
bewegt

Aktiviert automatische Klicks, wenn die Maus stoppt.
Verwenden Sie die zusätzlichen Einstellungen im
Abschnitt "Dwell Click (Verzögerter Klick)", um
festzulegen, wie der Klicktyp ausgewählt wird.

Schieberegler "Delay (Verzögerung)" im Abschnitt
"Dwell Click (Verzögerter Klick)"

Bestimmt, wie lange der Mauszeiger ruhen muss, bevor
ein automatischer Klick ausgeführt wird.

Schieberegler "Motion threshold
(Bewegungsschwellenwert)"

Bestimmt, wie empfindlich der Mauszeiger auf
Bewegungen der Maus reagieren soll.
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Dialogfeldelement Beschreibung

Klicktyp im Voraus auswählen Bestimmt den Klicktyp, der aus einem Fenster oder
Panel-Applet auszuführen ist.

Klicktypfenster anzeigen Wenn diese Option aktiviert ist, können die
verschiedenen Klicktypen (einfacher Klick, Doppelklick,
Mitziehklick oder sekundärer Klick) in einem Fenster
ausgewählt werden.
Anmerkung - Das Panel-Applet zum verzögerten Klick
kann anstelle des Fensters verwendet werden.

Den Klicktyp mittels Mausgesten auswählen Wenn Sie die Maus in eine bestimmte Richtung
bewegen, bestimmt dies über den Klicktyp. Weisen Sie
den verschiedenen Richtungen jeweils Klicktypen zu.
Beachten Sie, dass jede Richtung nur für einen Klicktyp
verwendet werden kann.

Anmerkung - Der Systemadministrator muss das gnome/accessibility/mousetweaks-
Package installieren, um diese Barrierefreiheitseinstellungen zu aktivieren.

Mit der Maus können Sie die folgenden Aktionen ausführen.

Maustaste Aktionen

Linke Maustaste ■ Markieren von Text
■ Auswählen von Objekten
■ Ziehen von Elementen
■ Aktivieren von Objekten

Mittlere Maustaste ■ Einfügen von Text
■ Verschieben von Elementen

Rechte Maustaste Verwenden Sie die rechte Maustaste, um das Kontextmenü eines Objekts zu öffnen.
Für die meisten Objekte können Sie auch durch Drücken der Tastenkombination
Umschalt+F10 das Kontextmenü öffnen, wenn das Objekt bereits ausgewählt ist.

Wenn Sie beispielsweise Dateien im Dateimanager betrachten, können Sie durch einen
einfachen Klick mit der linken Maustaste die Datei auswählen und durch einen Doppelklick
mit der linken Maustaste die Datei öffnen. Ein Klick mit der rechten Maustaste öffnet ein
Kontextmenü für diese Datei.

Anmerkung - In den meisten Anwendungen können Sie Text mit der linken Maustaste
auswählen und in einer anderen Anwendung mit der mittleren Maustaste einfügen. Dies wird
"Auswahl einfügen" genannt und arbeitet unabhängig von der normalen Verwendung der
Zwischenablage.

Um mehrere Objekte auszuwählen, halten Sie die STRG-Taste gedrückt oder verwenden die
UMSCHALT-Taste, falls es sich dabei um eine Reihe aufeinanderfolgender Objekte handelt.
Sie können auch ein Rechteck um die Objekte herumziehen, um mehrere Objekte auszuwählen.
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Mauszeiger
Die Darstellung des Mauszeigers kann sich ändern. Die Darstellung des Zeigers kann
Rückmeldungen über eine bestimmte Operation, eine Position oder einen Zustand geben. Die
folgenden Mauszeiger werden angezeigt, wenn sich Ihre Maus über die verschiedenen Elemente
des Bildschirms bewegt:

Anmerkung - Die Mauszeiger können von den hier gezeigten abweichen, da ihre Darstellung
von den jeweiligen Mauseinstellungen abhängt.

TABELLE A-3 Mauszeigerbeschreibung

Mauszeiger Beschreibung

Normaler Zeiger
Der Zeiger, der bei der normalen Verwendung der Maus angezeigt wird.

Mauszeiger für
"Beschäftigt"

Dieser Mauszeiger erscheint über einem Fenster, das gerade eine Aufgabe ausführt.
Sie können mit der Maus keine Eingabe in diesem Fenster ausführen, aber Sie
können die Maus zu einem anderen Fenster verschieben und damit weiterarbeiten.

Mauszeiger für Größe
ändern

Dieser Mauszeiger zeigt an, dass Sie diesen Bereich ziehen können, um die
Größe von Teilen der Benutzeroberfläche zu verändern. Er erscheint über dem
Fensterrahmen und über den Größenänderungsanfasspunkten zwischen den
Bereichen eines Fensters. Die Richtung der Pfeile zeigt an, in welcher Richtung die
Größe veränderbar ist.

Handzeiger
Dieser Mauszeiger wird angezeigt, wenn sich die Maus über einer
Hypertextverknüpfung befindet, beispielsweise auf einer Webseite. Dieser Zeiger
informiert darüber, dass Sie die Verknüpfung anklicken können, um ein neues
Dokument zu laden oder eine Aktion auszuführen.

Mauszeiger für Text
Dieser Mauszeiger wird angezeigt, wenn sich die Maus über einem Text befindet,
den Sie auswählen oder bearbeiten können. Klicken Sie hier, um einen Text
einzugeben oder einen vorhandenen Text an einen anderen Ort zu ziehen.

Die folgenden Mauszeiger werden beim Ziehen eines Objekts angezeigt, beispielsweise einer Datei oder eines
Textabschnitts. Sie zeigen, was beim Drücken der Maustaste, während des Ablegens des Objekts geschieht.

Verschiebungszeiger
Zeigt an, dass das Objekt beim Ablegen von der alten Position an die neue Position
verschoben wird.

Kopierzeiger
Dieser Mauszeiger erscheint beim Ablegen eines Objekts, wenn an diesem Ort eine
Kopie des Objekts erzeugt wird.

Mauszeiger für
symbolische Verknüpfungen

Dieser Mauszeiger erscheint beim Ablegen eines Objekts, wenn an diesem Ort eine
symbolische Verknüpfung des Objekts erzeugt wird. Ein symbolischer Verweis ist
eine besondere Art von Datei, die auf eine andere Datei oder einen anderen Ordner
verweist. Weitere Informationen zur Erstellung symbolischer Verknüpfungen finden
Sie unter „So erstellen Sie einen symbolischen Link zu einer Datei oder einem
Ordner“ [93].

Fragezeichenzeiger
Dieser Mauszeiger zeigt an, dass Ihnen beim Ablegen des Objekts eine Auswahl
der möglichen Aktionen angezeigt wird. Ein Menü wird angezeigt, in welchem Sie
wählen können, welche Aktion Sie ausführen wollen. Beispielsweise können Sie
verschieben, kopieren oder eine symbolische Verknüpfung erzeugen.

Mauszeiger für "Nicht
verfügbar"

Dieser Mauszeiger zeigt an, dass Sie das Objekt am gegenwärtigen Ort nicht
ablegen können. Das Loslassen der Maustaste zeigt hier keine Wirkung. Das
gezogene Objekt kehrt an seinen ursprünglichen Ort zurück.
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Mauszeiger Beschreibung

Zeiger zum Verschieben
von Panel-Objekten

Dieser Mauszeiger wird beim Ziehen eines Panels oder Panel-Objekts mit der
mittleren Maustaste angezeigt. Weitere Informationen zu Panels erhalten Sie unter
Kapitel 4, Desktop-Panels verwenden.

Mauszeiger für Fenster
verschieben

Dieser Mauszeiger wird beim Ziehen eines Fensters angezeigt, um es zu
verschieben. Weitere Informationen zum Verschieben von Fenstern erhalten Sie
unter „Mit Fenstern arbeiten“ [20].
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Bedienung der Tastatur

Die Tastatur kann für fast jede Aufgabe verwendet werden, die Sie mit der Maus ausführen
können. Mit Hilfe von Tastenkombinationen können Sie allgemeine Aufgaben im Oracle
Solaris-Desktop ausführen und mit Oberflächenelementen wie Panels und Fenstern arbeiten.
Auch in Anwendungen können Sie Tastenkombinationen verwenden. Wählen Sie zur
Anpassung das Einstellungstool für Tastenkombinationen. Weitere Informationen zur
Konfiguration von Tastenkombinationen erhalten Sie unter „Tastenkombinationen“ [130].

Sie können auch die Einstellungen des Oracle Solaris-Desktops ändern, um die
Barrierefreiheitseinstellungen der Tastatur zu nutzen. Weitere Informationen zu den
Barrierefreiheitsfunktionen der Tastatur erhalten Sie unter „Barrierefreiheit“ [151]. Weitere
Informationen zu den Tastaturnavigationsfiunktionen, die im Oracle Solaris-Desktop zur
Verfügung stehen, finden Sie unter „Oracle Solaris 11 Desktop Accessibility Guide “

Dieser Anhang beinhaltet die folgenden Informationen:

■ „Globale Tastenkombinationen“ [167]
■ „Tastenkombinationen für Fenster“ [168]
■ „Anwendungstasten“ [169]
■ „Zugriffstasten“ [170]

Globale Tastenkombinationen

Globale Tastenkombinationen geben Ihnen die Möglichkeit, desktopbezogene Aufgaben
anstelle von Aufgaben, die sich auf das ausgewählte Fenster oder die ausgewählte Anwendung
beziehen, mit Hilfe der Tastatur auszuführen. In der nachfolgenden Tabelle sind einige globale
Tastenkombinationen aufgeführt.

TABELLE B-1 Globale Tastenkombinationen

Tastenkombination Funktion

ALT+F1, STRG+ESC Öffnet das Menü "Applications (Anwendungen)".

ALT+F2, Meta+R Das Dialogfeld "Run Application (Anwendung ausführen)" wird angezeigt. Weitere
Informationen zum Ausführen von Anwendungen finden Sie unter „Ausführen von
Anwendungen“ [119].

http://www.oracle.com/pls/topic/lookup?ctx=dsc&id=/app/docs/doc/E54036
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Tastenkombination Funktion

DRUCK Erstellt ein Bildschirmfoto des gesamten Desktops. Weitere Informationen zum
Aufnehmen von Bildschirmfotos finden Sie unter „Bildschirmfotos aufnehmen“ [120].

ALT+DRUCK Erstellt ein Bildschirmfoto des aktuell aktivierten Fensters.

Strg+Alt+Pfeiltasten Wechselt zu einer anderen Arbeitsfläche in der angegebenen Richtung. Weitere
Informationen zur Arbeit mit mehreren Arbeitsflächen finden Sie unter „Überblick über
die Arbeitsflächen“ [25].

STRG+ALT+D Verkleinert alle Fenster und macht den Desktop zum aktiven Bereich.

ALT+TAB-TASTE Wechselt zwischen den Fenstern. Wenn Sie diese Tastenkombination verwenden,
erscheint eine Liste mit den Fenstern, die Sie auswählen können. Lassen Sie die Tasten
los, um ein Fenster auszuwählen. Drücken Sie die Umschalt-Taste, um in umgekehrter
Richtung durch die Fensterliste zu blättern.

Alt+ Esc Wechselt zwischen den Fenstern. Lassen Sie die Tasten los, um ein Fenster auszuwählen.
Drücken Sie die Umschalttaste, um in umgekehrter Reihenfolge durch die Fenster zu
blättern.

STRG+ALT+TAB-
TASTE

Wechselt zwischen den Panels und dem Desktop. Wenn Sie diese Tastenkombination
verwenden, erscheint eine Liste mit den Elementen, die Sie auswählen können. Lassen
Sie die Tasten los, um ein Element auszuwählen. Drücken Sie die Umschalt-Taste, um in
umgekehrter Richtung durch die Liste der Elemente zu blättern.

Tastenkombinationen für Fenster
Mit Hilfe von Tastenkombinationen für Fenster können Sie Vorgänge im aktuell aktivierten
Fenstern über die Tastatur ausführen. Die folgende Tabelle enthält einige Tastenkombinationen
für Fenster.

TABELLE B-2 Tastenkombinationen für Fenster

Tastenkombination Funktion

ALT+TAB-TASTE Wechselt zwischen den Fenstern. Wenn Sie diese Tastenkombination verwenden,
erscheint eine Liste mit den Fenstern, die Sie auswählen können. Lassen Sie die Tasten
los, um ein Fenster auszuwählen. Drücken Sie die Umschalt-Taste, um in umgekehrter
Richtung durch die Fensterliste zu blättern.

Alt+ Esc Wechselt zwischen den Fenstern. Lassen Sie die Tasten los, um ein Fenster
auszuwählen. Drücken Sie die Umschalttaste, um in umgekehrter Reihenfolge durch
die Fenster zu blättern.

Alt+F4 Schließt das aktuell aktivierte Fenster.

Alt+F5 Macht das Maximieren des aktuellen Fensters rückgängig, falls dieses maximiert ist.

Alt+F7 Verschiebt das aktuell aktivierte Fenster. Nach dem Drücken dieser Tastenkombination
können Sie das Fenster entweder mit der Maus oder den Pfeiltasten bewegen. Um das
Verschieben zu beenden, klicken Sie mit der Maus oder drücken Sie eine beliebige
Taste auf der Tastatur.

Alt+F8 Ändert die Größe des aktuell aktivierten Fensters. Nach dem Drücken dieser
Tastenkombination können Sie die Größe des Fensters entweder mit der Maus oder
den Pfeiltasten verändern. Um die Größenänderung zu beenden, klicken Sie mit der
Maus oder drücken Sie eine beliebige Taste auf der Tastatur.

Alt+F9 Minimiert das aktuelle Fenster.
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Tastenkombination Funktion

Alt+F10 Maximiert das aktuelle Fenster.

ALT+LEERTASTE Öffnet das Fenstermenü für das aktuell ausgewählte Fenster. Das Fenstermenü
ermöglicht Aktionen wie Minimieren, Wechsel der Arbeitsfläche oder Schließen.

Umschalt+Strg+Alt+
Pfeiltasten

Verschiebt das aktuelle Fenster auf eine andere Arbeitsfläche in der angegebenen
Richtung. Weitere Informationen zur Arbeit mit mehreren Arbeitsflächen finden Sie
unter „Überblick über die Arbeitsflächen“ [25].

Anwendungstasten

Mit Hilfe von Tastenkombinationen für Anwendungen können Sie Vorgänge in Anwendungen
ausführen. Die folgende Tabelle enthält einige Tastenkombinationen für Anwendungen.

TABELLE B-3 Anwendungstastenkombinationen

Tastenkombination Aktion

STRG+N Erstellt ein neues Dokument oder Fenster.

Strg+X Schneidet den gewählten Text oder Bereich aus und speichert ihn in der
Zwischenablage.

Strg+C Kopiert den ausgewählten Text oder Bereich in die Zwischenablage.

Strg+V Fügt den Inhalt der Zwischenablage ein.

Strg+Z Bricht die letzte Aktion ab.

Strg+S Speichert das aktuelle Dokument.

F1 Lädt die Onlinehilfe der Anwendung.

Zusätzlich zu diesen Tastenkombinationen unterstützen alle Anwendungen eine Reihe von
Navigationstasten und Aktionen, die mit der Benutzeroberfläche in Zusammenhang stehen.
Diese Tasten ermöglichen es Ihnen, Vorgänge auszuführen, wofür Sie normalerweise die Maus
benötigen. Die folgende Tabelle listet einige dieser Tasten auf.

TABELLE B-4 Steuerungstasten der Benutzeroberfläche

Tasten Aktion

Pfeiltasten oder
Tabulatortaste

Wechselt zwischen Steuerelementen der Benutzeroberfläche oder den Elementen einer
Liste.

Eingabetaste oder
Leertaste

Aktiviert oder wählt das Objekt aus.

F10 Aktiviert das am weitesten links befindliche Menü des Anwendungsfensters.

Umschalt+F10 Aktiviert das Kontextmenü für das ausgewählte Element.

Esc Schließt ein Menü, ohne ein Menüelement auszuwählen, oder bricht einen Ziehvorgang
ab.
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Zugriffstasten

Eine Zugriffstaste ist ein unterstrichener Buchstabe in einer Menüleiste, einem Menü oder
Dialog, den Sie zum Ausführen einer Aktion verwenden können.

Wenn Sie ein Menü öffnen möchten, drücken Sie die Alt-Taste und danach die entsprechende
Zugriffstaste. Um eine Menüoption auszuwählen, während das Menü angezeigt wird, drücken
Sie die Zugriffstaste für die Menüoption.

Beispiel: Drücken Sie zum Öffnen eines neuen Fensters in der Hilfe ALT+F, um das Menü
"File" (Datei) zu öffnen, und drücken Sie dann N, um den Menüeintrag "New Window" (Neues
Fenster) zu aktivieren. Über Zugriffstasten können Sie auch auf Elemente in einem Dialog
zugreifen. Um auf ein bestimmtes Dialogfeldelement zuzugreifen, drücken Sie die ALT-Taste
und danach die Zugriffstaste.
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